
What is Net.Medic?

With the explosive growth of the Internet, travel on the information highway can be slow. Net.Medic helps you 
recognize and avoid many of the Internet roadblocks by:

n Optimizing your online connections 

n Identifying many Internet ailments in seconds

n Tracing the cause of these ailments to their source

n Offering suggestions about how to solve the problems, and whenever possible automatically fixing them.

Net.Medic is an easy-to-use browser companion that animates your online connections, and tracks the vital signs of 
your online activity. It also provides clear and simple reports that can help you transform your online experience.

Note

When you start up your computer, Net.Medic is automatically loaded. To check if Net.Medic is currently running, 
simply look for the Net.Medic system tray icon in your taskbar. Even if you close the Net.Medic display, its 
background monitoring component continues to record your online activity for you.

What do you want to know more about?

n What are the reasons for the crawl on the Internet? 

n How Internet slowness can impact you 

n How Net.Medic can help you 

n How Net.Medic works with your browser 

n How to get started using Net.Medic 



Vital signs of your online activity

By continuously monitoring your end-to-end connection, Net.Medic tells you exactly what is happening at every 
critical point. With a glance, you can now easily check the following Internet vital signs from your desktop:

n Your current online activity (for example, “Transferring data…”)

n Current speed

n The health of your online connection

n The network and server delay

n The location of bottlenecks along your end-to-end connection

n The traffic levels on the Intranet, ISP, Internet, and remote servers

Note

For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic 
Results” Web page. This Web page is located on the technical support section of the VitalSigns Web site 
(www.vitalsigns.com). 



Reasons for slowness on the Internet

The information crawl on the Internet can be caused by one or more of the following problems:

n Desktops or modems that are misconfigured and not optimized

n Bottlenecks due to insufficient capacity 

n Web page transfers that are hung (frozen)

n Inadequate access from your desktop to your Intranet, ISP, Internet backbone, or Web site servers

n Poor phone lines that cause modems to hang up or underperform

n Sluggishness of Web site servers 

What do you want to know more about?

n How Internet slowness can impact you 

n How Net.Medic can help you 

n How Net.Medic animates your online connections for you 

n How Net.Medic works with your browser 

n How to get started using Net.Medic



How Internet slowness can impact you

At some point, the information crawl on the Internet will impact you along with other Internet or Intranet users. On a 
typical day, users can be found impatiently waiting for a Web page to download, wondering why a Web server is not 
responding, being unexpectedly disconnected from their ISP, or getting a cryptic error message that is useless 
unless you are an expert in HTTP.

What’s the right corrective action?

Faced with these Internet performance problems, deciding the right corrective action is often confusing. In the past, 
corrective action tended to focus on resolving bandwidth and congestion issues. However, available bandwidth is 
just one factor effecting online performance, and quite often it’s not the key factor. For example, the enormous 
power of the Internet can be diminished by slow modem connections, suboptimized desktop computers, or 
unresponsive Web servers.

Consequently, to improve Internet performance, you need the following:

n A way to proactively monitor and manage your online experience

n A tool to instantly pinpoint the specific source of performance problems and a way to easily communicate with 
those responsible for the poor performance

n A mechanism to improve data transfers by optimizing your online connections

Fortunately, the Net.Medic software can quickly and easily help identify and isolate many of these Internet 
performance issues.

What do you want to know more about? 

n How Net.Medic can help you 

n How Net.Medic animates your online connections for you

n How Net.Medic works with your browser 

n How to get started using Net.Medic



Right corrective action

Corrective action can range from real-time actions such as stopping a hung transmission and restarting, which 
Net.Medic will automatically do, to purchasing a faster modem or purchasing a premium service from your ISP. 
Useful corrective action depends on knowing the cause of the problem.

n Should you subscribe to a premium service from your ISP? No, not if the Internet backbone or the remote 
servers are responsible for the bottleneck.

n Should you buy a faster modem? No, it won’t help if the problem is that your ISP doesn’t have enough modems 
in their modem bank.

n What should you do when you are retrieving a Web page and your browser “hangs”? Waiting indefinitely for the 
browser to “unfreeze” won’t solve this problem, especially if it’s unclear whether the page is actually hung.



How Net.Medic can help you

Net.Medic identifies, diagnoses, and fixes many problems that negatively impact your online experience.    Now you 
can trace each network bottleneck to its source—desktop computers (the client), your modem,    the Intranet, your 
ISP, the Internet backbone, or the remote Web server. 

Net.Medic identifies problems in seconds, offers suggestions about how to solve the problem and often 
automatically fixes them. By continuously monitoring activities along your Web path, Net.Medic tells you exactly 
what’s happening at every point. It reports your throughput, retrieval time, Web server load and efficiency, as well as 
network congestion levels. In addition, Net.Medic monitors your desktop computer and modem to ensure optimal 
configuration for your online connections. Net.Medic provides the information you need to make informed decisions 
about how to improve your online experience.

Note

· Because Net.Medic works so closely with your browser, you can run Net.Medic as a browser inlay. 

· For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic Results” Web 
page. This Web page is located on the technical support section of the VitalSigns Web site (www.vitalsigns.com).

What do you want to know more about?

n How Net.Medic works with your browser 

n How Net.Medic animates your online connections for you

n How Net.Medic identifies and isolates bottlenecks 

n How Net.Medic remedies many Internet ailments

n How Net.Medic recommends prescriptions for Internet ailments

n How Net.Medic contacts an appropriate resource for assistance 

n How to get started using Net.Medic



How Net.Medic works with your browser

Net.Medic works with such standard Internet browsers as Netscape Communicator 4.0, Netscape Navigator 3.x, 
Microsoft Internet Explorer 4.0, and Internet Explorer 3.x.    Because Net.Medic works so closely with your browser, 
you can run Net.Medic as an inlay in your browser. This feature allows you to conserve desktop space and to work 
primarily within one window as you “surf the Web.”

Tip

n Net.Medic remembers the last pane you snapped onto the browser and automatically resnaps it the next time 
you restart your browser.

n If you widen your browser window, the entire Net.Medic inlay can be viewed.

What do you want to know more about?

n Tips on snapping dashboard panes and the ticker tape onto your browser 

n How to display Net.Medic as a browser inlay 

n How to work with the Net.Medic inlay

n Net.Medic inlay menu options 

n How Net.Medic animates your online connections for you

n Parts of the Web path monitored by Net.Medic

n Understanding the monitored Web page activities



To change your modem or calling location

1 Right-click on the Net.Medic system tray icon.

2 From the displayed pop-up menu, choose Set Up Location or Set Up Modem.

n If you choose Set Up Location,    the Windows Control Panel dialing Properties dialog box opens. You can use 
this dialog box to specify your calling location and dialing details.

n If you choose Set Up Modem, the Windows Control Panel Modem Properties dialog box opens. You can use 
this dialog box to change your modem information.

Note

n If you need more information on using these two Windows dialog boxes, refer to your Windows documentation 
or help system.



Net.Medic pop-up menu options

The Net.Medic inlay has a pop-up menu that allows you to quickly perform certain tasks from the inlay. Right-click 
on the Net.Medic inlay to display the pop-up menu, then drag right to select an option. An x in the following table 
indicates the menu option is available. The Snap on Browser, Snap on Dashboard, Float Over Desktop, and 
Preferences commands are also available from the Net.Medic ticker tape pop-up menu.

Pane Menu 

option

Activity Through
put 

Retrieval Client Modem Intranet ISP Intern
et

Server Connect 
Time

x x x x x x x x x x Close Pane 

x x x x x x x x x x Float Over 
Desktop 

x x x x x x x x x x Snap on 
Browser 

x x x x x x x x x x Snap on 
Dashboard 

x x x x Identify 

x Hide 
Throughput 

x Show 
Throughput 

x Hide Speed 
Limit 

x Show Speed 
Limit 

x Speed Limit 

Note

n Except for the Hide Throughput and Show Throughput commands, which are only available from the inlay, the 
preceding list of menu options is available from the dashboard or inlay.

 What do you want to know more about?

n How to work with the Net.Medic inlay

n What is the Net.Medic ticker tape? 



Snap on Browser command

The pop-up menu command that snaps the Net.Medic dashboard pane onto your browser. 

Tips

n When you display this command from the Net.Medic inlay, this command is dimmed to indicate the pane is 
already snapped onto the browser.

n Net.Medic remembers the last pane you snapped onto the browser and automatically resnaps it the next time 
you restart your browser.



Float Over Desktop command

Besides snapping a Net.Medic dashboard pane onto your browser, you can float it over your desktop as follows:

1 Right-click on the Net.Medic dashboard pane to display its pop-up menu.

2 From the pop-up menu, choose Float Over Desktop.

Tip

To move the floating pane over your desktop, left-click on the pane and drag it to its new location on your desktop.



Close Pane command

The pop-up menu command that closes the pane in the Net.Medic dashboard.



Snap on Dashboard command

The pop-up menu command that detaches the pane from the browser inlay and snaps (opens) it onto the Net.Medic 
dashboard.



Identify command

This pop-up menu command displays identification information about your Intranet, ISP, or the current remote Web 
server. For example, if you pop up the menu from the Intranet pane and choose Identify, your Intranet is identified. 
The Identify command is available from the Intranet, ISP, and server panes. You can also access the Identify 
command from the Activity pane by right-clicking on the server icon or one of its router hop icons.



Hide Throughput command

The pop-up menu command that closes (hides) the Throughput gauge in the Activity pane. Note that this command 
is only available in the Activity pane’s pop-up when the pane is snapped onto the browser.



Show Throughput command

The pop-up menu command that shows (opens) the Throughput gauge in the Activity dashboard pane. Note that 
this command is only available in the Activity pane’s pop-up menu when the pane is snapped onto the browser.



Hide Speed Limit command

The pop-up menu command that closes (hides) the Speed Limit digital display in the Throughput dashboard pane.



Show Speed Limit command

The pop-up menu command that shows (opens) the Speed Limit digital display in the Throughput dashboard pane. 
The speed limit is the estimated maximum speed or bandwidth (capacity) available end-to-end during the current 
transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 line) and automatically 
calculates your speed limit. You may, however, want to change the current speed limit if the receive and transmit 
rates (the blue vertical bars in the recv and send graph) are high and difficult to read. In this case, raising the speed 
limit will increase the histogram maximum, thereby making the bars shorter in the graph and easier to interpret. To 
manually set the speed limit, right-click on this digital display, choose Speed Limit from the pop-up menu, then drag 
right and choose one of the manual settings.



Speed Limit command

The pop-up menu command that displays the submenu that can be used to change the current speed limit. The 
speed limit is the estimated maximum speed or bandwidth (capacity) available end-to-end during the current 
transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 line) and automatically 
calculates your speed limit. 

You may, however, want to change the current speed limit if the receive and transmit rates (the blue vertical bars in 
the recv and send graph) are high and difficult to read. In this case, raising the speed limit will increase the 
histogram maximum, thereby making the bars shorter in the graph and easier to interpret. To manually set the 
speed limit, right-click on this digital display, choose Speed Limit from the pop-up menu, then drag right and choose 
one of the manual settings.



How Net.Medic identifies and isolates bottlenecks

Net.Medic animates your online connection by highlighting the activity across the Internet, including traffic jams and 
bottlenecks. The Net.Medic dashboard identifies performance problems and isolates the source of the bottlenecks. 
Net.Medic alerts you to problems in your Web path, and describes them in plain language. Net.Medic also provides 
a diagnosis and prescription for the problem in its Diagnosis window. 

Monitoring your Internet vital signs

By continuously monitoring activity along your end-to-end connection, Net.Medic tells you exactly what’s happening 
at every critical juncture. Net.Medic is constantly monitoring the health of your online connection even when you are 
not transferring Web pages. Consequently, you can use the Net.Medic dashboard and inlay to scan for potential hot 
spots even when you’re not retrieving Web pages.

Note

For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic 
Results” Web page. This Web page is located on the technical support section of the VitalSigns Web site 
(www.vitalsigns.com).

What do you want to know more about?

n How Net.Medic animates your online connections for you

n Parts of the Web path monitored by Net.Medic 

n How Net.Medic remedies many Internet ailments 

n How Net.Medic recommends prescriptions for Internet ailments 

n How Net.Medic contacts an appropriate resource for assistance 

n How to get started using Net.Medic



Parts of the Web path monitored by Net.Medic

Net.Medic monitors each component in your Web path. You can quickly check the vital signs of your unique Web 
path with Net.Medic’s animated end-to-end overview provided in its Activity pane. 

Note

n The rate of page animation reflects the current transfer rate.

n To learn more about an icon in the Activity pane, move your pointer over it. Net.Medic’s balloon help displays a 
brief description of the icon. 

n You will see two sets of routers if you are retrieving information from an Internet Web server and are connected 
to the Internet through a modem. The first set is the ISP routers and the second set is the Internet backbone 
routers. If you are connected to a corporate Intranet, you will see three sets of routers. The Intranet routers will 
be the first set of the three router sets.

n If you are connected to a corporate Intranet and the Web server is also on the corporate Intranet, you will only 
see one set of Intranet routers connected by a white line.

n For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic 
Results” Web page. This Web page is located on the technical support section of the VitalSigns Web site 
(www.vitalsigns.com).

What do you want to know more about?

n What exactly are router hops? 

n Why is router hop information important? 

n How Net.Medic animates your online connections for you

n Understanding the monitored Web page activities 

n How to identify objects in your Web path 



Path components

Your computer, which is at the beginning of your Web path.

Your modem, which connects your desktop computer to your ISP. (If you connected via a local 
area network [LAN], this component is not shown because it’s not in your Web path.)

Each router that was traversed to connect your desktop computer to the remote server. Each 
router hop icon represents an Intranet router, ISP router, or Internet backbone router in your 
Web path.

The remote server, which is at the end of your Web path.

All of the preceding icons are colored to indicate the current health of the component. Gray, yellow, and red 
respectively indicate good, moderate, or poor health of each component in your path.



Identifying objects in your Web path

Net.Medic’s Identify feature allows you to identify the following components in your Web path:

n The company’s Intranet

n Your ISP

n The remote Web server

To identify the Intranet in your path (if there is one)

Right-click on one of the Intranet router hop icons in the Activity 
pane and choose Identify from the pop-up menu.

Right-click anywhere in the Intranet dashboard pane and choose 
Identify from the pop-up menu. 

To identify the ISP in your path

Right-click on one of the ISP router hop icons in the Activity pane 
and choose Identify from the pop-up menu.

Right-click anywhere in the ISP dashboard pane and choose 
Identify from the pop-up menu. 

To identify the remote Web server in your path

Right-click on the server icon  in the Activity pane and choose 
Identify from the pop-up menu.

Right-click anywhere in the Server pane and choose Identify from 
the pop-up menu. 

Note

The Net.Medic inlay also supports this Identify feature. For example, to identify the remote Web server, right-click on 
the server icon in the Net.Medic inlay and choose Identify from the pop-up menu.



How Net.Medic animates your online connections for you

Net.Medic animates your online connections so you can easily check the vital signs of your current Web path. It 
continuously monitors the components and activity along your path.

Web page activity is animated as it occurs. Net.Medic also tells you exactly what’s happening at every critical 
juncture (for example, Net.Medic reports it is connecting to a new site and transferring data). 

Note

n The rate of page animation reflects the current transfer rate.

n The page icon orbits your computer icon     to indicate that the current Web page is being retrieved from your 
computer’s cache rather than from the remote server.

n For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic 
Results” Web page. This Web page is located on the technical support section of the VitalSigns Web site 
(www.vitalsigns.com).

What do you want to know more about?

n How to interpret colors in your dashboard

n How to identify objects in your Web path

n Parts of the Web path monitored by Net.Medic

n Understanding the monitored Web page activities

n What exactly are router hops?

n Why router hop information is important 

n Using router hops to obtain more detailed information 



Understanding the monitored Web page activities

Net.Medic displays status messages in its Activity pane to provide you with details about your current Web page 
activities. The following are the possible status messages along with a description.

Browser-related status 
messages

Description

Opening a new site. A new site is visited for the first time in the 
current session.

Attempting to get a new 
page.

A new Web page is being visited.

Attempting to resolve 
name...

The Web browser is currently trying to convert 
the name of the remote Web server to an IP 
address.

Name resolved. The name of the remote Web server has been 
successfully converted to an IP address.

Unable to resolve name. The name of the remote Web server could not 
be converted to an IP address.

Attempting to connect to 
server...

The Web browser is currently trying to 
establish a connection to the remote Web 
server.

Connected to server. The Web browser has established a 
connection to the remote Web server.

Already connected to server. An established connection already exists 
between the Web browser and the remote 
Web server.

Unable to connect to server. The Web browser failed to establish a 
connection to the remote Web server.

Transferring data... Currently the Web browser is sending data to 
the remote Web server or receiving data from 
it.

Idle There is currently no data transmission 
between the Web browser and the remote 
Web server.

Page not found The Web page could not be found on the 
remote Web server.

Page relocated The remote Web server indicated that the 
Web page has been moved to another place.

Page access denied The Web page could not be accessed due to 
authorization failure.

Web server has experienced 
problem

The remote Web server indicated that it is 
having a problem (for example, it is currently 
heavily loaded).

Modem call-related status 
messages

Description



Dialing The modem is dialing for a connection.

Proceeding The modem is proceeding to connect to a 
remote modem.

Connected A connection is established with a remote 
modem.

No answer There is no answer from the remote modem.

No Dialtone There is no dial tone and the call could not be 
completed.

Done The call has ended normally.

Remote Disconnect The remote modem has terminated the 
connection, or the line was dropped (for 
example, you accidentally turned off your 
modem while connected).

What do you want to know more about?

n Parts of the Web path monitored by Net.Medic

n How to identify objects in your Web path



Understanding router hops

Net.Medic tracks the number of router hops your computer (the client) traversed to connect to the remote Web 
server. Each router hop icon, which is shown in the Activity pane, represents one router hop along your Web path. 
Net.Medic counts the number of router hops and reports the total number (for example, “10 Hops”). Each router hop 
in your path is shown as a colored dot in the Activity pane. 

Router hop groups 

To help you monitor and pinpoint the source of potential bottlenecks, Net.Medic segregates the router hops in your 
path into different groups. These router hop groups correspond to the different demarcation points or domains (the 
Intranet portion, the ISP portion, and the Internet backbone portion) in your path. 

n If you are retrieving information from an Internet Web server and are connected to the Internet through a 
modem, there will be two sets of routers. The first set is the ISP routers and the second set is the Internet 
backbone routers. 

n If you are connected to a corporate Intranet, there will be three sets of routers. The Intranet routers will be the 
first set of the three router sets. 

n If you are connected to a corporate Intranet and the Web server is also on the corporate Intranet, there will only 
be one set of Intranet routers connected by a white line.

Tips

n To learn more about a group of router hops, move your pointer over one of its icons in the Activity pane. 
Net.Medic’s balloon help displays a brief description of the router hop group.

n The first router in a group is the entry router; the last router in a group is the exit or egress router. 

n To identify your Intranet or ISP, right-click on one of its icons in the Activity pane or right-click on the 
corresponding dashboard pane, and choose Identify from the pop-up menu.

What do you want to know more about?

n How Net.Medic animates your online connections for you

n Understanding the monitored Web page activities 

n Parts of the Web path monitored by Net.Medic

n How to identify objects in your Web path

n The different groups of router hops 

n Why router hop information is important

n Using router hops to obtain more detailed information



Hops when connected via a modem

If you’re connected to the Internet via a modem, there are two distinct groups of router hops in your Web path.

n ISP routers 

n Internet backbone routers 

Net.Medic calculates the health of the following router hops and then colors the router hop icons as follows:

n ISP entry router

n ISP egress router

n Internet entry router 

n Internet egress router 

n The remaining ISP and Internet router hops (the routers between the entry and egress routers)

n The entire group of Intranet routers 

Note that all of router hop icons in the Intranet group are always one color (for instance, they are all gray or red at 
any one time).



Hops when connected via an Intranet

If you’re connected to the Internet via a LAN, there are three distinctive groups of router hops in your Web path.

n The first hop group represents the Intranet routers 

n The second hop group represents your ISP routers

n The third hop group represents the Internet backbone routers

For example, the following shows a connection in which the computer must traverse 13 routers (two Intranet 
routers, then five ISP routers, and finally six Internet backbone routers) to connect to the remote server. All Intranet, 
ISP, and Internet backbone routers are gray, which indicates that there are no bottlenecks in this area of your path.

Net.Medic calculates the health of the following router hops and then colors the router hop icons as follows:

n ISP entry router

n ISP egress router

n Internet entry router 

n Internet egress router 

n The remaining ISP and Internet router hops (the routers between the entry and egress routers)

n The entire group of Intranet routers 

Note that all of router hop icons in the Intranet group are always one color (for instance, they are all gray or red at 
any one time).



Different router hop groups

Net.Medic shows the number of router hops in your current Web path. Each router hop is represented by colored 
dots in the Activity pane. For example, if your computer traverses ten routers to connect to a remote Web server, 
that Web path involves ten hops. Net.Medic segregates your path into different router hop groups. These router hop 
groups correspond to the various demarcation points or domains (the Intranet portion, the ISP portion, and the 
Internet backbone portion) in your path. 

The first router in a group is called the entry router; the last router in a group is called the exit or egress router.

n If you are retrieving information from an Internet Web server and are connected to the Internet through a 
modem, there will be two sets of routers. The first set is the ISP routers and the second set is the Internet 
backbone routers. 

n If you are connected to a corporate Intranet, you will see three sets of routers. The Intranet routers will be the 
first set of the three router sets. If you are connected to a corporate Intranet and the Web server is also on the 
corporate Intranet, you will only see one set of Intranet routers connected by a white line.

Colors of the router hop icons

Net.Medic calculates the health of the following router hops and then colors the corresponding router hop icons in 
the Activity pane:

n ISP entry router

n ISP egress router

n Internet entry router 

n Internet egress router 

n The remaining ISP and Internet router hops (the routers between the entry and egress routers)

n The entire group of Intranet routers 

Note that all of router hop icons in the Intranet group are always one color (for instance, they are all gray or red at 
any one time).

Tips

n To learn more about a group of router hops, move your pointer over one of its icons in the Activity pane. 
Net.Medic’s balloon help displays a brief description of the router hop group.

n By clicking once on a router hop icon, you can obtain detailed performance information about that portion of 
your path. For example, click once on any of the ISP router hop icons to open the ISP dashboard pane.

n You can identify your Intranet or ISP by right-clicking on one of its router hop icons in the Activity pane and 
choosing Identify from its pop-up menu.

n By double-clicking on a yellow or red router hop icon, the Net.Medic health log opens with the matching entry 
highlighted. This features helps you quickly pinpoint the source of a problem.

What do you want to know more about?

n Parts of the Web path monitored by Net.Medic

n How Net.Medic animates your online connections for you

n How to identify objects in your Web path

n Why router hop information is important

n Hops when connected via a modem 

n Hops when connected via an Intranet

n Working with the health log 



Why router hop information is important

Because Net.Medic tracks and monitors the router hops along your Web path, you can quickly check the vital signs 
of your Intranet, your ISP, and the Internet backbone for your unique perspective. To monitor the health of your 
router hops, check their color in the Activity pane.

Identifying bottlenecks

If Net.Medic detects a problem with the Intranet, ISP, or Internet backbone, it colors the corresponding router hop 
icons yellow or red. For example, if the Internet backbone is experiencing a problem, the group of Internet router 
hops is colored yellow.

Isolating the source of a bottleneck

By simply double-clicking on a yellow or red router hop icon in the Activity pane, you can quickly isolate the source 
of a bottleneck. The Net.Medic health log opens with the matching entry automatically highlighted. By double-
clicking on its router hop icon, you can even pinpoint the problem to a particular router within the ISP or Internet 
group (for example, to the ISP entry or egress router).

Tips

n By simply moving your pointer over a router hop icon , you can use balloon help to display a brief description 
of that router hop group.

n By clicking once on a router hop icon, you can obtain detailed performance information about that portion of 
your path. For example, to open the ISP pane in your dashboard click on any of the ISP router hop icons in the 
Activity pane.

n You can use the Identify feature to identify your Intranet, your ISP, or the current remote Web server.

What do you want to know more about?

n Parts of the Web path monitored by Net.Medic

n Using router hops to obtain more detailed information

n Hops when connected via a modem 

n Hops when connected via an Intranet

n Identifying objects in your Web path 

n Working with the health log



How you can use router hop information

You can use the router hops displayed in the Activity pane to obtain more detailed information about your Intranet, 
your ISP, and the Internet backbone.

n To learn more about a group of router hops, move your pointer over one of its icons. Net.Medic’s balloon help a 
displays a brief description of the router hop group.

n To identify your Intranet or ISP, right-click on one of its router hop icons  in the Activity pane and choose 
Identify from the pop-up menu. (You can also right-click anywhere in the Intranet pane or ISP pane and choose 
Identify from the pop-up menu.)

n To obtain more detailed information about the performance of your Intranet, your ISP, or the Internet backbone, 

left-click on any of its router hop icons  in the Activity pane. The corresponding pane opens in the dashboard 
with details about the performance of that portion of your Web path. 

For instance, click any of the Internet router hop icons (the yellow dots in the following figure) to obtain more 
information about why the Internet backbone is experiencing problems. 

The Internet pane opens in the dashboard.

To obtain more information about a health problem, double-click on a yellow or red router hop icon. The 
Net.Medic health log opens with the matching entry highlighted. This feature helps you quickly pinpoint the 
source of a health problem.

What do you want to know more about?

n Parts of the Web path monitored by Net.Medic

n Identifying objects in your Web path 

n Working with the health log

n Hops when connected via a modem 

n Hops when connected via an Intranet



How Net.Medic remedies common Internet ailments

Net.Medic helps eliminate a number of Web slowdowns so you won’t even encounter them. Sometimes after 
identifying a problem and describing it in clear language, Net.Medic asks if you want the problem remedied. 
Net.Medic’s AutoCure feature lets you choose the solution. For example,

n If a    modem is not operating at optimal speed because it’s not taking advantage of compression, Net.Medic 
notifies you. It then asks if you want the connection optimized. With a simple click of a button, you can direct 
Net.Medic to go ahead and remedy the problem. The next time you log in, you should begin to see an 
improvement in your modem’s performance.

n If you have an unresponsive remote Web server, Net.Medic re-initiates requests to fix hung connections, and 
thereby eliminates long waiting times, manual re-tries, and time-outs. 

Sometimes after identifying a problem and describing it in clear language, Net.Medic asks if you want the problem 
remedied. With a click of a button, you can direct Net.Medic to fix the problem instantly.

What do you want to know more about?

n How Net.Medic recommends prescriptions for Internet ailments 

n How Net.Medic contacts an appropriate resource for assistance 

n How to get started using Net.Medic



Eliminating many network slowdowns

Net.Medic helps eliminate network slowdowns such as the following:

n If you have a slow modem because of improper configuration settings, Net.Medic automatically resets your 
modem’s configuration settings for compression. 

n If you have an unresponsive server, Net.Medic reloads the screen or re-initiates requests to hung connections. 
This capability eliminates long waiting times, manual re-tries, and time-outs.



How Net.Medic recommends prescriptions for Internet ailments

Net.Medic quickly identifies many desktop or modem slowdowns and makes recommendations about how to 
eliminate them. For example, if your modem is not able to connect at optimal speed (19,200 kbps vs. 33,600 kbps), 
Net.Medic recommends that you upgrade your modem. 

To substantiate its recommendations, Net.Medic also provides the following clear and simple reports:

n Net.Medic health log 

n Net.Medic history reports

n Net.Medic call log 

n Session Summary window

n Health Summary Report

What do you want to know more about?

n Working with the health log 

n Working with the history reports 

n Working with the call log 

n Getting a session summary 

n Getting a monthly summary 



How Net.Medic contacts an appropriate resource about an ailment

When your Internet performance requires additional assistance, Net.Medic tells you who to contact and even 
automates your requests for assistance. 

n For slow or unreliable ISP connections, Net.Medic recommends you contact your ISP. 

n If Web sites are performing poorly, Net.Medic suggests you contact the Webmaster. Net.Medic automatically 
generates an E-mail message to the appropriate party and asks for your permission to send it. Note that the E-
mail notification feature is only available with the retail version of Net.Medic.

Note

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users.

n As part of the E-mail, Net.Medic automatically includes a record of the problem. After formatting the text for the 
E-mail message, Net.Medic asks for your permission to send it to the appropriate party. Unless you tell 
Net.Medic to send the E-mail notification, it will not be sent.

n You can use Net.Medic’s Identify feature to identify your Intranet, ISP, or the current remote Web server.

What do you want to know more about?

n How Net.Medic helps you notify the appropriate resource about a problem 

n Identifying objects in your Web path

n Tips on interpreting Net.Medic E-mail notifications (for E-mail recipients) 



How Net.Medic helps you notify the appropriate resource about a problem

If the prescription for an Internet ailment is to notify an appropriate resource (for example, your ISP or Webmaster), 
Net.Medic tells you this, creates the E-mail message that contains detailed information about the problem, and asks 
you for permission to send it. Note that the E-mail notification feature is only available with the retail version of 
Net.Medic.

Note

· If the remedy is to send an E-mail, Net.Medic notes this in the Prescription portion of its Diagnosis window. As 
part of the E-mail, Net.Medic automatically includes a record of the trouble. If it is inappropriate to send E-mail 
due to the nature of the problem, the Notify button is grayed out (disabled). 

· Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about 
intermittent problems. This, in turn, will enable them to focus on solving chronic problems that plague their 
users.

· After formatting the text for the E-mail message, Net.Medic asks for your permission to send it to the 
appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent.

To use Net.Medic to send an E-mail to an appropriate resource

1 Open the health log.

2 In the health log, locate the problem you want more information about and double-click on it. 

3 The Diagnosis window opens with a diagnosis and prescription for the problem. In the Diagnosis window, click 
Notify. An E-mail message opens with details about the problem along with the probable cause. Net.Medic also 
fills in the subject of the E-mail message and its recipient (for example, your ISP or Webmaster). 

4 Click the envelope button to send the E-mail to the specified resource. Net.Medic notifies you that it has sent the 
E-mail.

Tip

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users.

n To keep a record of the reported problems, you can print the E-mail messages.

What do you want to know more about?

n Working with the health log 

n Working with the Diagnosis window

n Tips on interpreting Net.Medic E-mail notifications (for E-mail recipients) 



To open the health log, use any of the following methods

Double-click on a hot spot (a yellow or red icon) in the Activity 
pane.

Click  in the Net.Medic toolbar.

Choose Health Log from the Net.Medic Window menu.

Right-click on the Net.Medic icon in the system tray area of your 
taskbar.    (Note that the Net.Medic icon can be gray, yellow, or 
red depending on your current overall online health.)

Choose Health Log from the Net.Medic pop-up menu.

Tip

n You can also open the health log by double-clicking on certain objects in panes other than the Activity pane (for 
example, the bank of health lights in the Modem pane). To check if the object supports double-clicking, move 
your pointer over it. If a magnifying glass appears, double-click on the object to open the health log.

n When you open the health log by double-clicking on a yellow or red Net.Medic icon, Net.Medic automatically 
highlights the matching entry in the log. This feature helps you quickly pinpoint the source of the problem without 
manually searching through the log.



Chronic problem

The last column of the health log reports the number of times Net.Medic has encountered the same problem during 
the past 30 minutes. Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This 
policy will help to minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails 
about intermittent problems. This, in turn, will enable them to focus on solving chronic problems that plague their 
users. 

After formatting the text for the E-mail message, Net.Medic asks for your permission to send it to the appropriate 
party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent. Note that the E-mail notification 
feature is only available with the retail version of Net.Medic.



To get started using Net.Medic

n Start Net.Medic for the first time by double-clicking the Net.Medic icon on your desktop.

The Net.Medic dashboard automatically opens on your desktop. The dashboard initially reports your connection 
is “Idle” if you are using a modem. The Net.Medic system tray icon appears in your taskbar.

n If you’re not already connected to the Internet, connect to it now.

n Use your Internet browser to visit one of your favorite Web sites and watch Net.Medic animate this online 
connection. 

n Snap the Net.Medic Activity pane onto your browser.

Right-click on the Activity pane in the Net.Medic dashboard and choose Snap On Browser from the pop-up 
menu. The Activity pane snaps onto your browser as an inlay.

n Minimize the Net.Medic dashboard by clicking  in the Net.Medic title bar. This lets you conserve desktop 
space and monitor your online session from your browser.

n Use the Net.Medic inlay to monitor your current Web path while you surf the Web with your browser.    Net.Medic 
reports your current status (for example, “Transferring data…”). 

n Check the inlay for hot spots.

The color of the inlay objects indicates the health of the different components of your Web path. Gray, yellow, 
and red respectively indicate good, moderate, or poor health. A hot spot is indicated when an object turns yellow 
or red. For example, a yellow modem icon indicates a health problem with your modem. The yellow dots, which 
represent your ISP router hops, indicate there is a health problem with the ISP portion of your path. 

n When an icon turns yellow or red, double-click on it to pinpoint the cause of the health problem. 

For example, double-click on the yellow modem icon to learn more about the modem problem. The Net.Medic 
health log opens with more information about the hot spot.

n Obtain a diagnosis and prescription for the problem by double-clicking on an entry in the health log. 

The Diagnosis window opens with a diagnosis and prescription for the problem.

n Follow the prescribed remedy for the problem. 

n If Net.Medic can fix the problem, then it lets you know. In this case, click AutoCure in the Diagnosis window to 
have Net.Medic fix the problem. The AutoCure Wizard dialog box opens and explains how Net.Medic plans to fix 
the problem. Click OK to have Net.Medic fix the problem. Note that if the prescription is to send E-mail to the 
appropriate resource (for example, your ISP or Webmaster) and it is a chronic problem, click Notify to have 
Net.Medic generate a detailed E-mail message to the appropriate company or individual. After formatting the 
text for an E-mail notification, Net.Medic asks for your permission to send it to the appropriate party. Unless you 
tell Net.Medic to send the E-mail notification, it will not be sent. The E-mail notification feature is only available 
with the retail version of Net.Medic.

n Click OK to close the AutoCure Wizard dialog box.

n Click Close to shut the Diagnosis window.

n Continue to use the Activity pane to monitor your online activities.

n Get a summary of the session by clicking  in the Net.Medic toolbar. 

The Session Summary window opens and reports the source of bottlenecks in your current online session.

n Click  to close the Session Summary window.

n Shut down Net.Medic.

Right-click on the Net.Medic system tray icon. The Net.Medic inlay and dashboard close and the Net.Medic 
program shuts down. The Net.Medic icon is removed from the system tray to indicate that the Net.Medic 
program and its background monitoring process are no longer running. When you restart your computer, 
Net.Medic will be automatically restarted and its icon will appear in your system tray. 



Note

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users. Note that 
the E-mail notification feature is only available with the retail version of Net.Medic.

n To reopen the Net.Medic dashboard, left-click on the Net.Medic system tray icon.

n To identify the server, your Intranet, or your ISP, right-click on the server icon  or one of the Intranet router hop 
icons or ISP router hop icons in the Activity pane and choose Identify from the pop-up menu.

What do you want to know more about?

n Another example of how to use Net.Medic

n How to work with the Net.Medic dashboard

n How to work with the Net.Medic inlay

n How to identify objects in your Web path 

n How to monitor the health of your online connections 

n How Net.Medic animates your online connections

n How to identify and isolate the cause of the problem 

n How to get a diagnosis and prescription for a problem 

n How to remedy a problem

n Tips on interpreting Net.Medic E-mail notifications (for E-mail recipients) 



Sample session

This example entails Net.Medic detecting a user’s 28.8 kbps modem operating suboptimally because compression 
has not been enabled. Compression allows you to speed up your downloads from remote Web servers. This 
example assumes you have started Net.Medic for the first time and the Net.Medic dashboard is open on your 
desktop.

n Check that you are connected to the Internet.

n Visit one of your favorite Web sites. 

n Snap the Net.Medic Activity pane onto your browser.

Right-click on the Activity pane in the Net.Medic dashboard and choose Snap On Browser from the pop-up 
menu. The Activity pane snaps onto your browser as an inlay.

n Watch the Net.Medic inlay animate this online connection.

Net.Medic reports how many router hops your computer (the client) traversed to connect to the remote Web 

server. Each router hop icon  represents a router hop in your Web path. Net.Medic segregates the router hops 
into different groups. The router hop groups correspond to the distinct regions or domains (the Intranet portion, 
ISP portion, and Internet backbone portion) in your path.

n Check the Net.Medic inlay for hot spots.

The color of icons in the Net.Medic inlay indicate if there are any problems with your current path. For example, 
because the PC and modem icons are yellow, this indicates your desktop computer and modem are 
experiencing some health problems.

n Get more information about the problem.

Check the Modem pane for more information about the modem problem. (If the pane is not already opened, 
click once on the yellow modem icon on your desktop in the Net.Medic inlay.) 

n Use Net.Medic to obtain a diagnosis and possible cure for the modem problem.

Double-click on the modem icon in the Net.Medic inlay to display the Net.Medic health log.

In the health log, double-click the “Modem speed suboptimized” entry to obtain a diagnosis and prescription for 



the problem. The Diagnosis window opens with a diagnosis and prescription for the modem problem. 

In the Diagnosis window, click AutoCure. The AutoCure Wizard dialog box opens and notifies you when it has 
fixed the problem. Net.Medic cures the problem by enabling compression and tuning your modem and desktop 
configuration. If the prescription is to send E-mail to the appropriate resource (for example, your ISP or 
Webmaster), click Notify to have Net.Medic automatically send an E-mail notification. Note that the E-mail 
notification feature is only available with the retail version of Net.Medic.

n In the AutoCure Wizard dialog box, click OK to close the dialog box. 

n In the Diagnosis window, click Close to shut it. 

n Click  in the Net.Medic health log window to close it.

n Before ending the session, obtain a summary of the session.

Click  in the Net.Medic toolbar. The Session Summary window opens and reports the source of bottlenecks in 
your current online session. 

n Click  to close the Session Summary window.

n Reconnect to your ISP and the server so your modem can begin to take advantage of its built-in compression to 
speed up your downloads.

n Visit some of your favorite sites and then get another summary of your current session by clicking  in the 
Net.Medic toolbar.

n Shut down Net.Medic.

Shut down the Net.Medic program and its background monitoring process by right-clicking on the Net.Medic 
system tray icon.

The Net.Medic inlay and dashboard close and the Net.Medic icon is removed from the system tray. Note that the 
Net.Medic background monitoring process is also shut down. When you restart your computer, Net.Medic will be 
automatically restarted and its icon appears in your system tray.

Note

· To reopen the Net.Medic dashboard, left-click on the Net.Medic system tray icon.

· Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will 
help to minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about 
intermittent problems. This, in turn, will enable them to focus on solving chronic problems that plague their 
users.

· For detailed information about how to interpret Net.Medic results, please refer to the “Interpreting Net.Medic 
Results” Web page. This Web page is located on the technical support section of the VitalSigns Web site 
(www.vitalsigns.com).

What do you want to know more about?

n Understanding the monitored Web page activities 

n How to work with the dashboard

n How to work with the inlay

n How to identify objects in your Web path 

n How to monitor the health of your online connections 

n How Net.Medic animates your online connections

n How to identify and isolate the cause of the problem 

n How to get a diagnosis and prescription for a problem 

n How to remedy a problem

n Tips on interpreting Net.Medic E-mail notifications (for E-mail recipients) 



Health Log

This health log describes the problems Net.Medic has encountered. The last column reports the number of times 
Net.Medic has encountered the same problem over the past 30 minutes. Net.Medic helps you pinpoint the problem 
by automatically highlighting the matching entry in the log when you open it by double-clicking on a hot spot. For 
instance, by double-clicking on the yellow modem icon you are immediately notified that the problem is related to 
the configuration of the serial port.



AutoCure Wizard dialog box

A gauge at the top of this dialog box is incremented as Net.Medic works to cure the problem. After it fixes the 
problem, it informs you “Cure Complete.” 



Diagnosis window

In this case, Net.Medic can cure the problem and prompts you to click AutoCure to have the problem fixed. If the 
cure had been to notify your ISP, by clicking Notify you can have Net.Medic generate a detailed E-mail message to 
the appropriate company or individual. After formatting the text for an E-mail notification, Net.Medic asks for your 
permission to send it to the appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be 
sent. Note that the E-mail notification feature is only available with the retail version of Net.Medic.

 



This is a problem which you would probably not be aware of or able to pinpoint without Net.Medic. In addition, 
Net.Medic is able to automatically fix the problem after prompting you to click AutoCure. Without Net.Medic, you 
would manually have to fix the problem. Net.Medic’s robust capability to remedy slow online connections ultimately 
saves you time and money. 



Tips

Here are some tips to help you deal with the various types of online communications problems. A tip on how to 
understand and interpret Net.Medic E-mail notifications is also included for E-mail recipients (Webmasters, system 
administrators, and ISPs). Note that the E-mail notification feature is only available with the retail version of 
Net.Medic.

What do you want tips on?

n Tips on accessing missing Web sites

n Tips on balloon help

n Tips on busy signals

n Tips on dropped connections

n Tips on modem and phone line problems

n Tips on modem problems 

n Tips on saving hard disk space to speed up Web page transfers

n Tips on snapping dashboard panes and the ticker tape onto the browser 

n Tips on unanswered calls

n Tips on interpreting Net.Medic E-mail notifications 



Tips on interpreting Net.Medic E-mail notifications

Net.Medic automatically generates an E-mail notification for chronic problems and severe warnings. In order to help 
the E-mail recipient (for example, Webmasters, system administrators, or ISPs), understand and interpret the 
contents of a Net.Medic E-mail notification, the E-mail notification now includes an event number. Note that the E-
mail notification feature is only available with the retail version of Net.Medic.

This event number is a link to the VitalSigns Web site. E-mail recipients can click on the link to open a Web page 
that contains more detailed information about the specific problem reported by the Net.Medic user.



Tips on balloon help

Balloon help is available for certain objects in the Net.Medic dashboard. Move your pointer over an object. If balloon 
help is available, a magnifying glass appears and the Net.Medic displays a brief description of the object. For 
example, if you’re connected via a modem, move the pointer over the first or second group of router hop icons. As 
the following figures show, Net.Medic displays a brief description of the router hop group. 

If you are having problems displaying Net.Medic’s balloon help, try the following:

n Reselect the Net.Medic dashboard window and then move the pointer over the object you want balloon help on.

n Snap the Net.Medic pane or inlay back onto the dashboard and then move the pointer over the object you want 
balloon help on.



Tips on snapping dashboard panes and the ticker tape onto your browser

Here are some tips if you are experiencing browser-related problems.

n Check that you are running Netscape Communicator 4.0, Netscape Navigator 3.x, Microsoft Internet Explorer 
4.0, or Internet Explorer 3.x.

n if you are having problems snapping a Net.Medic dashboard pane onto your browser, check that your browser’s 
toolbar preferences are set to support pictures and text. For example, with Netscape Navigator 3.0 choose 
General Preferences from the Options menu. The Preferences window opens with the Appearance panel 
displayed. In the Toolbars section of the Appearance panel, verify that the Pictures and Text option is selected, 
and then click OK.

n In addition to snapping a dashboard pane onto your browser, you can snap and detach the Net.Medic ticker 
tape onto your browser.    With Netscape Navigator, you can snap a dashboard pane and the ticker tape 
concurrently. With Internet Explorer, you can only snap a dashboard pane or the ticker tape. 

n If the Net.Medic dashboard pane or ticker tape not snap onto the Internet Explorer window, check that the 
browser window is wide enough to display the Net.Medic inlay. If it is not, widen the browser window.

n If the dashboard pane or ticker tape does not snap onto your browser, check that your browser window is not 
minimized (closed) on your desktop. 

n Net.Medic remembers the last pane snapped onto the browser and will automatically resnap it the next time you 
start the browser.

What do you want to know more about?

n Tips on balloon help

n List of dashboard panes 

n Working with the Net.Medic inlay 



Tips on modem and phone line problems

Here are some tips if you are experiencing problems with your modem or phone line(s).

n If your phone line has call waiting and you’re using a modem to connect to the Internet, then you must turn off 
call waiting. If you need more information about how to turn off call waiting, contact your phone company.

n If you’re dialing your ISP from a business that requires a “9” for an outside phone line, you must add a “9” prefix 
to your dial-in string. To change the dial-in string, use the set-up dialog box provided by your ISP. If you need 
more information about modifying your dial-in string, contact your ISP.

n If you’re not getting maximum modem performance after installing a modem and drivers, verify that your 
browser is correctly configured. If the problem persists, then contact your phone company to check if your phone 
line is wired for an Internet connection. If your phone line is wired for an Internet connection and the problem 
persists, then you should consider buying a teleprotector.

What do you want to know more about?

n Tips on busy signals

n Tips on dropped connections

n Tips on modem problems

n Tips on unanswered calls 

n Working with the Net.Medic call log 

n Getting a diagnosis and prescription for a problem



Tips on modem problems

Here are some tips if you are experiencing modem problems.

n Verify that your modem is plugged in and turned on.

n Check that your modem’s phone cord is securely inserted at both ends of the connection.

n If you have an external modem, check that the phone line is securely plugged into the proper modem socket.

n If you have an internal modem, check that the phone line is securely plugged into your computer’s modem 
socket.

n Check that you are using the correct dial-in string.

n If you’re dialing your ISP from a business that requires a “9” for an outside phone line, you must add a “9” prefix 
to your dial-in string. To change the dial-in string, use the set-up dialog box provided by your ISP. If you need 
more information about modifying your dial-in string, contact your ISP.

n Your computer’s ability to use its modem port may be hampered if you are running telephony or communications 
software (for example, fax software). If you’re using such software, try the following:

1. Close the telephony or communications software.

2. Move the telephony or communications software from the Startup program group to another Windows group.

3. Restart your computer and then reconnect to the Internet.

n Use the Net.Medic’s call log to obtain more information about your modem calls made over the past month.

What do you want to know more about?

n Tips on busy signals

n Tips on dropped connections

n Tips on modem and phone line problems

n Tips on unanswered calls 

n Working with the Net.Medic call log 

n Getting a diagnosis and prescription for a problem



Tips on busy signals

Net.Medic’s call log tracks the number of busy signals your modem encountered over the past month. Busy signals 
are caused by your ISP’s inability to handle customer demand. For example, if your ISP does not have enough 
modems in their dial-in modem bank, your modem will routinely encounter busy signals. 

Before switching to another ISP, contact your ISP and ask them the following questions:

1. How many users are there currently in your geographical area?

2. Do they have a local newsgroup that provides information and tips about their services?

3. How many dial-in phone numbers are there for your geographical area?

4. What is the ratio of users to dial-in phone numbers?

When evaluating the ratio of users to dial-in phone numbers, use the following guidelines. ISPs should have no 
more than 10 to 15 users per dial-in phone number in an area. If an ISP has more than 20 users per dial-in 
phone number, it usually means you’ll routinely get a busy signal.

Before switching to another ISP, ask the prospective ISP these same questions. 

What do you want to know more about?

n Tips on dropped connections

n Tips on modem and phone line problems

n Tips on modem problems 

n Tips on unanswered calls 

n Working with the Net.Medic call log 

n Getting a diagnosis and prescription for a problem



Tips on unanswered calls

If you have dialed your ISP and your call rings endlessly, here is some information that could help:

n Unanswered calls are usually caused by your phone company, which provides the dial-in lines, and not your ISP.

n Most ISPs use groups of dial-in lines called hunt groups. Problems related to hunt groups are difficult to detect 
and troubleshoot. Consequently, to protect yourself against such problems, ask your ISP for a list of your hunt 
group’s phone numbers. If you have this list of phone numbers, you can dial any of these direct phone numbers 
to connect to your ISP rather than dialing the hunt group’s dial-in string.

n Ask your current or prospective ISP if they use hunt groups. If they do, then ask for a list of hunt group phone 
numbers.

n Use the Net.Medic’s call log to obtain more information about your past month’s modem calls.

What do you want to know more about?

n Tips on busy signals 

n Tips on dropped connections

n Tips on modem and phone line problems

n Tips on modem problems 

n Working with the Net.Medic call log 

n Getting a diagnosis and prescription for a problem



Tips on dropped connections

When you’re connected to the Internet and unexpectedly disconnected, this is called a “dropped connection.” The 
following information may help you deal with this situation:

n The cause for dropped connections are difficult to pinpoint and fix. Net.Medic, however, tracks dropped 
connections. Along with its diagnosis, if possible, it provides a prescription in its health log.

n If you’re experiencing dropped connections, you may want to contact your phone company. If Net.Medic detects 
this problem, it automatically creates an E-mail that you can send to your phone company. Note that the E-mail 
notification feature is only available with the retail version of Net.Medic.

n Most modems sold today sense and adapt to the quality of the phone line. For example, a 28.8 kbps modem 
adapts to the quality of the phone line. Because of this adaptive behavior, the modem’s speed can fluctuate 
between 19.2 kbps and 28.8 kbps. Check the Net.Medic Modem pane for details on your modem’s performance.

n Because the average phone line was not originally designed to transfer data, such techniques as data 
compression are used to increase the amount of data that can be transferred over phone lines. If your modem is 
connected at a speed greater than 9.6 kbps, the modem connection speed may be faster than 9.6 kbps at 
certain times. 

n The various brands and models of modems vary significantly in their ability to adapt to poor-quality phone lines 
and to the wide range of modems used by ISPs. For more information about a specific modem, check for 
newsgroups that discuss modems (for example, the UseNet newsgroup named comp.dcom.modems).

What do you want to know more about?

n Net.Medic Modem pane 

n Getting a diagnosis and prescription for a problem

n Working with the Net.Medic call log 

n Working with the Net.Medic health log 



Tips on accessing missing Web sites

If you’ve tried to revisit a remote Web site and encountered such error messages as “…unable to find server,” this is 
a DNS-related problem. Such problems occur if:

n You’ve incorrectly entered the site’s URL in your browser.

n Your ISP’s DNS server is overloaded.

Unfortunately, DNS servers display the same error message in both of these cases. Consequently, you don’t know 
which condition caused the error message. Net.Medic, however, can help you pinpoint the cause and in some 
cases fix the problem.

When it’s your primary DNS server, Net.Medic reports this situation in its health log, and asks if you want it to fix the 
problem. If you decide to have Net.Medic fix the problem, it provides you with a secondary DNS server to access 
the Internet. If your secondary DNS server is also down, Net.Medic provides you with an alternative backup DNS 
server. If this is a chronic problem, Net.Medic automatically generates an E-mail notification. If it is a chronic 
problem, chick the Notify button in the Diagnosis window to generate an E-mail your ISP. After formatting the text for 
an E-mail notification, Net.Medic asks for your permission to send it to the appropriate party. Unless you tell 
Net.Medic to send the E-mail notification, it will not be sent. 

Note that the E-mail notification feature is only available with the retail version of Net.Medic.

What do you want to know more about?

n Working with the Net.Medic health log 

n Getting a diagnosis and prescription for a problem 



Tips on saving space on your hard disk

Here are some tips to save hard disk space on your computer. 

n When using Internet Explorer 3.0, regularly empty its trash by completing the following steps:

1 On your desktop, right-click on the Internet Explorer icon (by default, this icon is named “The Internet”) and 
choose Properties. 

2 In the displayed Properties window, click the Advanced tab. 

3 In the Temporary Internet file section of the Advanced panel, click Settings then click Empty Folder.

4 Click Yes when asked if you want to delete all the empty folders.

5 Click OK to close the Properties window.

n Regularly empty your desktop’s trash too. By default, the trash icon is named “Recycle Bin.” To empty this trash, 
right-click on the trash icon and choose Empty Recycle Bin from the pop-up menu.

n Clean out your cache or increase its size. By increasing your computer’s cache, you can retrieve Web pages 
faster. 

n With Netscape Navigator 3.0, increase your computer’s cache size by choosing Options and then Network 
Preferences. In the displayed Preferences window, check that the Cache tab is selected and then use it to 
empty your cache or increase the size of your cache. 

n With Internet Explorer 3.0, choose View and then Options. Click the Advanced tab and select the Settings 
button. Either purge the folder by selecting Empty folder or change the percentage of disk space Internet 
Explorer uses.

Note

n You can get a quick checkup of your computer’s health by checking the color of its icon  in the Net.Medic 
Activity pane. Gray, yellow, and red respectively indicate good, moderate, or poor health.

n Check the Net.Medic Client pane for more detailed information about your computer’s online performance.

What do you want to know more about?

n Net.Medic Activity pane 

n Net.Medic Activity pane icons 

n Net.Medic Client pane 



To start Net.Medic

On your desktop, open the folder that contains the Net.Medic icon 
and double-click on it. 

In your taskbar, select the Net.Medic menu option from the 
Start/Programs submenu. By default, Net.Medic is installed into 
the StartUp programs group. For instance, if you’ve installed 
Net.Medic into the StartUp programs group, then you would click 
the Start bar, choose Programs, StartUp, and Net.Medic.

Tips

n By default, Net.Medic is placed in the Startup folder under Programs accessible through the Start menu on your 
taskbar. If Net.Medic is installed in your StartUp folder (the recommended configuration), it will automatically 
start every time you reboot your computer.

n When you restart your computer, the Net.Medic icon appears in your system tray. To open the Net.Medic 
dashboard, left-click once on the Net.Medic system tray icon.

What do you want to know more about?

n How to exit (shut down) Net.Medic 



To exit (shut down) Net.Medic

Net.Medic’s background monitoring process continues to track your online activity even when the Net.Medic 
program is closed (minimized) on your desktop. To shut down the Net.Medic program and its background 
processing, you must exit Net.Medic.

To exit (shut down) Net.Medic

1 In the taskbar, right-click on the Net.Medic icon  in the system tray.

2 From the pop-up menu, choose Exit.

Net.Medic’s background monitoring processes stops and its icon  is removed from your system tray. When 
you restart your computer, the Net.Medic icon reappears because Net.Medic is automatically reloaded when you 
start Windows.

Tips

n By default, Net.Medic is placed in the Startup folder under Programs accessible through the Start menu on your 
taskbar. If Net.Medic is installed in your StartUp folder (the recommended configuration), it will automatically 
start every time you reboot your computer. 



icon in your taskbar

To reopen the dashboard, click once on the Net.Medic icon in your taskbar:

or 

right-click on the Net.Medic icon in your system tray.



To open the dashboard

Left-click on the Net.Medic system tray icon.

Right-click on the Net.Medic system tray icon and choose 
Dashboard from the pop-up menu. 

Note

The color of the Net.Medic system tray icon  varies depending on the overall health of your current online 
session.



Color of the Net.Medic system tray icon

Color Meaning

Gray Your overall online health is good.

Yellow Your overall online health is fair.

Red Your overall online health is poor.



To close the dashboard

In the Net.Medic title bar, click  to minimize the Net.Medic 
dashboard on your desktop.

In the Net.Medic title bar, click  to close the Net.Medic 
dashboard and/or inlay.

In the Net.Medic menu bar, pull down the File menu and choose 
Close.

Note

This process closes the Net.Medic dashboard on your desktop without shutting down the Net.Medic program. To 
shut down the Net.Medic program, right-click on the Net.Medic system tray icon and choose Exit from the pop-up 
menu.



Understanding the Net.Medic dashboard

Click on a part of the Net.Medic dashboard frame to obtain more information about it.



Title bar

Consists of the System pull-down menu and buttons used to minimize or close the Net.Medic dashboard.

Click to display the System pull-down menu that can be used for such 
tasks as closing (minimizing) the Net.Medic dashboard.

Click to minimize the Net.Medic dashboard on your desktop without 
shutting down the Net.Medic program.

Click to close the Net.Medic dashboard and/or inlay without shutting 
down the Net.Medic program.

Note

To shut down (exit) the Net.Medic program, right-click on the Net.Medic system tray icon 

 and choose Exit from the pop-up menu. Note that the Net.Medic icon can be gray, yellow, or red. The color varies 
depending on the overall health of your current online session.



Net.Medic menu bar

The Net.Medic menu bar consists of a set of pull-down menus. To pull down a menu, click on it in the menu bar.

Menu Option Description

File Close Closes the Net.Medic dashboard on your 
desktop without shutting down the Net.Medic 
program. Because Net.Medic is still running, 
the Net.Medic system tray icon remains in your 
taskbar.

View Home Opens only the Activity pane, the Throughput 
pane, and the Retrieval pane in the Net.Medic 
dashboard.

Details Opens the Details submenu from which you can 
open a particular pane in the Net.Medic 
dashboard:

n Choose My PC to open the Client pane.

n Choose Modem to open the Modem pane.

n Choose Intranet to open the Intranet pane.

n Choose ISP to open the ISP pane.

n Choose Internet to open the Internet pane.

n Choose Server to open the Server pane.

Summaries Opens the Summaries submenu from which you 
can open a particular pane in the Net.Medic 
dashboard:

n Choose Activity to open the Activity pane.

n Choose Throughput to open the Throughput 
pane.

n Choose Retrieval to open the Retrieval 
pane.

n Choose Connect to open the Connect Time 
pane.

Show 
Toolbar

Opens the toolbar in the Net.Medic dashboard 
window.

Hide 
Toolbar

Closes the toolbar in the Net.Medic dashboard 
window.

Vertical 
Layout

Displays the Net.Medic dashboard window 
vertically on your desktop.

Horizontal
Layout

Displays the Net.Medic dashboard window 
horizontally on your desktop.

Open All Opens all the panes in the Net.Medic dashboard 
window.

Close All Closes all the panes in the Net.Medic dashboard 
window.

Preference
s

Opens the Net.Medic Preferences window, which 
you can use to change the Net.Medic E-mail, 
ticker tape, display colors, performance, and 
other preferences.

Windo Call Log Opens the Net.Medic call log.



w

Health Log Opens the Net.Medic health log.

History 
Reports

Opens the History Reports submenu from which 
you can view and print the various Net.Medic 
history reports.

Session 
Summary

Opens the Net.Medic Session Summary window 
that gives you a summary of your current online 
session.

Help Help Opens this Net.Medic help system on your 
desktop.

VitalSigns 
Home 
Page

Opens the VitalSigns home page in your 
browser.

Register 
Net.Medic

Opens the VitalSigns Web page, which contains 
information about registering your Net.Medic 
product.

Release 
Notes

Opens the VitalSigns Web page, which contains 
release note information about the Net.Medic 
product.

Technical 
Support

Opens the VitalSigns Web page, which contains 
technical support information (for example, 
Net.Medic frequently asked questions [FAQs]) 
about the product.

Feedback Opens the VitalSigns Feedback page that you 
can use to send VitalSigns your feedback on the 
Net.Medic product.

About 
Net.Medic

Displays the version number of the Net.Medic 
software.

Note

To shut down (exit) the Net.Medic program, right-click on the Net.Medic system tray icon, and choose Exit from the 

pop-up menu. The Net.Medic program and background monitoring process shuts down and the Net.Medic icon     
is removed from the system tray. The next time you restart your computer, Net.Medic is automatically started and its 
icon appears in your system tray.



Net.Medic system tray menu options

The Net.Medic system tray icon has a pop-up menu that you can use to quickly perform certain tasks. Net.Medic 
adds its own menu options to the standard Windows menu options. Right-click on the Net.Medic system tray icon to 
display its pop-up menu.

Net.Medic 
menu 
options

Description

Dashboard Opens the Net.Medic dashboard on your desktop.

Health Log Opens the Net.Medic health log on your desktop.

Call Log Opens the Net.Medic modem call log on your desktop.

Reports Opens the Net.Medic History Reports window from which you 
can view and print the various Net.Medic history reports.

 

Session 
Summary

Opens the Net.Medic Session Summary window that 
provides a summary of your current online session.

About Displays the version number of the Net.Medic software.

Exit Exits (shuts down) the Net.Medic program. Net.Medic’s 
background monitoring process is also shut down and the 
Net.Medic icon is removed from your system tray. The next 
time you restart your computer, the Net.Medic program starts 
automatically.



Health log menu options

The Net.Medic health log has of a set of pull-down menus. To pull down a menu, click on it in the menu bar.
Menu Option Description

File Print Prints the health log.

Close Closes the health log.

View This Session Displays only the health log entries for the 
errors encountered during the current 
session.

Past Day Displays only the health log entries for the 
errors encountered over the past day.

 

Past Week Displays only the health log entries for the 
errors encountered over the past week.

Show 
Acknowledg
e

Displays only the health log entries that you 
have acknowledged during the specified time 
period (for example, during this session or 
over the past week).

Refresh Updates the entries in the health log to 
include any errors reported since you’ve 
displayed the health log.



Toolbar

At the top of the Net.Medic dashboard frame there is a toolbar that contains the following buttons.

Health Log button. Click to open the Net.Medic health log. Note that 
this button changes colors to indicate the current overall health of 
your online connection.

Modem Call Log button. Click to open the Net.Medic modem call 
log.

History Reports button. Click to display the Net.Medic History 
Report window from which you can view and print the different 
history reports. 

Session Summary button. Click to display the Net.Medic Session 
Summary window, which gives you a summary of your current 
online session.

Network Activity button. Click to open and close the Activity pane in 
the Net.Medic dashboard.

Throughput button. Click to open and close the Throughput pane in 
the Net.Medic dashboard.

Retrieval button. Click to open and close the Retrieval pane in the 
Net.Medic dashboard.

Connect Time button. Click to open and close the Connect Time 
pane in the Net.Medic dashboard.

Help button. Click to open the Net.Medic help system on your 
desktop.

VitalSigns Home Page button. Click to load the VitalSigns home 
page into your browser.



What is the Net.Medic ticker tape?

The Net.Medic ticker tape reports the following information:

n The name of the Web site you are currently visiting

n The number of times you have visited the current site

n The URL and size of the Web page you are currently transferring

n The delay caused by the network expressed as an estimated percent

n The latest health log entry

n Any of your unread E-mail messages that meet the specified criteria 

n Any broadcast E-mail messages from your service provider (for example, “the DNS server will be down from 
11:00 PM to 11:30 PM tonight.”)

Tips

n To snap the ticker tape onto your browser, right-click anywhere in the ticker tape and choose Snap On Browser. 
With Netscape Navigator, you can snap a dashboard pane and the ticker tape concurrently. With Internet 
Explorer, you can only snap a dashboard pane or the ticker tape.

n To detach the ticker tape from your browser, right-click on the ticker tape and choose Snap on Dashboard.

n Individual Net.Medic users can use the ticker tape E-mail feature to send E-mails that will be displayed in other 
individual users’ Net.Medic ticker tape. To use this capability, simply include “VitalSigns” in the subject portion of 
your E-mails (for example, “Subject: VitalSigns: The mail server will be down tomorrow.”) After sending such 
messages to other Net.Medic users, it will appear in their ticker tape if the message is delivered by the Microsoft 
Messaging API (MAPI).

n To change the ticker tape preferences, right-click on the ticker tape and choose Preferences. The Preferences 
dialog box opens with the Ticker Tape panel selected. Use the Ticker Tape panel to change the current ticker 
tape preferences. For example, to suppress broadcast messages from the ticker tape, deselect the Mail option 
in the Ticker Tape panel, and then click OK.

What do you want to know more about?

n How can you change the ticker tape preferences? 

n How can system administrators change the user configuration variables? 



Specified criteria

By default, Net.Medic checks your mailbox for unread messages that meet the following criteria: (1) messages that 
were delivered by the Microsoft Messaging API (MAPI), and (2) messages that begin with the string “VitalSigns:” If it 
finds any messages that match this criteria, it automatically displays the message contents in its ticker tape. 

System administrators can customize the search string used to determine if an unread E-mail message should be 
displayed in the Net.Medic ticker tape. To change the default search string (“VitalSigns”), system administrators 
must use the Registry Editor to change the value of the registry variable.



Activity pane

Use the Net.Medic Activity pane to animate your online connections and to determine your overall performance. 
Colored icons are used to represent the health of the various components in your Web path. This pane also reports 
the status of your current online activity (for example, “Attempting to connect to server”), the animation of Web 
pages being retrieved, and the number of hops in your path. For example, the rate of the page animation reflects 
how quickly you are retrieving the current Web page. 

Number of router hops. Net.Medic counts the number of router hops traversed in your current path. Each colored 
dot represents a router hop. For example, if your computer traversed ten routers to connect to a remote server, that 
Web path involves ten router hops.

If you are retrieving information from an Internet Web site and you are connected to the Internet via a modem, you 
will see two sets of routers. The first set is the ISP routers and the second set is the Internet backbone routers. If 
you are connected to a corporate Intranet, you will see three sets of routers. The Intranet routers will be the first set 
of three router sets.

If you are connected to a corporate Intranet and the Web server is also on the corporate Intranet, you will only see 
one set of Intranet routers connected by a white line.

Tips

n To learn more about a group of router hops, move your pointer over one of its icons in the Activity pane. 
Net.Medic’s balloon help displays a brief description of the group.

n If you click once on an object in this pane, the corresponding dashboard pane opens. To open the Intranet pane, 
click an Intranet router hop icon. To open the ISP pane, click an ISP router hop icon. To open the Internet pane, 
click an Internet router hop icon.

n If you double-click on a hot spot in this pane, the Net.Medic health log opens with the matching entry 
highlighted. This feature can help you quickly pinpoint the source of the problem without manually searching 
through the log

n By double-clicking on a health log entry, the Diagnosis window opens with a diagnosis and prescription for the 
problem if possible.

n You can use the Identify feature to quickly identify your ISP, Intranet, or the current remote Web server. 

What do you want to know more about?

n Colored icons in the Activity pane 

n Parts of the Web path monitored by Net.Medic 

n Understanding the monitored Web page activities

n Understanding router hops 

n Why router hop information is important 

n Identifying objects in your Web path 



Throughput pane

Use the Net.Medic Throughput pane to determine how fast you are currently transferring data over the network. 
Transfer speed is shown in kbps. For example, if you are receiving a Web page across the network at a rate of 26.3 
kbps, the Web page is being transferred at a rate of 26,300 bits per second (bps). The transfer speed rate is 
reported in: (1) the recv and send graph that indicates any activity seen on the network/dialup interface of the client, 
(2) the transfer gauge to the right of the recv and send graph, and (3) as a digital display (for example, 26.2 kbps). If 
white tips appear on the transfer gauge, this reflects a data transfer that is using compression and is exceeding the 
modem connection speed.

Speed limit digital display. The speed limit is the estimated maximum speed or bandwidth available end-to-end 
during the current transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 line) and 
automatically calculates your speed limit. You may, however, want to change the current speed limit if the receive 
and transmit rates (the blue vertical bars in the recv and send graph) are high and difficult to read. In this case, 
raising the speed limit will increase the histogram maximum, thereby making the bars shorter in the graph and 
easier to interpret. To manually set the speed limit, right-click on this digital display, choose Speed Limit from the 
pop-up menu, then drag right and choose one of the manual settings.

Recv and send graphs and digital displays. The recv graph and digital display report the receive rate during each 
interval. The send graph and digital display report the transmit rate during each interval. Transfer rates for the 
previous several seconds scroll from right to left with the passage of every second. The send/recv graphs indicate 
any activity seen on the network/dialup interface of the client. If the blue lines have white tips at the top, your 
connection is using compression to speed up the download of Web pages.

What do you want to know more about?

n What do the colors in your dashboard mean? 

n List of dashboard panes

n List of dashboard objects (charts, gauges, etc.) 



Retrieval pane

Use the Net.Medic Retrieval pane for the following purposes: (1) to determine how effectively you are transferring 
data over the network, (2) to establish how much time it takes to retrieve a Web page, and (3) to pinpoint the source 
of the delays.

Time digital display. Reports the total time (delay) taken to retrieve the current Web page. (The retrieval of a Web 
page is an HTTP transfer.) The transfer time is shown in minutes, seconds and tenth of seconds.

Network gauge. Reports an estimated percent of retrieval time caused by a delay in the network that is between 
the Web site and the client (your desktop computer). 

Site gauge. Reports an estimated percent of retrieval time caused by a delay on the server (Web site). The 
Network gauge and the Site gauge measurements combined always total 100%. The Network gauge gives a real-
time indication of the percentage of transfer time attributable to the network. The Site gauge indicates the 
percentage of transfer time attributable to the Web server (the site). For example, if the Network gauge reads 43% 
and the Site gauge reads 57%, this indicates the site is causing most of the delay.

Avg. Rate digital display. Reports the average rate to retrieve the current Web page from the Web site. This rate is 
shown in kbps. 

Note 

Net.Medic separates the amount of delay in retrieving the page into two portions: the delay caused by the network 
and the delay caused by the server. This network delay is the time it takes to make the request from the client to the 
server’s network connection plus the time it takes the results to be returned from the server’s network connection to 
the client. Some of this delay is the propagation delay in the links. The remainder is the delay in packet queues of 
intermediate devices such as routers. In the preceding example, the network contributed to 43% of the delay and 
the remainder belongs to the server.

Tip

n For more information about the network (Internet) portion of your Web path, check the Internet pane in the 
Net.Medic dashboard. 

n For more information about the site, check the Server pane in the Net.Medic dashboard. 

n For a performance rating of the sites you’ve visited the most over the past month, check the Net.Medic history 
reports.

What do you want to know more about?

n What do the colors in your dashboard mean?

n List of dashboard panes 

n List of dashboard objects (charts, gauges, etc.) 

n Working with the history reports 



Client pane

Use the Net.Medic Client pane to determine the performance and overall health of the client (your desktop 
computer). 

Bank of health lights. Reports the overall health of your desktop computer. Green, yellow, and red respectively 
indicate good, moderate, or poor health. For example, yellow indicates a moderate to serious problem with your 
computer. To obtain more information about PC-related problems, check the Net.Medic health log by double-clicking 

on this pane’s yellow or red health light, or on the yellow or red PC icon  in the Activity pane.

CPU Load gauge. Reports what percent of your computer’s CPU is currently utilized. The CPU load is sometimes 
referred to as the system load. The more occupied it is, the slower your browser may work. Spiking (occasional high 
percentages) in this gauge is normal. However, a continually high reading on the gauge indicates a sustained heavy 
CPU load, which could signify an overtaxed computer. Windows 95 will often run at 100% if you have multiple 
applications open.

Cache Hits meter. Reports the percent of Web pages this session retrieved from local disk cache (cache hits) 
rather than retrieving them from the remote Web site. The local cache, or Web page storage, keeps pages from 
Web sites you have previously visited, and stores them on your local hard drive. Once these pages are stored on 
your hard drive, they can be quickly retrieved from your computer the next time you visit that Web site. It is faster to 
“download” from your local drive than from the remote Web site. High numbers in this meter indicate good cache 
management and thus good browsing performance.

 Tips

n The name of your computer (for example, “us.ppp.pdelay”) appears in the upper-left corner of this pane.

n The color of the client icon  in the Activity pane also indicates the computer’s overall health. Gray, yellow, and 
red respectively indicate good, moderate, or poor health.

What do you want to know more about?

n What do the colors of the Client pane’s bank of health lights mean? 

n What does the color of the client icon mean?

n What do the colors in your dashboard mean?

n List of dashboard panes

n List of dashboard objects (charts, gauges, etc.) 

n Working with the health log 



Modem pane

Use the Net.Medic Modem pane to determine your modem’s performance and overall health.

Bank of health lights. Indicates the overall health of your modem. Green, yellow, and red indicate good, moderate, 
or poor health. To obtain more information about problems related to your modem, check the Net.Medic health log 
by double-clicking on this pane’s yellow or red health light, or on the yellow or red modem icon in the Activity pane.

Compression scale. Provides an estimate of the amount of compression your modem is currently using. The 
compression scale setting is updated every second and is only active during transfers. The blue arrow will slide 
back and forth to indicate the level of compression. If the blue arrow turns white when it is active, this signifies 
compression is in effect. If your modem is using compression, you can download Web pages faster. You can have 
Net.Medic enable compression via its AutoCure feature.

Speed meter. Reports the connection speed of your modem. The meter indicates what percent of the rated modem 
speed was actually achieved during the “handshake” between your modem and the ISP’s modem. A low percentage 
in this meter indicates your modem is not connected at optimal speed. For example, if you had a 28.8 kbps modem 
and the speed is reported at 26.4 kbps, the Speed meter registers 92% because 8% of your modem’s potential 
capacity is not being utilized.

Tips

n This pane is not present in the Net.Medic dashboard if your computer does not have a modem.

n The color of the modem icon in the Activity pane also indicates the modem’s overall health. Gray, yellow, and 
red indicate good, moderate, or poor health.

n To obtain more information about calls made by your modem, check the Net.Medic call log.

n To obtain more information about using your modem, refer to your modem’s online help system.

What do you want to know more about?

n What do the colors of the modem’s dashboard lights mean?

n What do the colors in your dashboard mean?

n List of dashboard panes 

n List of dashboard objects (charts, gauges, etc.)

n How Net.Medic animates online connections for you 

n Working with the health log

n Working with the call log 



Intranet pane

Use the Net.Medic Intranet pane to determine the following: (1) the health of your Intranet from your unique 
perspective, and (2) your Intranet’s performance based upon a periodic sampling. Note that most modem users are 
not using an Intranet and therefore will not see this pane in their Net.Medic dashboard.

 
Delay chart. Provides an estimate of network delay attributed to the Intranet. Blue indicates a reasonable delay. 
Yellow indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer 
the delay caused by your Intranet. The delay attributed to the Intranet is computed by taking the difference of round 
trip times between reaching the last Intranet router and the first Intranet router.
Traffic gauge. Provides a relative estimate of the Intranet traffic level in your Web path. Note that this is along your 
path through the network. This estimate is computed by taking the delay introduced by the Intranet and comparing 
that against the historical distribution of Intranet delays. The current value is placed in that distribution by computing 
a percentile. In the preceding example, 10% indicates that the current response was in the 10th percentile, which 
means that the current Intranet delay was more than 10% of previously seen delays and was less than 89% of other 
previous delays. Therefore, lower percentile numbers mean lower congestion and vice-versa. The traffic index for 
your performance over the Intranet is baselined over time and will become more accurate over time.

Bank of health lights. Indicates the current overall health of your Intranet services (for example, IP connectivity 
and DNS). Green, yellow, and red respectively indicate good, moderate, or poor health.

Tip

n The name of your Intranet appears in the upper-left corner of this pane.

n To obtain more information about problems related to your Intranet, check the Net.Medic health log by double-
clicking on this pane’s yellow or red health light, or on one of the yellow or red Intranet router hop icons in the 
Activity pane. 

n To identify your Intranet, right-click anywhere in the Intranet pane and choose Identify from the pop-up menu. 
You can also identify your Intranet by right-clicking on one of its router hop icons in the Activity pane.

What do you want to know more about?

n What does the color of my Intranet pane’s bank of health lights mean? 

n What do the colors in your dashboard mean? 

n List of dashboard objects    (charts, gauges, etc.) 



ISP pane

Use the Net.Medic ISP pane to obtain the following information: (1) an index of the current overall health of your ISP 
from your connection point, and (2) your ISP’s performance based upon a periodic sampling. 

Delay chart. Provides an estimate of network delay that is attributable to your ISP. The chart provides a histogram 
of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow indicates 
slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the delay 
caused by your ISP.

Traffic gauge. Provides a relative estimate of the ISP traffic level in your Web path. This estimate is computed by 
taking the delay introduced by the ISP and comparing that against the historical distribution of ISP delays. The 
current value is placed in that distribution by computing a percentile. In the preceding example, 89% indicates that 
the current response was in the 89th percentile, which means that the current ISP delay was more than 89% of 
previously seen delays and was less than 10% of other previous delays. Therefore, higher percentile numbers 
mean higher congestion and vice-versa. The traffic index for your ISP’s performance is baselined over time and will 
become more accurate over time.

Bank of health lights. Indicates the current overall health of your ISP. Green, yellow, and red respectively indicate 
good, moderate, or poor health.

Tip

n The name of your ISP appears in the upper-left corner of this pane.

n To identify your ISP, right-click anywhere in the ISP pane and choose Identify from the pop-up menu. You can also 
identify your ISP by right-clicking on any of its router hop icons in the Activity pane.

n To obtain more information about ISP-related problems, check the Net.Medic health log by double-clicking on this 
pane’s yellow or red health light, or on one of its yellow or red router hop icons in the Activity pane.

n For more information about your ISP’s performance over the past month, check Net.Medic’s Service Provider 
Report. 

What do you want to know more about?

n What do the colors of the ISP dashboard lights mean? 

n What do the colors in your dashboard mean? 

n List of dashboard panes

n List of dashboard objects (charts, gauges, etc.)

n Identifying objects in your Web path 

n Working with the Service Provider Report 



Internet pane

Use the Net.Medic Internet pane to check the performance of the Internet portion of your Web path. To obtain more 
information about problems related to the Internet backbone, check the Net.Medic health log by double-clicking on a 
yellow or red Internet hop (router) icon in the Activity pane.

Delay chart. Provides an estimate of the network delay attributable to the Internet backbone. The chart provides a 
histogram of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow 
indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the 
delay caused by the Internet backbone. The delay attributed to the Internet backbone is computed by taking the 
difference of round trip times between reaching the remote Web server and the last ISP router.

Traffic gauge. Provides a relative estimate of the Internet traffic level along your path. Lower percentile numbers in 
this gauge mean lower congestion and vice-versa. This estimate is computed by taking the delay introduced by the 
Internet and comparing that against the historical distribution of Internet delays. The current value is placed in that 
distribution by computing a percentile. In the preceding example, 8% indicates that the current response was in the 
8th percentile, which means that the current Internet delay was more than 8% of previously seen delays and was 
less than 81% of other previous delays. Therefore, lower percentile numbers mean lower congestion and vice-
versa. The traffic index is baselined over time and becomes more accurate over time.

Peak Speed meter. Reports an estimated peak transfer speed as a percent of the speed limit of your online 
connection. The speed limit refers to the number of bits per second (bps) that can be transferred by the thinnest 
pipe between your computer and the Web server. If you are reaching frequently accessed sites, which are 
sometimes connected to the Internet backbone with thick pipes, the thinnest pipe is usually the first link between 
your computer and your ISP. This is generally the case when you are connected to the modem. While the speed 
limit refers to the theoretical maximum speed that can be reached, the Peak Speed refers to the current speed 
observed while your pages are being transferred. 

A low percentage in this meter indicates poor utilization of the bandwidth available end to end. Consequently, high 
values in this meter are desirable and indicate the Internet backbone is passing traffic without introducing delays.

What do you want to know more about?

n What do the colors in your dashboard mean? 

n List of dashboard panes

n List of the dashboard objects (charts, gauges, etc.)

n Identifying objects in your Web path 



Server pane

Use the Net.Medic Server pane (also referred to as the Web site pane) to obtain an estimate of the health or 
performance of the remote Web server. The name of the remote Web server (for example, “southport.jpl.nasa”) 
appears in the upper-left corner of this pane. 

Delay chart. Reports the estimated server and application (HTTP) delay caused by the various Web sites you have 
most recently visited. The delay measurement is based on the amount of time the server takes to complete its 
response to a request. Blue indicates a reasonable delay. Yellow indicates slowness associated with the remote 
Web server and the application layer response. The taller the line on this chart, the longer the delay caused by the 
server or Web site.

Load gauge. Reports the relative load on the server or Web site. This estimate is computed by taking the server 
delay and comparing that against the historical distribution of server delays. Consequently, this value is an indicator 
of the responsiveness of the server. The current delay value is placed in the historical delay distribution by 
computing a percentile. In the preceding example, 10% indicates that the current response was in the 10th 
percentile. This means that the current Internet delay was more than 10% of previously seen delays and was less 
than 89% of other previous delays. Therefore, lower percentile numbers mean lower load and better 
responsiveness. The more you visit a site, the more accurate its load gauge percentage reading becomes.

Throughput meter. Reports the efficiency of the current server or Web site and its attempt to use the available 
network bandwidth. It’s an estimated percent of the speed limit achieved by the current Web site server averaged 
over the complete page transfer time. A high throughput percentage indicates good utilization of the bandwidth 
available to the current server or Web site. However, if the speed limit is high (such as “LAN” speed), even the 
fastest servers may not achieve a high percentage.

Note

The color of the server icon  in the Activity pane also indicates the server’s overall health. Gray, yellow, and red 
respectively indicate good, moderate, or poor health. This overall health is computed based on the health of the 
following components:

n If the server throughput is less than 10% of the available network bandwidth, then the status is yellow.

n If the server is not responding to page requests from the Web browser, then the status is red.

n If the delay introduced by the server is more than 600 milliseconds, then the status is yellow.

n If the estimate of load on the server as compared against historical measurements places the server load on the 
90th percentile of the distribution, then the status is yellow.

Tip

n To obtain more information about problems related to the current Web server, check the Net.Medic health log by 
double-clicking on a yellow or red server icon in the Activity pane.

n To identify the server, right-click on this pane and choose Identify from the pop-up menu. You can also identify a 

server by right-clicking on  in the Activity pane.

n Net.Medic has a Frequently Visited Sites Report that rates the performance of the ten sites you’ve visited most 
over the past month. It also has a Slowest Sites Report that rates the performance of the slowest five sites 
you’ve visited over the past month. You can display these reports from the toolbar or the Net.Medic Windows 
menu.

What do you want to know more about?

n What do the colors in your dashboard mean? 

n List of dashboard panes

n List of dashboard objects (charts, gauges, etc.)

n Identifying objects in your Web path 

n Frequently Visited Sites Report 

n Slowest Sites Report 



Connect Time pane

Use the Net.Medic Session Time/Connect Time pane for the following purposes: (1) to track your modem 
connection time if you’re connected via a modem, or (2) to track your browser activity time. Total time is shown in 
hours and minutes. Note that the session time is reported for both modem and LAN connections; whereas, the 
modem connect time is only reported with modem connections. You can switch between these two views (Modem 
Connect Time and Session Connect Time) by right-clicking on this Net.Medic pane and choosing Session Time or 
Modem Connect Time from the pop-up menu.

Session digital display. Time on current session.

Today digital display. Time on all sessions today.

This Month digital display. Time on all sessions this month.

Note

n The session connect time stops incrementing when the browser is idle for more than 3 minutes.

n Note that ISPs vary in their billing policies and can also periodically change them. For example, various ISPs 
use different methods to round up the billable hours while others bill in minimum time increments. Net.Medic 
does not account for such variables. Consequently, although the Net.Medic Connect Time dashboard pane 
reflects your online time over the past month, the reported time may not reflect your final ISP bill because of 
these variables.

What do you want to know more about?

n List of dashboard panes

n List dashboard objects (charts, gauges, etc.)



What do the colors in your dashboard mean?

Net.Medic is continually monitoring your Web path even when not transferring Web pages. Net.Medic uses colored 
icons in its Activity pane to help you quickly identify hot spots in your Web path.

Gray indicates a healthy state. Yellow and red indicate moderate to poor health.    For instance, a red icon indicates 
Net.Medic has detected a health problem with your modem even though you are currently not transferring a Web 
page. Yellow and red icons are also referred to as “hot spots.”

What do you want to know more about?

n Colored icons in the Activity pane 

n Colored banks of health lights in the dashboard

n List of dashboard objects (charts, gauges, etc.)

n Understanding router hops 



Colored icons in the Activity pane

The Activity pane uses colored icons to indicate the current health of the components in your Web path.    Click once 
on any of these icons to open or close a dashboard pane.

Icons Description of Activity pane icons

Client icon, which represents your desktop computer. Click to 
open and close the Client pane in your dashboard.

Modem icon, which represents your modem. Click to open and 
close the Modem pane in your dashboard.

Router hop icon. Each router hop icon represents an Intranet 
router, ISP router, or Internet backbone router involved in your 
current Web path. For example, there are ten router hop icons if 
your computer must traverse ten routers to connect to the 
remote Web server.

Click to open and close the corresponding dashboard pane. For 
example, click any of the Internet router hop icons to open the 
Internet pane in the dashboard. If you move your pointer over 
the router hop group in the Activity pane, Net.Medic’s balloon 
help displays a brief description of the group.

Server icon, which represents the remote server. Click to open 
and close the Server pane.

What do you want to know more about?

n What does the color of the server icon mean?

n What does the color of the client icon mean?

n What does the color of the modem icon mean?

n What does the color of a router hop icon mean?



What does the color of the client icon mean?

Net.Medic uses the color of the client icon  in the Activity pane to indicate the current overall health of the client 
(your desktop computer).

What do you want to know more about?

n What does the color of the Client pane’s bank of health lights mean? 

n What does the color of your modem icon mean? 

n What does the color of the server icon mean?

n What do the colors of the router hop icons mean? 

n Understanding router hops 

n Why router hop information is important

n What do the colors in your dashboard mean? 



What does the color of the modem icon mean?

Net.Medic uses color to report the current overall health of your modem. The modem icon  in the Activity pane is 
colored to signify this health. 

The overall health is computed based on the health of the following components:
n If there was an abnormal disconnect of a modem session, then the status is red.

n If the modem negotiated baud rate is less than 90% of the modem rated baud rate, then the status is yellow.

n If the serial line DTE rate (the rate of transfer between your computer and the modem) is less than four times 
the rated baud rate of the modem, then the status is yellow. 

Note

To fully utilize compression, a DTE rate that is four times higher than the modem’s rated baud rate is needed.

What do you want to know more about?

n What do the colors in your dashboard mean?

n What does the color of the client icon mean? 

n What does the color of the server icon mean?

n What do the colors of the router hop icons mean? 

n Understanding router hops 

n Why router hop information is important

n Hops when connected via a modem 



What does the color of a router hop icon mean?

Net.Medic uses color to report the current overall health of the router hops in your current Web path. The router hop 

icon  in the Activity pane is colored to signify the health of the different groups of router hops (the Intranet routers, 
the ISP routers, and the Internet backbone routers) in your path.

What do you want to know more about?

n What do the colors in your dashboard mean?

n What does the color of the Intranet router hop icons mean?

n What do the colors of the ISP router hop icons mean?

n What do the colors of the Internet router hop icons mean?

n Understanding router hops 

n Why router hop information is important

n Hops when connected via a modem 

n Hops when connected via an Intranet 



What does the color of the Intranet router hop icons mean?

The color of the Intranet router hop icons in the Activity pane indicates the overall health of your Intranet. Green, 
yellow, and red respectively indicate good, moderate, and poor health. Note that all of the icons in the Intranet 
router hop group are the same color (for example, they are all gray or red).

Tip

n To obtain more information about Intranet-related problems, check the Net.Medic health log by double-clicking 
on any of the yellow or red Intranet router hop icons in the Activity pane.

What do you want to know more about?

n What do the colors in your dashboard mean?

n What do the colors of the ISP router hop icons mean?

n What do the colors of the Internet router hop icons mean?

n Understanding router hops 

n Why router hop information is important

n Hops when connected via a modem 

n Hops when connected via an Intranet

n Working with the health log



What do the colors of the ISP router hop icons mean?

The colors of the ISP router hop icons in the Activity pane indicates the overall health of your ISP.

Tip

n To obtain more information about ISP-related problems, check the Net.Medic health log by double-clicking on 
any of the yellow or red ISP router hop icons in the Activity pane.

What do you want to know more about?

n What do the colors in your dashboard mean?

n What does the color of the Intranet router hop icons mean?

n What do the colors of the Internet router hop icons mean?

n Understanding router hops 

n Why router hop information is important

n Hops when connected via a modem 

n Hops when connected via an Intranet

n Working with the health log



What do the colors of the Internet router hop icons mean?

The color of the Internet router hop icons in the Activity pane indicates the overall health of the Internet backbone.

Tip

n To obtain more information about Internet-related problems, check the Net.Medic health log by double-clicking 
on any of the yellow or red Internet router hop icons in the Activity pane.

What do you want to know more about?

n What does the color of the Intranet router hop icons mean?

n What does the color of the ISP router hop icons mean?

n Understanding router hops 

n Why router hop information is important

n Hops when connected via a modem 

n Hops when connected via an Intranet

n Working with the health log



What does the color of the server icon mean?

Net.Medic uses color to signify the current overall health of the remote Web server in your path. 

The server icon  in the Activity pane is colored to signify this health. Green, yellow, and red respectively indicate 
good, moderate, or poor health.

Tip

n To obtain more information about server-related problems, check the Net.Medic health log by double-clicking on 
a yellow or red health server icon in the Activity pane.

What do you want to know more about?

n What does the color of the client icon mean? 

n What does the color of the modem icon mean? 

n What do the colors of the router hop icons mean? 

n Understanding router hops 

n Why router hop information is important

n Working with the health log



Colored bank of dashboard lights

The following dashboard panes have a bank of health lights that report an index of the component’s overall health:

n The Client pane, which signifies the overall health of the client.

n The Modem pane, which signifies the overall health of your modem.

n The Intranet pane, which signifies the overall health of your Intranet. 

n The ISP pane, which signifies the overall health of your ISP.

Green indicates good health. Yellow indicates moderate health. Red indicates poor health.

What do you want to know more about?

n What do the colors in the Client’s pane’s bank of health lights mean? 

n What do the colors in the Modem pane’s bank of health lights mean? 

n What do the colors of the Intranet pane’s bank of health lights mean? 

n What do the colors of the ISP pane’s bank of health lights mean? 

n List of dashboard objects (charts, gauges, etc.) 



What does the color of the Client pane’s bank of health lights mean?

The overall health of your desktop computer is signified by the bank of health lights in the Client pane. Green, 
yellow, and red respectively indicate good, moderate, or poor health. 

Tips

n The color of the client icon     in the Activity pane also indicates your computer’s overall health. A gray, yellow, 
and red icon respectively indicate good, moderate, or poor health.

n To obtain more information about PC-related problems, check the Net.Medic health log by double-clicking on a 
yellow or red health light in the Client pane or on a yellow or red client icon in the Activity pane.

What do you want to know more about?

n What do the colors in the Modem pane’s bank of health lights mean? 

n What do the colors of the Intranet pane’s bank of health lights mean? 

n What do the colors of the ISP pane’s bank of health lights mean?

n List of dashboard objects (charts, gauges, etc.)

n Working with the health log 



What does the color of the Modem pane’s bank of health lights mean?

The overall health of your modem is signified by the bank of health lights in the Modem pane. Green, yellow, and 
red respectively indicate good, moderate, or poor health. 

Note

To fully utilize compression, a DTE rate that is four times higher than the modem’s rated baud rate is needed.

Tips

n The color of the modem icon  in the Activity pane also indicates your computer’s overall health. A gray, yellow, 
and red icon respectively indicate good, moderate, or poor health.

n To obtain more information about modem-related problems, check the Net.Medic health log by double-clicking 
on a yellow or red health light in the Modem pane or on a yellow or red modem icon in the Activity pane.

What do you want to know more about?

n What do the colors in the Client pane’s bank of health lights mean? 

n What do the colors in the Intranet pane’s bank of health lights mean? 

n What do the colors of the ISP pane’s bank of health lights mean?

n List of dashboard objects (charts, gauges, etc.)

n Working with the health log



What does the color of the Intranet pane’s bank of health lights mean?

The overall health of your Intranet is signified by the bank of health lights in the Intranet pane. Green, yellow, and 
red respectively indicate good, moderate, or poor health. 

Tips

n To obtain more information about Intranet-related problems, check the Net.Medic health log by double-clicking 
on a yellow or red health light in the Intranet pane or on one of the Intranet router hop icons in the Activity pane.

What do you want to know more about?

n What does the color of the Client pane’s bank of health lights mean? 

n What does the color of the Modem pane’s bank of health lights mean? 

n What does the color of the ISP pane’s bank of health lights mean?

n List of dashboard objects (charts, gauges, etc.)

n Working with the health log



What does the color of the ISP pane’s bank of health lights mean?

The overall health of your ISP is signified by the bank of health lights in the ISP pane. Green, yellow, and red 
respectively indicate good, moderate, or poor health. 

Tips

n To obtain more information about ISP-related problems, check the Net.Medic health log by double-clicking on a 
yellow or red health light in the ISP pane or on one of the ISP router hop icons in the Activity pane.

What do you want to know more about?

n What does the color of the Client pane’s bank of health lights mean? 

n What does the color of the Modem pane’s bank of health lights mean? 

n What does the color of the Intranet pane’s bank of health lights mean? 

n List of dashboard objects (charts, gauges, etc.)

n Working with the health log



Working with the Net.Medic inlay

The process of displaying a Net.Medic dashboard pane within your browser is called “snapping a pane” onto your 
browser. 

To snap a Net.Medic pane onto your browser:

Right-click on the dashboard pane and choose Snap On 
Browser. The Net.Medic pane opens as an inlay in your browser.

To detach (close) the Net.Medic inlay in your browser:

Right-click on the Net.Medic browser inlay and choose Snap on 
Dashboard. 

Tips

n In addition to snapping any Net.Medic dashboard panes onto your browser, you can snap and detach the 
Net.Medic ticker tape onto your browser. With Netscape Navigator, you can snap a dashboard pane and the 
ticker tape concurrently. With Internet Explorer, you can only snap a dashboard pane or the ticker tape.

What do you want to know more about?

n Net.Medic inlay menu options

n Tips on snapping dashboard panes onto your browser 



Working with the Net.Medic dashboard

The Net.Medic dashboard animates your Web path by highlighting the Internet activity, including traffic jams and 
bottlenecks. At a glance, the dashboard tells you the following:

n What’s your overall performance

n How fast you’re transferring Web pages

n How effectively you’re retrieving Web pages

n How your computer is performing

n How your modem is performing

n How your Intranet is performing

n How your ISP is performing

n How the Internet is performing 

n How the remote server is performing 

n How long you’re been connected to the network

What do you want to know more about?

n The different parts of the dashboard 

n List of dashboard objects (charts, gauges, etc.) 

n How to close a dashboard pane

n How to reopen a dashboard pane 

n How to snap a pane onto your browser



To close a dashboard pane

Right-click on the pane, and choose Close Pane from the pop-up 
menu.

Click the toolbar button or dashboard icon for the pane.

Pull down the View menu in the Net.Medic menu bar and 
deselect the appropriate option from the Details submenu. For 
example, to close the Internet pane deselect the Internet option 
in the Details submenu.

Tip

n To reopen all the panes, pull down the View menu in the Net.Medic menu bar and choose Open All.

n To display the name of a toolbar button (tool tips), move the pointer over it.

Note

For a brief description of objects in a Net.Medic dashboard pane, move your pointer over the object. If balloon help 
is supported for the object, a brief description automatically pops up. 

What do you want to know more about?

n Net.Medic menu bar

n Net.Medic’s balloon help 

n Net.Medic’s dashboard panes

n Net.Medic’s dashboard objects (charts, gauges, etc.)



To reopen a dashboard pane

Click the toolbar button or dashboard icon for the pane. 

Pull down the View menu in the Net.Medic menu bar and select 
the appropriate option from the Details submenu. For example, 
to reopen the Internet pane choose Internet from the Details 
submenu.

Tip

n To reopen all the panes, pull down the View menu in the Net.Medic menu bar and choose Open All.

n To display the name of a toolbar button (tool tip), move the pointer over it.

Note

For a brief description of digital displays, charts, gauges, and dials in a Net.Medic pane, move your pointer over the 
object. Net.Medic’s balloon help displays a brief description of the object. 

What do you want to know more about?

n Net.Medic menu bar

n Net.Medic’s balloon help 

n Net.Medic’s dashboard panes

n Net.Medic’s dashboard objects (charts, gauges, etc.)

n How Net.Medic animates your online connections for you 

n Parts of the Web path monitored by Net.Medic 



Net.Medic’s balloon help

Net.Medic has balloon help for its icons, digital displays, charts, gauges, and dials. To display the balloon help, 
move your pointer over the object.    If balloon help is available for the object, a brief description automatically pops 
up. For instance, move the pointer over the first group of router hop icons. If you’re connected to the Internet, these 
are the ISP routers in your Web path.

Move the pointer over the second group of router hop icons. If you’re connected to the Internet via a modem, these 
are the Internet backbone routers in your path.

Note

If you were connected via an Intranet, the hops are divided into Intranet routers, followed by ISP routers, and then 
the Internet backbone routers.

What do you want to know more about?

n Net.Medic’s dashboard panes

n Net.Medic’s dashboard objects (charts, gauges, etc.)

n Parts of the Web path monitored by Net.Medic 

n Different groups of router hops 



Opening and closing dashboard panes

You can quickly close and reopen all the Net.Medic dashboard panes by clicking on the following icons or Net.Medic 
toolbar buttons.

Icon
s

Description of the Activity pane icon

Client icon, which represents your desktop computer. Click to 
open and close the Client pane in your dashboard. (You can also 
open the Client pane by pulling down the View menu and 
choosing My PC from the Details submenu.)

Modem icon, which represents your modem. Click to open and 
close the Modem pane in your dashboard. (You can also open 
the Modem pane by pulling down the View menu and choosing 
Modem from the Details submenu.)

Router hop icon. Each router hop icon represents an Intranet 
router, ISP router, or Internet backbone router involved in your 
current Web path. For example, if your computer must traverse 
ten routers to connect to the remote Web server then there are 
ten router hops in this path.

Click to open and close the corresponding dashboard pane. For 
example, click on one of the Internet router hop icons to open the 
Internet pane in the dashboard. If you move your pointer over the 
router hop icon in the Activity pane, Net.Medic’s balloon help 
displays a brief description of the router hop group.

(You can also open the Intranet pane, the ISP pane, and the 
Internet pane by pulling down the View menu and respectively 
choosing Intranet, ISP, and Internet from the Details submenu.)

Server icon in the Activity pane. Click to open and close the 
Server pane. (You can also open the Server pane by pulling 
down the View menu and choosing Server from the Details 
submenu.)

Butt
on

Description of Net.Medic toolbar button

Health Log button. Click to open the Net.Medic health log. 

Modem Call Log button. Click to open the call log.

History Reports button. Click to display the History Report 
window from which you can view the different Net.Medic history 
reports. 

Session Summary button. Click to display the Net.Medic Session 
Summary window.

Activity button. Click to open and close the Activity pane.

Throughput button. Click to open and close the Throughput 
pane.

Retrieval toolbar button. Click to open and close the Retrieval 
pane.

Connect Time toolbar button. Click to open and close the 



Connect Time pane.

Help button. Click to open this Net.Medic help system. You can 
also display this help system by choosing Help from the Help 
menu.

VitalSigns Home Page button. Click to load the VitalSigns home 
page into your browser. You can also display the VitalSigns 
home page by choosing Visit VitalSigns Home Page from the 
Help menu.

Tip

n To open all the panes, pull down the View menu in the Net.Medic menu bar and choose Open All.

What do you want to know more about?

n How to find out the name of a toolbar button 

n How to reopen a dashboard pane 

n How to close a dashboard pane 

n How to snap a dashboard pane on and off your browser

n List of Net.Medic menu bar commands



Icons     Description of the 
Activity pane icon

Client icon, which represents your desktop computer. Click to open 
and close the Client pane in your dashboard. (You can also open the 
Client pane by pulling down the View menu and choosing My PC from 
the Details submenu.)

Modem icon, which represents your modem. Click to open and close 
the Modem pane. (You can also open the Modem pane by pulling 
down the View menu and choosing Modem from the Details 
submenu.)

Router hop icon. Represents all the router hops (Intranet routers, ISP 
routers, and the Internet backbone routers) traversed from your 
desktop computer to the remote server for the current online 
connection. 

Click a router hop icon to open the corresponding Net.Medic 
dashboard pane (the Intranet, ISP, or Internet pane). For example, 
click one of the Internet router hop icons to open the Internet pane in 
the dashboard.

If you move your pointer over a router hop group in the Activity pane, 
Net.Medic’s balloon help displays a brief description of the group.

(You can also open the Intranet pane, the ISP pane, and the Internet 
pane by pulling down the View menu and respectively choosing 
Intranet, ISP, and Internet from the Details submenu.)

Server icon, which represents the remote server. Click to open and 
close the Server pane. (You can also open the Server pane by pulling 
down the View menu and choosing Server from the Details submenu.)

Tip

n Click once on any of these preceding icons to open or close the corresponding dashboard pane.



Activity pane icons

Icons Description of Activity pane icon

Client icon, which represents your desktop computer. Click to 
open and close the Client pane in the Net.Medic dashboard. 
(You can also open the Client pane by pulling down the View 
menu and choosing My PC from the Details submenu.)

Modem icon, which represents your modem. Click to open and 
close the Modem pane in the Net.Medic dashboard. (You can 
also open the Modem pane by pulling down the View menu 
and choosing Modem from the Details submenu.)

Router hop icon. Each router hop icon represents an Intranet 
router, ISP routers, or Internet backbone routers involved in 
the Web path. For example, if your computer must traverse 
ten routers to connect to the remote Web server then there are 
ten router hops in this path.

Click to open and close the corresponding dashboard pane 
(the Intranet, ISP, or Internet pane). If you click once on one of 
the router hop icons, the corresponding dashboard pane 
opens. To open the Intranet pane, click one of the Intranet 
router hop icons. To open the ISP pane, click one of the ISP 
router hop icons. 

(You can also open the Intranet pane, the ISP pane, and the 
Internet pane by pulling down the View menu and respectively 
choosing Intranet, ISP, and Internet from the Details 
submenu.)

Server icon, which represents the remote server. Click to open 
and close the Server pane. (You can also open the Server 
pane by pulling down the View menu and choosing Server 
from the Details submenu.)

Tips

n Click once on any of these preceding icons to open or close the corresponding dashboard pane.

n To open only the Activity pane, the Throughput pane, and the Retrieval pane, choose Home from the View 
menu.

What do you want to know more about?

n Colored icons in the Activity pane

n Different groups of router hops 

n Why router hop information is important

n Net.Medic menu bar options 



Icon Description

Health Log button. Click to open the Net.Medic health log. (You can 
also open the health log by double-clicking on a yellow or red 
Net.Medic icon or by choosing Health Log from the Net.Medic Window 
menu.)

Modem Call Log button. Click to open the Net.Medic call log. (You can 
also open the call log by choosing Call Log from the Net.Medic 
Window menu.)

History Reports button. Click to display the History Reports window 
from which you can view and print the different history reports.    (You 
can also display a history report by pulling down the Net.Medic 
Window menu, choosing History Reports then dragging right and 
choosing a report.)

Session Summary button. Click to display the Net.Medic Session 
Summary window, which gives you a summary of your current online 
session. (You can also display the Session Summary window by 
choosing Session Summary from the Net.Medic Window menu.)

Network Activity button. Click to open and close the Activity pane. 

Throughput button. Click to open and close the Throughput pane.

Retrieval button. Click to open and close the Retrieval pane.

Connect Time button. Click to open and close the Connect Time pane.

Help button. Click to open this Net.Medic help system. (You can also 
open the help system by choosing Help from the Net.Medic Help 
menu.)

VitalSigns Home Page button. Click to load the VitalSigns home page 
into your browser. (You can also display the VitalSigns home page by 
choosing Visit VitalSigns Home Page from the Net.Medic Help menu.)



Toolbar buttons

Icon Description

Health Log button. Click to open the Net.Medic health log. (You can 
also open the health log by double-clicking on a yellow or red 
Net.Medic icon or by pulling down the Net.Medic Window menu and 
choosing Health Log.)

Modem Call Log button. Click to open the Net.Medic call log. (You can 
also open this log by pulling down the Net.Medic Windows menu, and 
choosing Call Log.)

History Reports button. Click to display a list of Net.Medic history 
reports that you can view. (You can also display a history report by 
pulling down the Net.Medic Window menu, choosing History Reports 
then dragging right and choosing a report.)

Session Summary button. Click to display the Net.Medic Session 
Summary window. (You can also display the Session Summary 
window by choosing Session Summary from the Net.Medic Window 
menu.)

Network Activity button. Click to open and close the Activity pane.

Throughput button. Click to open and close the Throughput pane.

Retrieval button. Click to open and close the Retrieval pane.

Connect Time button. Click to open and close Connect Time pane. 
After opening this pane, you can switch between Modem Connect 
Time and Session Connect Time by right-clicking on the pane and 
choosing Modem Connect Time or Session Connect Time.

Help button. Click to open this Net.Medic help system on your 
desktop.

VitalSigns Home Page button. Click to display the VitalSigns home 
page in your browser.



To monitor the health of your online connections

Use the Activity pane to monitor your Web paths. Net.Medic uses colored icons to indicate the current health of the 
Web path components. Green indicates a healthy condition; yellow and red respectively indicate moderate to 
severe health problems. 

Note

n You can display the Activity pane in the Net.Medic dashboard or as a browser inlay. To display it as an inlay, 
right-click the Activity pane in the dashboard and choose Snap On Browser. 

n To save desktop space, hide the dashboard by clicking  in the Net.Medic toolbar. If an icon in the inlay 
becomes a hot spot, left-click on the Net.Medic system tray icon to reopen the Net.Medic dashboard for more 
information about the problem.

Tips

n When an icon changes to yellow or red, check the corresponding dashboard pane to help pinpoint the cause of 
the problem. For example, if the server icon turns red, check the Server pane.

n When an icon turns yellow or red, click  to display the Net.Medic health log.

n To get a summary of your session, click . The Session Summary window opens with a summary of your 
current online session.



To identify and isolate the cause of the problem

Use the Net.Medic dashboard to identify traffic jams or bottlenecks.

n Check the Activity pane

n Check the Throughput pane 

n Check the Retrieval pane 

n Check the Modem pane 

n Check the Intranet pane

n Check the ISP pane 

n Check the Internet pane 

n Check the Server pane 

What do you want to know more about?

n How to get a diagnosis and prescription for a problem 

n How to remedy a problem 

n List of dashboard panes



To get a diagnosis and prescription for a problem

1 Open the Net.Medic health log.

2 In the health log, select the entry you want more information about and click Diagnosis. 

The Diagnosis window opens with a diagnosis and prescriptions for the problem. 

n If Net.Medic can fix the problem, then it lets you know. In this case, click AutoCure in the Diagnosis window to 
have Net.Medic fix the problem. The AutoCure Wizard dialog box opens and reports how it plans to cure the 
problem. After Net.Medic fixes the problem, click OK to close the AutoCure Wizard dialog box.

n If the prescription is to send E-mail to the appropriate resource (for example, your ISP or Webmaster), click 
Notify to have Net.Medic send its detailed E-mail message to the appropriate party. 

Note

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users. Note that 
the E-mail notification feature is only available with the retail version of Net.Medic.

n After formatting the text for the E-mail notification, Net.Medic asks for your permission to send it to the 
appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent.

What do you want to know more about?

n Working with the health log 

n Working with the Diagnosis window

n How to remedy a problem



To remedy a problem

Net.Medic helps eliminate many network slowdowns so you won’t even encounter them. Sometimes after identifying 
a problem and describing it in clear language, Net.Medic asks if you want the problem remedied. 

Net.Medic’s AutoCure feature lets you choose the solution. For example, if your modem is not connecting at optimal 
speed, Net.Medic notifies you. It then asks if you want the connection optimized. With a simple click of a button, you 
can direct Net.Medic to go ahead and remedy the problem. Certain features, such as modem compression, will 
remain set in the optimized position.

To cure a problem

1 Open the Net.Medic health log.

2 In the Health Log window, double-click on a problem. The Diagnosis window opens the highlighted problem.

3 Check the supplied diagnosis and prescription. 

4 Net.Medic will inform you if it can fix the problem. If it can, Net.Medic asks you to click AutoCure. If the remedy is 
to send a detailed E-mail prescription to an appropriate resource, click Notify to have Net.Medic send its detailed 
E-mail message to the appropriate company or individual. 

5 When you have finished working in the Diagnosis window, click Close to shut the window.

Note

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users. Note that 
the E-mail notification feature is only available with the retail version of Net.Medic.

n After formatting the text for the E-mail notification, Net.Medic asks for your permission to send it to the 
appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent.



Working with the Diagnosis window

Net.Medic provides a diagnosis and prescription for an identified problem in its Diagnosis window. 

To display the Diagnosis window

1 Open the Net.Medic health log.

2 In the Health Log window, highlight the problem that you want a diagnosis of and prescription for.

3 Display the Diagnosis window for the highlighted entry by double-clicking on the log entry or by clicking once 
and then clicking Diagnosis.

4 Check the supplied diagnosis and prescription. 

5 Net.Medic will inform you if it can fix the problem. If it can, Net.Medic asks you to click AutoCure. If the remedy is 
to send a detailed E-mail prescription to an appropriate resource (for example, your ISP or Webmaster), click 
Notify. By clicking Notify, you can have Net.Medic generate a detailed E-mail message to the appropriate 
company or individual. After formatting the text for an E-mail notification, Net.Medic asks for your permission to 
send it to the appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent.

6 When you have finished working in the Diagnosis window, click Close.

Note

n Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users. Note that 
the E-mail notification feature is only available with the retail version of Net.Medic.

n If you have the Diagnosis window open, you can continue to display a diagnosis and prescription for various 
entries in the health log by clicking once on another log entry. The contents of the Diagnosis window are 
updated to reflect the diagnosis and prescription for the currently selected entry.



Snapping dashboard panes on and off the browser

With a couple of clicks, you can snap any Net.Medic pane onto your browser window. This saves space on your 
desktop and allows you to monitor your online session from your browser. 

To snap a pane onto your browser

In the Net.Medic dashboard, right-click on the Net.Medic pane 
you want to snap onto the browser and choose Snap on 
Browser. The pane closes in the dashboard and opens in your 
browser.

To detach (unsnap) a pane from your browser

Right-click on the Net.Medic inlay and choose Snap on 
Dashboard. 

Note

n When a Net.Medic pane is in your browser, the pane is called an inlay.

n You can perform the same tasks from a Net.Medic pane whether it is displayed in the dashboard or browser. For 
example, you can close the pane by right-clicking on the pane and choosing Close Pane from the pop-up menu.

n If the Net.Medic dashboard is closed, left-click on the Net.Medic system tray icon. The Net.Medic dashboard 
reopens on your desktop.

What do you want to know more about?

n Net.Medic pop-up menu options

n Net.Medic inlay

n Net.Medic dashboard panes



What is the Net.Medic inlay?

Because Net.Medic is a browser companion, you can run Net.Medic as an inlay in your browser. This allows you to 
save desktop space and monitor your Internet connections from a single window. When you run Net.Medic as a 
browser inlay, Net.Medic runs as an inlay in the upper-right corner of your browser. You can display any Net.Medic 
pane as an inlay.

To display a Net.Medic pane as a browser inlay:

In the dashboard, right-click on the dashboard pane and choose 
Snap On Browser. The pane closes in the dashboard and opens 
as an inlay in your browser.



Understanding the different Net.Medic logs

Net.Medic has the following two logs that track your online performance:

n Health log 

n Call log 

What do you want to know more about?

n Working with the health log 

n Working with the call log 



Changing the user configuration and registration information

You do not have to perform any system reconfiguration after installing Net.Medic. Net.Medic uses a set of default 
values for the necessary user configuration and registration variables. These variables are stored by default in the 
MyComputer\software\VitalSigns\Medic\Config directory. 

To change a user configuration and registration information

1 Use the Windows startbar to run the Registry Editor. 

Choose Run from the Start menu. In the displayed Run dialog box, type regedit and click OK.

2 Go to the Net.Medic system registry folder (MyComputer\software\VitalSigns/Medic\1.0\Config directory).

3 Right-click on the variable you want to change.

4 From the pop-up menu, choose Modify. 

5 Specify the new value for the variable in the Value data field of the displayed Edit String dialog box.

6 After specifying a new value for the variable, click OK in the Edit String dialog box.

7 Continue to change variables by repeating steps 3 through 7, or click  to quit the Registry Editor.

What do you want to know more about?

n List of configuration and registration information variables 



List of user configuration and registration information variables

You can use the Windows Registry Editor to change any of the following user configuration variables. Net.Medic, 
however, automatically assigns a default value to each variable as listed below.

Variable Default setting Function

HKEY_CURRENT_USER\SOFTWARE\
VITALSIGNS\LOCATION

Software\VitalSigns\Medic\Config HKEY_CURRENT_USER offset where 
customized information is kept. This variable is 
always at a fixed location.

PRODUCT_NAME Net.Medic Application name

PRODUCT_VERSION 1.0 Version number

PRODUCT_INSTALLDIR C:\Program Files\VitalSigns\Net.Medic Default directory into which the application will 
be installed

SERVICE_PROVIDER_NAME VitalSigns Software Inc. Site administrator

SERVICE_PROVIDER _LOGO C:\Program 
Files\VitalSigns\Medic\Medic.bmp

Site administrator logo

SERVICE_PROVIDER _DOMAIN vitalsigns.com Site administrator domain

SERVICE_PROVIDER _HELPDESK 1-800-UFI-LLME Phone number of the site’s help desk

SERVICE_PROVIDER _KEYWORD VitalSigns Special key word to identify site administrator E-
mail address. This is the variable that you must 
modify to change the search string Net.Medic 
uses to determine if it should display an unread 
message, which was delivered by the Microsoft 
Messaging API (MAPI) in its ticker tape.

SERVICE_PROVIDER _FEEDBACK SMTP:feedback@vitalsigns.com E-mail address to which user feedback    is sent

SERVICE_PROVIDER _HOMEPAGE www.vitalsigns.com VitalConnect™ home page address.

SERVICE_PROVIDER _BROWSER Preferred Web browser

UPLOAD_PREFERENCE URL+USER User preference for uploading

POLLING_INTERVAL 1000 Polling interval for ISP traffic in milliseconds



To open the Net.Medic call log

In the Net.Medic menu bar, choose Call Log from the Window 
menu.

In the Net.Medic toolbar, click .

What do you want to know more about?

n How to work with the call log

n How to obtain details about a call 



Working with the call log

The Net.Medic call log tracks your past month’s modem calls. The log provides information about your modem’s 
success rate, the connection speed, the duration of the call, the current status of the call, its average throughput, 
and the percentage of time it was idle. A colored light is used to indicate the success (health) of each call. A green, 
yellow, or red light respectively indicate good, moderate, or poor success of the call.

This vital data can help you decide whether you should upgrade to a faster modem. In addition, you can use this log 
to audit your monthly usage and fees as well as the level of service provided by your ISP.

Note

ISPs vary in their billing policies and can also periodically change them. For example, various ISPs use different 
methods to roundup the billable hours while others bill in minimum time increments. Net.Medic does not account for 
such variables. Consequently, although this log reflects your actual online modem time over the past month, the 
reported time may not reflect your final ISP bill because of these variables.

To open the Net.Medic call log

Right-click on the Net.Medic system tray icon, and choose Call Log from the pop-up menu.

In the Net.Medic dashboard, click  in the toolbar, or pull down the Window menu and choose Call 
Log.

The call log opens with a list of all your modem calls for the past month. 

 To obtain details about a call

In the call log, click on the arrow to the left of a call entry. 

Additional details about the call are displayed in the call log.

Tip

n To obtain details about all the calls in the log, choose Open All from the View menu.

n To close the details about all the calls in the log, choose Close All from the View menu.

n To print the call log, choose Print from the File menu.

n To close the call log, choose Close from the File menu.

n To hide (minimize) the log, click .

n You can compare the log’s historical information with your current session information. 

n To obtain a summary of your modem calls for the current session, click . The Session Summary window 
opens with a summary of your current session. To obtain details on your modem calls for the session, click the 
Modem tab in the Session Summary toolbar.



To obtain details about a call

Click on the call entry in the Net.Medic call log. Additional details 
about the call are displayed in the call log.

To obtain details about all the calls listed in the log

Choose Open All from the File menu at the top of the log.

To close the details about all the calls, choose Close All from the 
File menu.



To open the Net.Medic health log

Double-click on a hot spot in the Net.Medic dashboard or inlay.

In the Net.Medic menu bar, choose Health Log from the Window 
menu.

In the Net.Medic toolbar, click .

Right-click on the Net.Medic system tray icon and choose Health 
Log from the pop-up menu.

Note

When you double-click on a Net.Medic hot spot to display the health log, it opens with the matching entry 
automatically highlighted. This feature can help you quickly identify the source of the problem. For example, by 
double-clicking on the red modem icon in the Activity pane, the matching entry (the “Modem speed suboptimized” 
entry) is highlighted when the log opens. 

What do you want to know more about?

n Working with the health log 

n Health log menu options 



Working with the health log

The Net.Medic health log describes the problems encountered with your online connections over the past week. A 
colored light is used to indicate the severity of each problem; yellow and red respectively indicate a moderately 
severe or very severe (critical) problem.

Contents of the health log

 The log provides the following information:

n Where the problem occurred (for example, at the ISP entry router or your desktop computer)

n A brief description of the problem (for example, CPU load)

n The date and time of the most recent occurrence of the problem

n The source of the problem (for example, your ISP or desktop computer)

n The number of times the same problem was detected over the past 30 minutes

To open the Net.Medic health log

In the Net.Medic dashboard or inlay, double-click on a hot spot. 

The Net.Medic health log opens with the matching entry highlighted. For example, by double-clicking 
on a yellow modem icon in the Activity pane, the health log opens with the entry “Modem speed 
suboptimized” highlighted.

In the Net.Medic dashboard click  in the toolbar, or pull down the Window menu and choose 
Health Log. The Net.Medic health log opens with all the problems reported over the past week for 
your online connections.

 Tip

n To indicate you’ve reviewed a particular problem in the health log, click once on it and then click Acknowledge. 
The next time you open the log, this entry is removed from the log. To acknowledge all of the currently listed 
problems, click Acknowledge All.

n To close the health log, click  or choose Close from the File menu.

n To hide (minimize) the health log, click .

Net.Medic only generates an E-mail notification for chronic problems or severe warnings. This policy will help to 
minimize the possibility of flooding Webmasters, system administrators, and ISPs with E-mails about intermittent 
problems. This, in turn, will enable them to focus on solving chronic problems that plague their users. By clicking 
Notify in the Diagnosis window, you can have Net.Medic generate a detailed E-mail message to the appropriate 
company or individual. After formatting the text for an E-mail notification, Net.Medic asks for your permission to send 
it to the appropriate party. Unless you tell Net.Medic to send the E-mail notification, it will not be sent. Note that the 
E-mail notification feature is only available with the retail version of Net.Medic.

n

What do you want to know more about?

n Health log menu options

n How to get a diagnosis and prescription for a problem 

n How to remedy a problem 



Working with the history reports

The Net.Medic history reports track and rate the performance of your ISP. In addition, it provides performance 
information about the Web sites you’ve visited the most over the past month. This historical information concerning 
your Web paths can help you identify bottlenecks as well as make informed decisions about how to resolve them. 
These reports can be useful for comparing current and past performance of your ISP or remote Web site.

There are six different types of history reports:

n Service Provider Report 

n Frequently Visited Sites Report

n Slowest Sites Report

n Health Summary Report

n Health Optimization Summary

n Traffic Report

Note

To obtain a summary of your current session, click  in the Net.Medic toolbar, or choose Session Summary from 
the Net.Medic Window menu.

What do you want to know more about?

n Service Provider Report

n Frequently Visited Sites Report 

n Slowest Sites Report 

n Health Summary Report 

n Health Optimization Summary 

n Traffic Report 



Health Optimization Summary

The Health Optimization Summary includes information about some of the improvements made in your online health 
by Net.Medic.

To display the Health Optimization Summary

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports, then drag right and choose Health 
Optimization.

In the Net.Medic toolbar, click , pull down the Reports 
menu in the displayed History Reports window and choose 
Health Optimization.

Right-click on the Net.Medic system tray icon, choose 
Reports from the pop-up menu. Pull down the Reports menu 
in the displayed History Reports window and choose Health 
Optimization. 

Tip

n To print a report, pull down the Print menu in the History Reports window and choose Print Report.

n To close a report, choose Close from Reports menu.



Traffic Report

Net.Medic’s Traffic Report provides estimates of the average Intranet, ISP, and Internet traffic levels based on the 
time of day. This information can help you determine the peak and non-peak hours for your Intranet, your ISP, and 
the Internet backbone. This, in turn, can help you avoid getting on the ”information highway” during congested 
intervals.

To display the Traffic Report

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports, then drag right and choose Traffic 
Report.

In the Net.Medic toolbar, click , pull down the Reports 
menu in the displayed History Reports window, and choose 
Traffic Report.

Right-click on the Net.Medic system tray icon, choose 
Reports from the pop-up menu. Pull down the Reports menu 
in the displayed History Reports window and choose Traffic 
Report. 

Tip

n To print a report, pull down the Print menu in the History Reports window and choose Print Report.

n To close a report, choose Close from Reports menu.



Service Provider Report

The Service Provider Report tracks and rates the performance of your ISP over the past month. Because it notifies 
you about ISP bottlenecks, it can help you decide whether to subscribe to a premium service offered by your ISP. You 
can also avoid needlessly calling your ISP for assistance or unnecessarily changing to a new ISP if your ISP isn’t a 
bottleneck. 

To display the Service Provider Report

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports, then drag right and choose Service 
Provider.

In the Net.Medic toolbar, click , pull down the Reports 
menu in the displayed History Reports window and choose 
Service Provider.

Right-click on the Net.Medic system tray icon, choose 
Reports from the pop-up menu. Pull down the Reports menu 
in the displayed History Reports window and choose Service 
Provider. 

To obtain a summary of your ISP’s performance for the current session

In the ISP pane, check the bank of health lights. Green, 
yellow, and red respectively indicate good, moderate, or poor 
performance.

In the Net.Medic toolbar, click . The Session Summary 
window opens and identifies whether your ISP was a 
bottleneck for the current session.

To obtain a summary of your ISP’s performance for the past month

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports and then Health Summary Report.

Tip

n To print a report, pull down the Print menu in the History Reports window and choose Print Report.

n To close a report, choose Close from Reports menu.

n You can view your ISP’s historical responsiveness by checking the Delay chart in the ISP pane.

n To obtain estimates of your current session, click  in the Net.Medic toolbar, or choose Session Summary from 
the Net.Medic Window menu.

n To obtain estimates of your sessions over the past month, pull down the Net.Medic Window menu, choose History 
Reports, then drag right and choose Health Summary Report.



Frequently Visited Sites Report

The Frequently Visited Sites Report rates the ten Web sites you’ve visited the most over the past month. The report 
graphs the following information for each site:

n The minimum, maximum, and average response time

n The minimum, maximum, and average throughput

n The number of times you’ve visited the site over the past month

This information can help you make an informed decision about which Web site to visit. If you’re a Webmaster, this 
information can help you decide if you should purchase a premium Web hosting service that guarantees fast end-to-
end connections around the clock.

To display the Frequently Visited Sites Report

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports, then drag right and choose Frequently 
Visited Sites.

In the Net.Medic toolbar, click , pull down the Reports menu 
in the displayed History Reports window and choose 
Frequently Visited Sites.

Right-click on the Net.Medic system tray icon, choose Reports 
from the pop-up menu. Pull down the Reports menu in the 
displayed History Reports window and choose Frequently 
Visited Sites. 

To obtain a summary of the server’s performance for the current session

In the Server pane, check the bank of health lights. Green, 
yellow, and red respectively indicate good, moderate, or poor 
performance.

To check a site’s current throughput, visit the site and check the 
Throughput meter in the Server pane.

Tip

n To print a report, pull down the Reports menu in the History Reports window and choose Print Current Report.

n To close a report, choose Close from Reports menu.

n To obtain a summary of your current session, click  in the Net.Medic toolbar, or choose Session Summary for 
the Net.Medic Window menu.

n To obtain a summary of your online sessions for the past month, pull down the Net.Medic Window menu, choose 
History Reports, then drag right and choose Health Summary Report.



Slowest Sites Report

The Slowest Sites Report rates the slowest five Web sites you’ve visited over the past month. The report provides the 
following information:

n The slowest five sites in terms of response time

n The slowest five sites in terms of    throughput

To display the Slowest Sites Report

In the Net.Medic menu bar, pull down the Window menu, 
choose History Reports, then drag right and choose Slowest 
Sites.

In the Net.Medic toolbar, click , pull down the Reports menu 
in the displayed History Reports window and choose Slowest 
Sites.

Right-click on the Net.Medic system tray icon, choose Reports 
from the pop-up menu. Pull down the Reports menu in the 
displayed History Reports window and choose Slowest Sites. 

To obtain a summary of the server’s performance for the current session

In the Server pane, check the bank of health lights. Green, 
yellow, and red respectively indicate good, moderate, or poor 
performance.

To check a site’s current throughput, visit the site and check 
the Throughput meter in the Server pane.

Tip

n To close a report, choose Close from the Reports menu.

n To print a report, pull down the Reports menu in the History Reports window and choose Print Current Report.

n To obtain a summary of your current session, click  in the Net.Medic toolbar, or choose Session Summary for 
the Net.Medic Window menu.

n To obtain a summary of your online sessions for the past month, pull down the Net.Medic Window menu, choose 
History Reports, then drag right and choose Health Summary Report.



Purpose of the Slowest Sites Report

This report can help you determine which sites to avoid when possible. You can use the report to quickly check the 
performance of a Web site relative to other sites. For example, the report enables you to view a site’s performance 
relative to your slowest five sites.



Health Summary Report

The Health Summary Report rates the overall health of your online sessions for the past month. The report provides 
the following information:

n A distribution of problems 

n The top five causes of the problems

The report can help you pinpoint problems that persistently cause a bottleneck in your online connections. 

To display the Health Summary Report

In the Net.Medic menu bar, pull down the Window menu, choose 
History Reports, then drag right and choose Health Summary 
Report.

In the Net.Medic toolbar, click , pull down the Reports menu in 
the displayed History Reports window and choose Health 
Summary.

Right-click on the Net.Medic system tray icon, choose Reports 
from the pop-up menu. Pull down the Reports menu in the 
displayed History Reports window and choose Health Summary. 

Note

n To obtain a summary of your current session, click  in the Net.Medic toolbar, or choose Session Summary for 
the Net.Medic Window menu.



To find out the name of a toolbar button

Move the pointer over the icon in the Net.Medic toolbar. The 
name of the icon is displayed in the dashboard.

Note

n Balloon help is also available for the icons, digital displays, charts, gauges and meters in the Net.Medic 
dashboard panes. 



To get a session summary

Click  in the Net.Medic toolbar.

The Summary View window opens with a summary of your current online session.

· The window’s toolbar reports the health of the Web path components as well 
as overall health. 

· It reports what percentage of the problems in the current session is 
attributable to various Web path components.

· The start time and duration of the current session are provided.

Tips

n For more information on the performance of a component in your Web path, click its tab in the Session 
Summary toolbar. For example, click on the Desktop tab to view more information about your computer’s 
performance.

n You can compare these ISP and server session statistics with their historical performance. 

n To view the historical performance of your ISP or server, click  in the Net.Medic toolbar. 

The History Reports window opens. In the menu bar, click Reports to display the Reports pull-down menu. From 
the pull-down menu, select the history report you want to view.

n You can compare current modem session statistics with past modem performance.

n To view the history of your modem calls, click  in the Net.Medic toolbar or choose Call Log from the Net.Medic 
Window menu. The Net.Medic call log opens with detailed information about your modem calls made over    the 
past month.

n To obtain a summary of your sessions for the past month, pull down the Window menu, choose History Reports 
then drag right and choose Health Summary Report.

What do you want to know more about?

n Working with the history reports

n Working with the call log 



To close (minimize) the Net.Medic dashboard

In the Net.Medic title bar, click .

In the Net.Medic title bar, click , then choose Minimize from 
the pull-down menu.

Tip

n This procedure hides the dashboard without closing the Net.Medic program. 

n To shut down (exit) the Net.Medic program, right-click on the Net.Medic system tray icon. Choose Exit from the 
pop-up menu. The Net.Medic program and background monitoring processor are shut down. The Net.Medic 
icon is removed from the system tray. The next time you restart your computer, the Net.Medic program is 
automatically started.



To close the Net.Medic inlay

Right-click on the inlay and choose Close Pane or Snap on 
Dashboard.

Tip

n This procedure closes the inlay without closing the Net.Medic program. To shut down (exit) the Net.Medic 
program, right-click on the Net.Medic system tray icon and choose Exit from the pop-up menu.



Changing the ticker tape settings

By default, the Net.Medic ticker tape reports the following information:

n The name of the Web site currently being visited

n The number of times you’ve visited the current site

n The URL and size of the Web page you’re currently transferring

n The delay caused by the network expressed as an estimated percent

n The last health log entry received

n Any of your unread mail messages that match the specified criteria 

n Any broadcast messages from your service provider (for example, “the DNS server will be down from 11:00 PM 
to 11:30 PM tonight.”)

To change the ticker tape settings

1 Right-click on the ticker tape and choose Preferences from the pop-up menu. The Preferences window opens 
with the Ticker Tape panel selected. 

2 Use the Ticker Tape panel to modify the settings in this dialog box. For example, to suppress broadcast 
messages from the ticker tape, left-click on the Mail option in the Ticker Tape panel to deselect it.

3 Click OK to implement the specified changes and to close the Preferences window.

Tips

n To snap the ticker tape onto your browser, right-click anywhere in the ticker tape and choose Snap On Browser. 
With Netscape Navigator, you can snap a dashboard pane and the ticker tape concurrently. With Internet 
Explorer, you can only snap a dashboard pane or the ticker tape.

n To detach the ticker tape from your browser, right-click on the ticker tape and choose Snap on Dashboard.

n Individual Net.Medic users can use the ticker tape E-mail feature to send E-mails that will be displayed in other 
individual users’ Net.Medic ticker tape. To use this capability, simply include “VitalSigns” in the subject portion of 
your E-mails (for example, “Subject: VitalSigns: The mail server will be down tomorrow.”) After sending such 
messages to other Net.Medic users, it will appear in their ticker tape if the message was delivered by the 
Microsoft Messaging API (MAPI).

What do you want to know more about?

n How can system administrators change user configuration variables?

n Tips on snapping dashboard panes and the ticker tape onto your browser 



Understanding the Net.Medic preferences

Net.Medic comes with a set of default preferences that allows you to install Net.Medic and start using it to monitor 
your online connections. These preferences include the following:

n A set of ticker tape settings

n E-mail settings that Net.Medic uses to send E-mails about chronic problems it encountered (Note that the E-mail 
notification feature is only available with the retail version of Net.Medic.)

n The number of colors Net.Medic uses to display its dashboard window

n Performance settings that it uses to monitor your online connections. 

Changing the Net.Medic preferences

You can, however, easily change any of the Net.Medic preferences by simply choosing Preferences from the View 
menu. For example, follow these steps to change the ticker tape settings:

1 Display the Preferences window by choosing Preferences from the View menu or by right-clicking on the ticker 
tape and choosing Preferences.

2 Check that the Ticker Tape panel of the Preferences window is selected. Use the Ticker Tape panel to change 
the current ticker tape preferences. For instance, to suppress broadcast messages from your ticker tape, left-
click on the Mail option in the Ticker Tape panel to deselect it.

3 In the Ticker Tape panel, click OK to implement the specified changes and to close the Preferences window.

What do you want to know more about?

n How to change the Net.Medic ticker tape settings 

n How to change the Net.Medic E-mail settings 

n How to change the Net.Medic display colors 

n How to change the Net.Medic performance settings 



Changing the Net.Medic E-mail settings

Net.Medic has a default set of performance settings so that you can install and start using it without having to 
reconfigure your system. You can, however, easily change these default settings through the Net.Medic Preferences 
window.

n If you have Microsoft Exchange Client installed on your PC, Net.Medic detects this and uses Exchange Client to 
send its E-mail notifications. Note that the E-mail notification feature is only available with the retail version of 
Net.Medic.

n If you do not have Exchange Client installed, Net.Medic will use SMTP to send its E-mail notifications. You must, 
however, supply Net.Medic with information about your SMTP settings.

To set your SMTP E-mail settings for Net.Medic

1 Choose Preferences from the Window menu in the Net.Medic menu bar. 

2 In the displayed Preferences window, click the Mail tab.

3 In the “When Sending E-Mail Notification” portion of the Mail panel, click the “Use SMTP Mail Setting” radio 
button.

4 In the “SMTP Mail Settings” portion of the Mail panel, specify your SMTP settings.

5  Click OK to implement the changes and to close the Preferences window.

Tips

n Net.Medic also comes with a set of preset ticker tape and performance preferences. Like the E-mail settings, 
you can use the Preferences window to change these default preferences.

What do you want to know more about?

n How Net.Medic helps you notify the appropriate resource about a problem 

n How to change the Net.Medic ticker tape settings 

n How to change the Net.Medic display colors

n How to change the Net.Medic performance settings



Changing the Net.Medic display colors

By default, Net.Medic uses 256 colors to display its dashboard window on your desktop. You can, however, change 
the display color setting to 16 colors. You may want to change the Net.Medic display colors from 256 colors 16 
colors, if you are encountering display problems such as the following:

n When moving between applications, you experience flickering problems.

n After you’ve snapped a Net.Medic pane onto your browser, the browser graphics are not being displayed with 
the proper colors.

To change the Net.Medic display color setting

1 Choose Preferences from the Window menu in the Net.Medic menu bar. 

2 In the displayed Preferences window, click the Colors tab.

3 In the Colors panel, click the 16 colors radio button.

4 Click OK to implement the new settings and to close the Preference window.

What do you want to know more about?

n How to change the Net.Medic ticker tape settings 

n How to change the Net.Medic E-mail settings 

n How to change the Net.Medic performance settings



Changing the Net.Medic performance settings

Net.Medic has a default set of performance settings so that you can install and start using it without having to 
reconfigure your system. You can, however, easily change these default settings through the Net.Medic Preferences 
window. By default, the Net.Medic program uses the following settings to track your online performance:

n Normal test frequency 

n Medium performance threshold level 

To change the test frequency setting

1 Choose Preferences from the Window menu in the Net.Medic menu bar. 

2 In the displayed Preferences window, click the Performance tab.

3 In the Test Frequency portion of the Performance panel, click the Slow radio button.

4 Click OK to implement the new settings and to close the Preference window.

To change the performance threshold level setting

1 Choose Preferences from the Window menu in the Net.Medic menu bar. 

2 In the displayed Preferences window, click the Performance tab.

3 In the Performance Threshold Levels portion of the Performance panel, move the sliding bar to reset the 
threshold level.

4 Click OK to implement the new settings and to close the Preference window.

Tips

n By changing the performance threshold level from “Medium” to “Low,” the frequency of exceeded thresholds will 
increase. This will result in an increase in the number of errors reported in your Net.Medic health log.

n By changing the performance threshold level from “Medium” to “High,” the frequency of exceeded thresholds will 
decrease. This, in turn, will result in a decrease in the number of errors reported in your Net.Medic health log.

n Net.Medic comes with a set of preset E-mail and ticker tape preferences. Like the performance threshold level 
settings, you can use the Preferences window to change these default preferences.

What do you want to know more about?

n Net.Medic dashboard objects (charts, gauges, etc.) 

n How to change the Net.Medic E-mail settings 

n How to change the Net.Medic ticker tape settings

n How to change the Net.Medic display colors

n How to work with the health log 



Test Frequency setting

Net.Medic uses the Test Frequency setting to determine how frequently it should poll. When the test frequency is 
set to normal (the default), Net.Medic polls every second. When set to slow, Net.Medic will poll every five seconds. 
To change the current setting, choose Preferences from the Net.Medic window menu.



Performance Threshold Levels setting

Net.Medic uses the performance threshold setting to determine if a performance threshold has been exceeded. For 
example, the Server pane has a Delay chart that estimates the network delay that is attributable to the current 
remote Web server.

Blue indicates a reasonable delay. Yellow indicates slowness associated with this portion of your network. 
Net.Medic uses the specified performance threshold level to calculate if the estimated delay is reasonable or 
abnormally long and then uses the appropriate bar (blue vs. yellow) in the Delay chart to report this information.



List of dashboard objects

Net.Medic’s dashboard panes have a set of objects that animate and monitor your online connection. All of the 
following dashboard objects have balloon help. Some of them also allow you to open the Net.Medic health log by 
double-clicking. To check if an object supports this double-clicking feature, move the pointer over it. If a magnifying 
glass appears, double-click on the object to open the health log with the matching entry already highlighted for you.

Activity pane

Indicates your overall performance and animates your online connections.

Icons Description

Desktop computer icon, which represents the client (your desktop 
computer).

Modem icon, which represents the modem used to connect to the 
Internet. If you are connecting via a LAN or other Internet 
connection, this icon will not appear in this pane.

Router hop icon, which represents each router (hop) in your Web 
path.

Server icon, which represents the remote Web server.

Gray indicates a healthy state. Yellow and red indicate moderate or poor health. The rate of page animation reflects 
the current transfer rate.

Number of router hops. Net.Medic counts the number of router hops traversed in your current Web path. Each 
colored dot represents a router hop in your path. The hops are divided into distinct groups to signify the different 
regions (the Intranet portion, ISP portion, and Internet backbone portion) in your path. For example, if your computer 
traversed ten routers to connect to a remote server, that Web path involves ten router hops. 

n If you are retrieving information from an Internet Web site and you are connected via a modem, you will see two 
sets of routers. The first set is the ISP routers and the second set is the Internet backbone routers. 

n If you are connected to a corporate Intranet, you will see three sets of routers. The Intranet routers will be the first 
of the three sets of routers.

If you are connected to a corporate Intranet and the Web server is also on the corporate Intranet, you will only see 
one set of Intranet routers connected by a white line.

Throughput pane 

Use the Net.Medic Throughput pane to determine how fast you are currently transferring data over the network. 
Transfer speed is shown in kbps. For example, if you are receiving a Web page across the network at a rate of 26.3 
kbps, the Web page is being transferred at a rate of 26,300 bits per second (bps). The transfer speed rate is 
reported in: (1) the recv and send graph that indicates any activity seen on the network/dialup interface of the client, 
(2) the transfer gauge to the right of the recv and send graph, and (3) as a digital display (for example, 28.8 kbps). If 
white tips appear on the transfer gauge, this reflects a data transfer that is using compression and is exceeding the 
modem connection speed.

Speed limit digital display. The speed limit is the estimated maximum speed or bandwidth available end-to-end 
during the current transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 line) and 
automatically calculates your speed limit. You may, however, want to change the current speed limit if the receive 
and transmit rates (the blue vertical bars in the recv and send graph) are high and difficult to read. In this case, 
raising the speed limit will increase the histogram maximum, thereby making the bars shorter in the graph and 
easier to interpret. To manually set the speed limit, right-click on this digital display, choose Speed Limit from the 
pop-up menu, then drag right and choose one of the manual settings.

Recv and send graphs and digital displays. The recv graph and digital display report the receive rate during each 
interval. The send graph and digital display report the transmit rate during each interval. Transfer rates for the 
previous several seconds scroll from right to left with the passage of every second. The send/recv graphs indicate 



any activity seen on the network/dialup interface of the client. If the blue lines have white tips at the top, your 
connection is using compression to speed up the download of Web pages.

Retrieval pane

Use this pane for the following purposes: (1) to determine how effectively you are transferring data over the 
network, (2) to establish how much time it takes to retrieve a Web page, and (3) to pinpoint the source of the delays.

Time digital display. Reports the total time (delay) taken to retrieve the current Web page. (The retrieval of a Web 
page is an HTTP transfer.) The transfer time is shown in minutes, seconds and tenth of seconds.

Network gauge. Reports an estimated percent of retrieval time caused by a delay in the network that is between 
the Web site and the client (your desktop computer). 

Site gauge. Reports an estimated percent of retrieval time caused by a delay on the server (Web site). The 
Network gauge and the Site gauge measurements combined always total 100%. The Network gauge gives a real-
time indication of the percentage of transfer time attributable to the network. The Site gauge indicates the 
percentage of transfer time attributable to the Web server (the site). For example, if the Network gauge reads 43% 
and the Site gauge reads 57%, this indicates the site is causing most of the delay.

Avg. Rate digital display. Reports the average rate to retrieve the current Web page from the Web site. This rate is 
shown in kbps. 

Note 

Net.Medic separates the amount of delay in retrieving the page into two portions: the delay caused by the network 
and the delay caused by the server. This network delay is the time it takes to make the request from the client to the 
server’s network connection plus the time it takes the results to be returned from the server’s network connection to 
the client. Some of this delay is the propagation delay in the links. The remainder is the delay in packet queues of 
intermediate devices such as routers. In the preceding example, the network contributed to 43% of the delay and 
the remainder belongs to the server.

Client pane

Use the Net.Medic Client pane to determine the performance and overall health of the client (your desktop 
computer). 

Bank of health lights. Reports the overall health of your desktop computer. Green, yellow, and red respectively 
indicate good, moderate, or poor health. For example, yellow indicates a moderate to serious problem with your 
computer. To obtain more information about PC-related problems, check the Net.Medic health log by double-clicking 

on this pane’s yellow or red health light, or on the yellow or red PC icon  in the Activity pane.

CPU Load gauge. Reports what percent of your computer’s CPU is currently utilized. The CPU load is sometimes 
referred to as the system load. The more occupied it is, the slower your browser may work. Spiking (occasional high 
percentages) in this gauge is normal. However, a continually high reading on the gauge indicates a sustained heavy 
CPU load, which could signify an overtaxed computer. Windows 95 will often run at 100% if you have multiple 
applications open.

Cache Hits meter. Reports the percent of Web pages this session retrieved from local disk cache (cache hits) 
rather than retrieving them from the remote Web site. The local cache, or Web page storage, keeps pages from 
Web sites you have previously visited, and stores them on your local hard drive. Once these pages are stored on 
your hard drive, they can be quickly retrieved from your computer the next time you visit that Web site. It is faster to 
“download” from your local drive than from the remote Web site. High numbers in this meter indicate good cache 
management and thus good browsing performance.

Note 

n The name of your computer (for example, “us.ppp.pdelay”) appears in the upper-left corner of this pane. 

n The color of the client    icon  in the Net.Medic Activity pane also indicates your computer’s overall health. 
Gray, yellow, and red indicate good, moderate, or poor health. 

Modem pane

Use the Net.Medic Modem pane to determine your modem’s performance and overall health.



Bank of health lights. Indicates the overall health of your modem. Green, yellow, and red indicate good, moderate, 
or poor health. To obtain more information about problems related to your modem, check the Net.Medic health log 
by double-clicking on this pane’s yellow or red health light, or on the yellow or red modem icon in the Activity pane.

Compression scale. Provides an estimate of the amount of compression your modem is currently using. The 
compression scale setting is updated every second and is only active during transfers. The blue arrow will slide 
back and forth to indicate the level of compression. If the blue arrow turns white when it is active, this signifies 
compression is in effect. If your modem is using compression, you can download Web pages faster. You can have 
Net.Medic enable compression via its AutoCure feature.

Speed meter. Reports the connection speed of your modem. The meter indicates what percent of the rated modem 
speed was actually achieved during the “handshake” between your modem and the ISP’s modem. A low percentage 
in this meter indicates your modem is not connected at optimal speed. For example, if you had a 28.8 kbps modem 
and the speed is reported at 26.4 kbps, the Speed meter registers 92% because 8% of your modem’s potential 
capacity is not being utilized.

Tips

n This pane is not present in the Net.Medic dashboard if your computer does not have a modem.

n The color of the modem icon in the Activity pane also indicates the modem’s overall health. Gray, yellow, and 
red indicate good, moderate, or poor health.

n To obtain more information about modem-related problems, check the Net.Medic health log. By double-clicking 
on the yellow or red modem icon (a hot spot) in the Activity pane, you can quickly pinpoint the source of the 
problem. The health log opens with the matching entry automatically highlighted. You can also display the health 
log by double-clicking on the yellow or red dashboard light in the Modem pane.

n To obtain more information about calls made by your modem, check the Net.Medic call log.

n To obtain more information about using your modem, refer to your modem’s online help system.

Intranet pane

Use the Net.Medic Intranet pane to determine the following: (1) the health of your Intranet from your unique 
perspective, and (2) your Intranet’s performance based upon a periodic sampling. The name of your Intranet 
appears in the upper-left corner of this pane. Note that most modem users are not using an Intranet and therefore 

will not see this pane in their Net.Medic dashboard. 

Delay chart. Provides an estimate of network delay attributed to the Intranet. Blue indicates a reasonable delay. 
Yellow indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the 
longer the delay caused by your Intranet. The delay attributed to the Intranet is computed by taking the difference of 
round trip times between reaching the last Intranet router and the first Intranet router.

Traffic gauge. Provides a relative estimate of the Intranet traffic level in your Web path. Note that this is along your 
path through the network. This estimate is computed by taking the delay introduced by the Intranet and comparing 
that against the historical distribution of Intranet delays. The current value is placed in that distribution by computing 
a percentile. In the preceding example, 10% indicates that the current response was in the 10th percentile, which 
means that the current Intranet delay was more than 10% of previously seen delays and was less than 89% of other 
previous delays. Therefore, lower percentile numbers mean lower congestion and vice-versa. The traffic index for 
your performance over the Intranet is baselined over time and will become more accurate over time.

Bank of health lights. Indicates the current overall health of your Intranet services (for example, IP connectivity 
and DNS). Green, yellow, and red respectively indicate good, moderate, or poor health.

ISP pane

Use the Net.Medic ISP pane to obtain the following information: (1) an index of the current overall health of your ISP 
from your connection point, and (2) your ISP’s performance based upon a periodic sampling. 

Delay chart. Provides an estimate of network delay that is attributable to your ISP. The chart provides a histogram 
of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow indicates 
slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the delay 
caused by your ISP.

Traffic gauge. Provides a relative estimate of the ISP traffic level in your Web path. This estimate is computed by 
taking the delay introduced by the ISP and comparing that against the historical distribution of ISP delays. The 



current value is placed in that distribution by computing a percentile. In the preceding example, 89% indicates that 
the current response was in the 89th percentile, which means that the current ISP delay was more than 89% of 
previously seen delays and was less than 10% of other previous delays. Therefore, higher percentile numbers 
mean higher congestion and vice-versa. The traffic index for your ISP’s performance is baselined over time and will 
become more accurate over time.

Bank of health lights. Indicates the current overall health of your ISP. Green, yellow, and red respectively indicate 
good, moderate, or poor health. 

Internet pane

Use the Net.Medic Internet pane to check the performance of the Internet portion of your Web path. To obtain more 
information about problems related to the Internet backbone, check the Net.Medic health log by double-clicking on a 
yellow or red Internet hop (router) icon in the Activity pane.

Delay chart. Provides an estimate of the network delay attributable to the Internet backbone. The chart provides a 
histogram of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow 
indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the 
delay caused by the Internet backbone. The delay attributed to the Internet backbone is computed by taking the 
difference of round trip times between reaching the remote Web server and the last ISP router.

Traffic gauge. Provides a relative estimate of the Internet traffic level along your path. Lower percentile numbers in 
this gauge mean lower congestion and vice-versa. This estimate is computed by taking the delay introduced by the 
Internet and comparing that against the historical distribution of Internet delays. The current value is placed in that 
distribution by computing a percentile. In the preceding example, 8% indicates that the current response was in the 
8th percentile, which means that the current Internet delay was more than 8% of previously seen delays and was 
less than 81% of other previous delays. Therefore, lower percentile numbers mean lower congestion and vice-
versa. The traffic index is baselined over time and becomes more accurate over time.

Peak Speed meter. Reports an estimated peak transfer speed as a percent of the speed limit of your online 
connection. The speed limit refers to the number of bits per second (bps) that can be transferred by the thinnest 
pipe between your computer and the Web server. If you are reaching frequently accessed sites, which are 
sometimes connected to the Internet backbone with thick pipes, the thinnest pipe is usually the first link between 
your computer and your ISP. This is generally the case when you are connected to the modem. While the speed 
limit refers to the theoretical maximum speed that can be reached, the Peak Speed refers to the current speed 
observed while your pages are being transferred. 

A low percentage in this meter indicates poor utilization of the bandwidth available end to end. Consequently, high 
values in this meter are desirable and indicate the Internet backbone is passing traffic without introducing delays.

Server pane

Use the Net.Medic Server pane (also referred to as the Web site pane) to obtain an estimate of the health or 
performance of the remote Web server. The name of the remote Web server (for example, “southport.jpl.nasa”) 
appears in the upper-left corner of this pane. 

Delay chart. Reports the estimated server and application (HTTP) delay caused by the various Web sites you have 
most recently visited. The delay measurement is based on the amount of time the server takes to complete its 
response to a request. Blue indicates a reasonable delay. Yellow indicates slowness associated with the remote 
Web server and the application layer response. The taller the line on this chart, the longer the delay caused by the 
server or Web site.

Load gauge. Reports the relative load on the server or Web site. This estimate is computed by taking the server 
delay and comparing that against the historical distribution of server delays. Consequently, this value is an indicator 
of the responsiveness of the server. The current delay value is placed in the historical delay distribution by 
computing a percentile. In the preceding example, 10% indicates that the current response was in the 10th 
percentile. This means that the current Internet delay was more than 10% of previously seen delays and was less 
than 89% of other previous delays. Therefore, lower percentile numbers mean lower load and better 
responsiveness. The more you visit a site, the more accurate its load gauge percentage reading becomes.

Throughput meter. Reports the efficiency of the current server or Web site and its attempt to use the available 
network bandwidth. It’s an estimated percent of the speed limit achieved by the current Web site server averaged 
over the complete page transfer time. A high throughput percentage indicates good utilization of the bandwidth 
available to the current server or Web site. However, if the speed limit is high (such as “LAN” speed), even the 



fastest servers may not achieve a high percentage.

Note

The color of the server icon  in the Activity dashboard pane indicates the server’s overall health. Gray, yellow, and 
red respectively indicate good, moderate, or poor health. This overall health is computed based on the health of the 
following components:

n If the server throughput is less than 10% of the available network bandwidth, then the status is yellow.

n If the server is not responding to page requests from the Web browser, then the status is red.

n If the delay introduced by the server is more than 600 milliseconds, then the status is yellow.

n If the estimate of load on the server as compared against historical measurements places the server load on the 
90th percentile of the distribution, then the status is yellow.

Connect Time pane

Use the Net.Medic Session Time/Connect Time pane for the following purposes: (1) to track your modem 
connection time if you’re connected via a modem, or (2) to track your browser activity time. Total time is shown in 
hours and minutes. Note that the session time is reported for both modem and LAN connections; whereas, the 
modem connect time is only reported with modem connections. You can switch between these two views (Modem 
Connect Time and Session Connect Time) by right-clicking on this Net.Medic pane and choosing Session Time or 
Modem Connect Time from the pop-up menu.

Session digital display. Time on current session.

Today digital display. Time on all sessions today.

This Month digital display. Time on all sessions this month.

Note

n The session connect time stops incrementing when the browser is idle for more than 3 minutes.

n Note that ISPs vary in their billing policies and can also periodically change them. For example, various ISPs 
use different methods to round up the billable hours while others bill in minimum time increments. Net.Medic 
does not account for such variables. Consequently, although the Net.Medic Connect Time dashboard pane 
reflects your online time over the past month, the reported time may not reflect your final ISP bill because of 
these variables.



List of Net.Medic panes

The Net.Medic dashboard includes the following panes that provide detailed performance information.

Activity pane

Use the Net.Medic Activity pane to animate your online connections and to determine your overall performance. 
Colored icons are used to represent the health of the various components in your Web path. This pane also reports 
the status of your current online activity (for example, “Transferring data”), the animation of Web pages being 
retrieved, and the number of hops in your path. For example, the rate of the page animation reflects how quickly 
you are retrieving the current Web page. 

Number of router hops. Net.Medic counts the number of router hops traversed in your current path. Each colored 
dot represents a router hop. For example, if your computer traversed ten routers to connect to a remote server, that 
Web path involves ten router hops. 

If you are retrieving information from an Internet Web site and you are connected to the Internet via a modem, you 
will see two sets of routers. The first set is the ISP routers and the second set is the Internet backbone routers. If 
you are connected to a corporate Intranet, you will see three sets of routers. The Intranet routers will be the first set 
of three router sets.

If you are connected to a corporate Intranet and the Web server is also on the corporate Intranet, you will only see 
one set of Intranet routers connected by a white line.

Tips

n To learn more about a group of router hops, move your pointer over one of its icons in the Activity pane. 
Net.Medic’s balloon help displays a brief description of the router hop group.

n If you click once on an object in this pane, the corresponding dashboard pane opens. To open the Intranet pane, 
click one of the Intranet router hop icons. To open the ISP pane, click one of the ISP router hop icons. To open 
the Internet pane, click one of the Internet backbone router hop icons. (You can also open the Intranet pane, the 
ISP pane, or the Internet pane by pulling down the View menu and respectively choosing Intranet, ISP, and 
Internet from the Details submenu.)

n If you double-click on a hot spot in this pane, the Net.Medic health log opens with the matching entry 
highlighted. This feature can help you quickly pinpoint the source of the problem without manually searching 
through the log

n By double-clicking on a health log entry, the Diagnosis window opens with a diagnosis and prescription for the 
problem if possible.

n You can use the Identify feature to quickly identify your ISP, Intranet, or the current remote Web server. 

Throughput pane

Use the Net.Medic Throughput pane to determine how fast you are currently transferring data over the network. 
Transfer speed is shown in kbps. For example, if you are receiving a Web page across the network at a rate of 26.3 
kbps, the Web page is being transferred at a rate of 26,300 bits per second (bps). The transfer speed rate is 
reported in: (1) the recv and send graph that indicates any activity seen on the network/dialup interface of the client, 
(2) the transfer gauge to the right of the recv and send graph, and (3) as a digital display (for example, 26.2 kbps). If 
white tips appear on the transfer gauge, this reflects a data transfer that is using compression and is exceeding the 
modem connection speed.

Speed limit digital display. The speed limit is the estimated maximum speed or bandwidth available end-to-end 
during the current transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 line) and 
automatically calculates your speed limit. You may, however, want to change the current speed limit if the receive 
and transmit rates (the blue vertical bars in the recv and send graph) are high and difficult to read. In this case, 
raising the speed limit will increase the histogram maximum, thereby making the bars shorter in the graph and 
easier to interpret. To manually set the speed limit, right-click on this digital display, choose Speed Limit from the 
pop-up menu, then drag right and choose one of the manual settings.

Recv and send graphs and digital displays. The recv graph and digital display report the receive rate during each 



interval. The send graph and digital display report the transmit rate during each interval. Transfer rates for the 
previous several seconds scroll from right to left with the passage of every second. The send/recv graphs indicate 
any activity seen on the network/dialup interface of the client. If the blue lines have white tips at the top, your 
connection is using compression to speed up the download of Web pages.

Retrieval pane

Use the Net.Medic Retrieval pane for the following purposes: (1) to determine how effectively you are transferring 
data over the network, (2) to establish how much time it takes to retrieve a Web page, and (3) to pinpoint the source 
of the delays.

Time digital display. Reports the total time (delay) taken to retrieve the current Web page. (The retrieval of a Web 
page is an HTTP transfer.) The transfer time is shown in minutes, seconds and tenth of seconds.

Network gauge. Reports an estimated percent of retrieval time caused by a delay in the network that is between 
the Web site and the client (your desktop computer). 

Site gauge. Reports an estimated percent of retrieval time caused by a delay on the server (Web site). The 
Network gauge and the Site gauge measurements combined always total 100%. The Network gauge gives a real-
time indication of the percentage of transfer time attributable to the network. The Site gauge indicates the 
percentage of transfer time attributable to the Web server (the site). For example, if the Network gauge reads 43% 
and the Site gauge reads 57%, this indicates the site is causing most of the delay.

Avg. Rate digital display. Reports the average rate to retrieve the current Web page from the Web site. This rate is 
shown in kbps. 

Note 

n Net.Medic separates the amount of delay in retrieving the page into two portions. The delay caused by the 
network and the delay caused by the server. This network delay is the amount of time it would take to make the 
request from the client to the server and the amount of time it takes the results to be returned from the server to 
the client. Some of this delay is the propagation delay in the links. The remainder is the delay in packet queues 
of intermediate devices such as routers. In the preceding example, the network contributed to 43% of the delay 
and the remainder belongs to the server.

n For more information about the network (Internet) portion of your Web path, check the Internet pane in the 
Net.Medic dashboard. 

n For more information about the site, check the Server pane in the Net.Medic dashboard. 

n For a performance rating of the sites you’ve visited the most over the past month, check the Net.Medic history 
reports.

Client (your computer) pane

Use the Net.Medic Client pane to determine the performance and overall health of the client (your desktop 
computer). 

Bank of health lights. Reports the overall health of your desktop computer. Green, yellow, and red respectively 
indicate good, moderate, or poor health. For example, yellow indicates a moderate to serious problem with your 
computer. To obtain more information about PC-related problems, check the Net.Medic health log by double-clicking 

on this pane’s yellow or red health light, or on the yellow or red PC icon  in the Activity pane.

CPU Load gauge. Reports what percent of your computer’s CPU is currently utilized. The CPU load is sometimes 
referred to as the system load. The more occupied it is, the slower your browser may work. Spiking (occasional high 
percentages) in this gauge is normal. However, a continually high reading on the gauge indicates a sustained heavy 
CPU load, which could signify an overtaxed computer. Windows 95 will often run at 100% if you have multiple 
applications open.

Cache Hits meter. Reports the percent of Web pages this session retrieved from local disk cache (cache hits) 
rather than retrieving them from the remote Web site. The local cache, or Web page storage, keeps pages from 
Web sites you have previously visited, and stores them on your local hard drive. Once these pages are stored on 
your hard drive, they can be quickly retrieved from your computer the next time you visit that Web site. It is faster to 
“download” from your local drive than from the remote Web site. High numbers in this meter indicate good cache 
management and thus good browsing performance.



 Tips

n The name of your computer (for example, “us.ppp.pdelay”) appears in the upper-left corner of this pane.

n The color of the client icon  in the Activity pane also indicates the computer’s overall health. Gray, yellow, and 
red respectively indicate good, moderate, or poor health.

Modem pane

Use the Net.Medic Modem pane to determine your modem’s performance and overall health.

Bank of health lights. Indicates the overall health of your modem. Green, yellow, and red indicate good, moderate, 
or poor health. To obtain more information about problems related to your modem, check the Net.Medic health log 
by double-clicking on this pane’s yellow or red health light, or on the yellow or red modem icon in the Activity pane.

Compression scale. Provides an estimate of the amount of compression your modem is currently using. The 
compression scale setting is updated every second and is only active during transfers. The blue arrow will slide 
back and forth to indicate the level of compression. If the blue arrow turns white when it is active, this signifies 
compression is in effect. If your modem is using compression, you can download Web pages faster. You can have 
Net.Medic enable compression via its AutoCure feature.

Speed meter. Reports the connection speed of your modem. The meter indicates what percent of the rated modem 
speed was actually achieved during the “handshake” between your modem and the ISP’s modem. A low percentage 
in this meter indicates your modem is not connected at optimal speed. For example, if you had a 28.8 kbps modem 
and the speed is reported at 26.4 kbps, the Speed meter registers 92% because 8% of your modem’s potential 
capacity is not being utilized.

Tips

n This pane is not present in the Net.Medic dashboard if your computer does not have a modem.

n The color of the modem icon in the Activity pane also indicates the modem’s overall health. Gray, yellow, and 
red indicate good, moderate, or poor health.

n To obtain more information about calls made by your modem, check the Net.Medic call log.

n To obtain more information about using your modem, refer to your modem’s online help system.

Intranet pane

Use the Net.Medic Intranet pane to determine the following: (1) the health of your Intranet from your unique 
perspective, and (2) your Intranet’s performance based upon a periodic sampling. The name of your Intranet 
appears in the upper-left corner of this pane. Note that most modem users are not using an Intranet and therefore 

will not see this pane in their Net.Medic dashboard. 

Delay chart. Provides an estimate of network delay attributed to the Intranet. Blue indicates a reasonable delay. 
Yellow indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the 
longer the delay caused by your Intranet. The delay attributed to the Intranet is computed by taking the difference of 
round trip times between reaching the last Intranet router and the first Intranet router.

Traffic gauge. Provides a relative estimate of the Intranet traffic level in your Web path. Note that this is along your 
path through the network. This estimate is computed by taking the delay introduced by the Intranet and comparing 
that against the historical distribution of Intranet delays. The current value is placed in that distribution by computing 
a percentile. In the preceding example, 10% indicates that the current response was in the 10th percentile, which 
means that the current Intranet delay was more than 10% of previously seen delays and was less than 89% of other 
previous delays. Therefore, lower percentile numbers mean lower congestion and vice-versa. The traffic index for 
your performance over the Intranet is baselined over time and will become more accurate over time.

Bank of health lights. Indicates the current overall health of your Intranet services (for example, IP connectivity 
and DNS). Green, yellow, and red respectively indicate good, moderate, or poor health. 

Tip

n To obtain more information about problems related to your Intranet, check the Net.Medic health log by double-
clicking on this pane’s yellow or red health light or on one of the yellow or red Intranet router hop icons in the 
Activity pane. 

n To identify your Intranet, right-click anywhere in the Intranet pane and choose Identify from the pop-up menu. 
You can also identify your Intranet by right-clicking on one of the Intranet router hop icons in the Activity pane 
and choosing Identify.



ISP pane

Use the Net.Medic ISP pane to obtain the following information: (1) an index of the current overall health of your ISP 
from your connection point, and (2) your ISP’s performance based upon a periodic sampling. 

Delay chart. Provides an estimate of network delay that is attributable to your ISP. The chart provides a histogram 
of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow indicates 
slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the delay 
caused by your ISP.

Traffic gauge. Provides a relative estimate of the ISP traffic level in your Web path. This estimate is computed by 
taking the delay introduced by the ISP and comparing that against the historical distribution of ISP delays. The 
current value is placed in that distribution by computing a percentile. In the preceding example, 89% indicates that 
the current response was in the 89th percentile, which means that the current ISP delay was more than 89% of 
previously seen delays and was less than 10% of other previous delays. Therefore, higher percentile numbers 
mean higher congestion and vice-versa. The traffic index for your ISP’s performance is baselined over time and will 
become more accurate over time.

Bank of health lights. Indicates the current overall health of your ISP. Green, yellow, and red respectively indicate 
good, moderate, or poor health.

Tips

n The name of your ISP appears in the upper-left corner of this pane.

n To identify your ISP, right-click anywhere in the ISP pane and choose Identify from the pop-up menu. You can also 
identify your ISP by right-clicking on any of the ISP router hop icons in the Activity pane.

n To obtain more information about ISP-related problems, check the Net.Medic health log by double-clicking on this 
pane’s yellow or red health light, or on one of its yellow or red router hop icons in the Activity pane.

n For more information about your ISP’s performance over the past month, check Net.Medic’s Service Provider 
Report. 

Internet pane

Use the Net.Medic Internet pane to check the performance of the Internet portion of your Web path. To obtain more 
information about problems related to the Internet backbone, check the Net.Medic health log by double-clicking on a 
yellow or red Internet hop (router) icon in the Activity pane.

Delay chart. Provides an estimate of the network delay attributable to the Internet backbone. The chart provides a 
histogram of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow 
indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the 
delay caused by the Internet backbone. The delay attributed to the Internet backbone is computed by taking the 
difference of round trip times between reaching the remote Web server and the last ISP router.

Traffic gauge. Provides a relative estimate of the Internet traffic level along your path. Lower percentile numbers in 
this gauge mean lower congestion and vice-versa. This estimate is computed by taking the delay introduced by the 
Internet and comparing that against the historical distribution of Internet delays. The current value is placed in that 
distribution by computing a percentile. In the preceding example, 8% indicates that the current response was in the 
8th percentile, which means that the current Internet delay was more than 8% of previously seen delays and was 
less than 81% of other previous delays. Therefore, lower percentile numbers mean lower congestion and vice-
versa. The traffic index is baselined over time and becomes more accurate over time.

Peak Speed meter. Reports an estimated peak transfer speed as a percent of the speed limit of your online 
connection. The speed limit refers to the number of bits per second (bps) that can be transferred by the thinnest 
pipe between your computer and the Web server. If you are reaching frequently accessed sites, which are 
sometimes connected to the Internet backbone with thick pipes, the thinnest pipe is usually the first link between 
your computer and your ISP. This is generally the case when you are connected to the modem. While the speed 
limit refers to the theoretical maximum speed that can be reached, the Peak Speed refers to the current speed 
observed while your pages are being transferred. 

A low percentage in this meter indicates poor utilization of the bandwidth available end to end. Consequently, high 
values in this meter are desirable and indicate the Internet backbone is passing traffic without introducing delays.



Server pane

Use the Net.Medic Server pane (also referred to as the Web site pane) to obtain an estimate of the health or 
performance of the remote Web server. The name of the remote Web server (for example, “southport.jpl.nasa”) 
appears in the upper-left corner of this pane. 

Delay chart. Reports the estimated server and application (HTTP) delay caused by the various Web sites you have 
most recently visited. The delay measurement is based on the amount of time the server takes to complete its 
response to a request. Blue indicates a reasonable delay. Yellow indicates slowness associated with the remote 
Web server and the application layer response. The taller the line on this chart, the longer the delay caused by the 
server or Web site.

Load gauge. Reports the relative load on the server or Web site. This estimate is computed by taking the server 
delay and comparing that against the historical distribution of server delays. Consequently, this value is an indicator 
of the responsiveness of the server. The current delay value is placed in the historical delay distribution by 
computing a percentile. In the preceding example, 10% indicates that the current response was in the 10th 
percentile. This means that the current Internet delay was more than 10% of previously seen delays and was less 
than 89% of other previous delays. Therefore, lower percentile numbers mean lower load and better 
responsiveness. The more you visit a site, the more accurate its load gauge percentage reading becomes.

Throughput meter. Reports the efficiency of the current server or Web site and its attempt to use the available 
network bandwidth. It’s an estimated percent of the speed limit achieved by the current Web site server averaged 
over the complete page transfer time. A high throughput percentage indicates good utilization of the bandwidth 
available to the current server or Web site. However, if the speed limit is high (such as “LAN” speed), even the 
fastest servers may not achieve a high percentage.

Note

The color of the server icon  in the Activity dashboard pane indicates the server’s overall health. Gray, yellow, and 
red respectively indicate good, moderate, or poor health. This overall health is computed based on the health of the 
following components:

n If the server throughput is less than 10% of the available network bandwidth, then the status is yellow.

n If the server is not responding to page requests from the Web browser, then the status is red.

n If the delay introduced by the server is more than 600 milliseconds, then the status is yellow.

n If the estimate of load on the server as compared against historical measurements places the server load on the 
90th percentile of the distribution, then the status is yellow.

Tips

n To obtain more information about problems related to the current Web server, check the Net.Medic health log by 
double-clicking on a yellow or red server icon the Activity pane. 

n To identify the server, right-click on the Server pane and choose Identify from the pop-up menu. You can also 

identify a server by right-clicking on  in the Activity pane.

n Net.Medic has a Frequently Visited Sites Report that rates the performance of the ten sites you’ve visited most 
over the past month. It also has a Slowest Sites Report that rates the performance of the slowest five sites 
you’ve visited over the past month. You can display these reports from the toolbar or the Net.Medic Windows 
menu.

Connect Time pane

Use the Net.Medic Session Time/Connect Time pane for the following purposes: (1) to track your modem 
connection time if you’re connected via a modem, or (2) to track your browser activity time. Total time is shown in 
hours and minutes. Note that the session time is reported for both modem and LAN connections; whereas, the 
modem connect time is only reported with modem connections. You can switch between these two views (Modem 
Connect Time and Session Connect Time) by right-clicking on this Net.Medic pane and choosing Session Time or 
Modem Connect Time from the pop-up menu.

Session digital display. Time on current session.

Today digital display. Time on all sessions today.

This Month digital display. Time on all sessions this month.



Note

n The session connect time stops incrementing when the browser is idle for more than 3 minutes.

n Note that ISPs vary in their billing policies and can also periodically change them. For example, various ISPs 
use different methods to round up the billable hours while others bill in minimum time increments. Net.Medic 
does not account for such variables. Consequently, although the Net.Medic Connect Time dashboard pane 
reflects your online time over the past month, the reported time may not reflect your final ISP bill because of 
these variables.



List of router hop groups

Net.Medic counts the number of router hops in your current Web path. Each dot  represents a router hop. For 
example, if your computer traversed ten routers to connect to a remote server, that Web path involves ten router 
hops.    Net.Medic uses colored dots to indicate the current health of the router hops involved in your current path. 
Gray indicates a healthy state. Yellow and red respectively indicate moderate to poor health.

Groups of hops

If you’re connected to the Internet via a modem, Net.Medic breaks the router hops into two distinct groups (the ISP 
routers and the Internet backbone routers). If you are connected via a LAN, your path’s router hops are divided into 
three groups:

n Intranet routers 

n ISP routers

n Internet backbone routers

Tips

n Color indicates the overall health of this portion of your path.

n To learn more about a router hop group, move your pointer over one of its icons in the Activity pane. Net.Medic’s 
balloon help displays a brief description of the router hop group.

n To display more information about an unhealthy router hop, click once on its yellow or red icon in the Activity 
pane. The corresponding pane opens in the Net.Medic dashboard. 

n For more information about the cause of the problem, double-click on a yellow or red router hop icon in the 
Activity pane. The Net.Medic health log opens with the matching entry automatically highlighted. By double-
clicking on the health log entry, Net.Medic displays a diagnosis of and prescription for the problem whenever 
possible.

What do you want to know more about?

n Understanding router hops 

n How you can use router hop information

n What does the color of a router hop icon mean? 











A

Activity 
pane

The Net.Medic pane that indicates your overall performance. Reports 
the status of your current Web path (for example, “Transferring 
data...”). Color is used to indicate the current health of the Web path 
components (your desktop computer and modem, the Intranet, the 
ISP, Internet backbone, and the remote server).

To display this pane in the Net.Medic dashboard, click  in the 
Net.Medic toolbar.

B

Backup 
DNS 
server

The Domain Name System (DNS) server is a computer that acts as 
the server for a domain. (A part of a network whose nodes are under 
some common control.) 

One of the main functions of the Domain Name Server is to convert 
the host names of network nodes to IP addresses. If the primary DNS 
server fails, the secondary DNS server handles the responsibility. If 
the secondary DNS server fails, Net.Medic supplies a backup DNS 
server, which is a fail-safe server at the core of the Internet. Although 
use of this backup server ensures connection to the Internet, it may 
not be the most direct route. Therefore, you should routinely use your 
ISP DNS servers to ensure you’re using the most direct route.

Balloon 
help

Balloon help is available for certain objects in the Net.Medic 
dashboard. Move your pointer over an object. If balloon help is 
available, Net.Medic displays a brief description of the object. For 
example, if you’re connected via a modem move the pointer over the 
first or second group of router hop icons. As the following figure 
shows, Net.Medic informs you that the first group of router hops 
represents the ISP routers traversed in your current Web path.

Bandwidt
h

The maximum transmission speed of a Web path or connection that is 
usually measured in kilobits per second (kbps) or megabits per 
second (Mbps). More bandwidth indicates that more data can be 
transmitted per second. Capacity is sometimes used to refer to 
bandwidth.

Baud 
rate

The transmission rate, which is typically expressed in bits per second 
(bps).



Browser A program you can use to explore the World Wide Web (Web). 
Netscape Navigator and Microsoft Internet Explorer are examples of 
browsers. VitalSigns Net.Medic is a browser companion.

Browser 
compani
on

Net.Medic works with most 32-bit, Windows 95 communication 
programs, such as Netscape Navigator and Microsoft Internet 
Explorer.

C

Cache The portion of your computer disk used to locally store a copy of data 
retrieved from the network. By caching the data (Web pages), your 
computer avoids having to make duplicate retrievals of the same Web 
page from the remote server during your current Internet session. By 
preloading such pages, it speeds up how quickly you can reload the 
Web page.

Cache 
hits

To save time, certain information that you retrieve from the network is 
automatically saved on your computer for later retrieval. When your 
computer retrieves the stored information from its cache (local disk) 
the retrieval is called a cache hit.

Net.Medic displays the percent of retrievals during a current Internet 
session that are retrieved from your computer's cache versus the 
remote Web server. This number is displayed in the Cache Hits meter.

Call log The Net.Medic log that tracks your modem calls. The log provides 
information about your modem’s success rate, the bandwidth it 
achieved for each call, its average connection rate, and the 
percentage of busy signals it encountered. This vital data can help 
you decide whether you should upgrade to a faster modem. You can 
also use this log to audit your monthly usage and fees as well as the 
level of service provided by your ISP. 

To display this log, click  in the Net.Medic toolbar or choose Call 
Log from the Net.Medic Window menu.

Client A smaller computer that connects to other larger, more powerful 
computers called servers. Your browser is an example of a 
client/server system. The client program running on your computer 
takes advantage of the more powerful server at a remote site. Your 
desktop computer is sometimes referred to as the client.

Client 
pane

The Net.Medic pane that indicates your desktop computer’s 
performance and overall health.

The name of your computer appears in the upper-left corner of this 
pane. To display this pane in the Net.Medic dashboard, click the client 

icon  in the Activity pane.

Client/
server 
software

An arrangement of computers consisting of clients and servers, which 
are commonly used on the Internet and Intranet. Clients are 
computers such as PCs that utilize the data management services of 
the more powerful computers called servers. 

Netscape Navigator and Microsoft Internet Explorer are examples of a 
client/server system in which the client (the Web browser program) 
runs on your computer and uses the processing power of the server 
located at a remote site.

CPU The Central Processing Unit (CPU) is the computer chip that 
processes instructions for the computer. The Intel Pentium or 486 are 
examples of CPUs. Different types of CPUs have various levels of 
processing power.



CPU 
load

The CPU's processing power that is currently being used in your 
computer is called the CPU load. Net.Medic reports your CPU load 
percentage in its dashboard. A continually high percentage, for 
example, could indicate your current CPU is being overtaxed. A 
possible solution would be to upgrade your computer to a more 
powerful CPU.

D

Dashboa
rd

Term used to refer to the main Net.Medic window.

Dial-in 
string

Phone number used to dial into an Internet Service Provider (ISP) 
from a desktop computer (for example, a PC). It is also called a dial-in 
phone number.

Dial-up 
account

A type of account for accessing the Internet. Unlike a direct 
connection, this type of account only connects to the Internet when a 
modem connection has been established.

Direct 
connecti
on

A type of account used for accessing the Internet through a hard-
wired connection between the computer and the Internet. With this 
type of connection, the computer has an IP address and can be a 
Web server.

 DNS Short for Domain Name System. When you use an Internet program 
and enter a domain name rather than an Internet Protocol (IP) 
address, the Internet program automatically uses DNS.    DNS 
translates the supplied domain name into the IP address. The duration 
of this DNS translation impacts the time needed to begin a connection 
to a remote server. Other factors can also extend this pre-connection 
process.

DNS 
server

The Domain Name System (DNS) server is a computer on the 
Intranet or ISP, which implements the DNS protocol. One of the main 
functions of the DNS server is to translate the hostnames of network 
nodes of a domain it is responsible for into IP addresses. (A domain is 
a part of a network whose nodes are under some common control.) 

The primary DNS server is the first DNS server that a host contacts 
for the translation of the hostname into an IP address. If the primary 
DNS server fails, the secondary DNS server handles the 
responsibility. If the secondary DNS server fails, Net.Medic supplies a 
backup DNS server.

Domain A part of a network whose nodes are under some common control.

E
Egress 
router

Another name for an exit (last) router in a group of Intranet, ISP, or 
Internet backbone routers along your Web path. For more information, 
refer to the definition of Exit router in this glossary.

E-mail Electronic mail that is sent and received over a network.

End-to-
end 
connecti
on

The connection between your computer and the remote Web server. 
For example, an end-to-end connection would be the connection 
between Client A (a PC in San Jose) and Server B (a remote Web 
server in Tokyo). Net.Medic monitors the health of your end-to-end 
connections. 

Entry 
router

The first router in a group of Intranet, ISP, or Internet backbone 
routers along your Web path. For example, the ISP entry router is the 
router used to connect your PC to your ISP. Such a router is a 
component of your Web path and is monitored by Net.Medic. If 
Net.Medic detects any problems with this router, it reports the problem 



in its health log. Entry routers are also referred to as ingress routers.

Exit 
router

The last router in a group of Intranet, ISP, or Internet backbone 
routers along your Web path. For example, the last router in the group 
of ISP routers is called the ISP exit router. The ISP exit router is 
usually the router prior to the ISP feeding into the Internet backbone. 
Such a router is a component of your Web path and is monitored by 
Net.Medic. If Net.Medic detects any problems with this router, it 
reports the problem in its health log. Exit routers are also referred to 
as egress routers.

F

Firewall Large networks typically have firewalls at different entry points to 
block access to unauthorized users. A proxy server is a computer that 
is used to access the Internet around a firewall.

Frame 
(Data 
packet)

A packet used to transmit user data over a network.

G

Gateway Networking hardware that allows messages to be transferred between 
two different types of networks.    For example, you need a gateway to 
communicate between a Macintosh AppleTalk network and a UNIX-
based network. Routers are examples of a gateway.

H

Health 
log

A Net.Medic log that records significant problems encountered during 
your online sessions as monitored by the Net.Medic software. The log 
explains what the problem is in plain language.

History 
reports

The Net.Medic reports that track and rate the performance of your ISP 
and the Web sites visited. 

Host 
compute
r

Typically, individuals access the Internet by using a modem to connect 
to a host computer. Host computers are large systems that have their 
own Internet address. For example, to access the Internet from your 
home computer you can use a modem to dial a phone number that 
connects you to one of your Internet Service Provider’s host 
computers. Host computers are also referred to as hosts.

Hostnam
e

Name assigned to each machine on the Internet. A hostname is 
similar to an Internet Protocol (IP) address in that it is a unique 
identifier. Each hostname consists of a machine name, a subnet 
name, a domain name, and a top-level domain name (for example, 
well.sj.ca.us). Typically, hostnames are given in full format (for 
instance, mypc.mydomain.com). This full format is referred to as a 
Fully Qualified Domain Name (FQDN). Hostnames, however, can be 
specified relative to a subnet or domain.

Hop 
counts

The term used to describe the passage of a data packet (frame) 
between two network nodes such as routers. For example, if your 
computer must traverse ten routers to connect to a remote server, that 
connection requires ten hops. 

The Net.Medic Activity pane shows how many router hops your 
current Internet connection involves. Each router in the Web path 
(each Intranet router, ISP router, or Internet backbone router) involved 
in the Web path is represented as router hop icons (colored dots) in 
the Activity pane. If there are ten router hop icons your computer must 
traverse ten routers to get to the remote Web server.



Hot 
spots

Even when you are not transferring Web pages, Net.Medic is 
continually monitoring your Web path. Net.Medic uses colors to allow 
you to quickly identify potential points in your path that might be a 
bottleneck. For instance, the following Activity pane indicates there is 
a serious problem with your modem. 

By simply double-clicking on a yellow or red icon in a Net.Medic pane 
or inlay, you can drill down to detailed performance information that 
tells you exactly what is occurring. These potential problem points are 
also called hot spots.

 HTML HyperText Markup Language. A formatting language used for 
documents on the Web. HTML files are plain text files with formatting 
codes that tell browsers how to display text, position graphics, and 
display links to other pages.

HTTP HyperText Transfer Protocol. Method used to exchange information 
between HTTP servers and clients.

HTTPD HyperText Transfer Protocol Daemon. A program that serves 
information using the HyperText Transfer Protocol (HTTP).

HTTP 
proxy

A single computer is capable of running multiple servers. Each server 
connection is identified by a port number. A HTTP proxy server, liken 
an HTTP server, occupies a port on the computer. 

HTTP 
server

A server that stores hypertext documents and sends them to such 
HyperText Transfer Protocol (HTTP) clients as an Internet browser.    A 
Web server is an example of an HTTP server.

Hunt 
group

Trunk hunting is a method used to switch incoming calls to the next 
consecutive or available number in a hunt group. If the first number 
called is busy or unavailable, the call is automatically switched to the 
next number in the hunt group.

Hyperlin
k (link)

A path that connects one part of a Web document to another part of 
the same document or to separate document or location on the World 
Wide Web. 

Hypertex
t

A set of text files that contains individual words that link one file to the 
next. The World Wide Web consists of hypertext documents.

I

Ingress 
router

The first router in a group of Intranet, ISP, or Internet backbone 
routers along your Web path. For example, the ISP ingress router is 
the router used to connect your PC to your ISP. Such a router is a 
component of your Web path and is monitored by Net.Medic. If 
Net.Medic detects any problems with this router, it reports the 
problem in its health log. Ingress routers are also referred to as entry 
routers.

Inlay An image from a companion application that is inlaid into another 
application's window. For example, because Net.Medic is a browser 
companion application, your browser window displays a Net.Medic 
inlay in its upper-right corner. By having this inlay in your browser, 
you can easily monitor the health of your current online session from 
your browser.

Internet A world-wide network of different types of computers that are linked 



together. No particular organization has jurisdiction over it.

Internet 
ailments

Include bottlenecks and other common Internet problems, such as 
being unexpectedly disconnected from your Internet Service 
Provider (ISP).

Internet 
backbone

The connections between the primary computers in the Internet.

Internet 
Explorer

Microsoft’s Internet browser that acts as a graphical interface to the 
World Wide Web. For example, you can use Internet Explorer to 
retrieve Web documents, to download files, to participate in 
newsgroups, and to send and receive E-mail. Net.Medic is a 
companion application to such browsers as Internet Explorer.

Internet 
pane

The Net.Medic pane that indicates how the Internet portion of your 
Web path is performing.

To open this pane in the Net.Medic dashboard, click any of the 

Internet router hop icons  in the Activity pane or pull down the 
View menu and choose Internet from the Details submenu.

Internet 
routers

The group of Internet backbone routers used to connect your 
desktop computer to the remote Web server. The first router in the 
group, which demarcs the start of the Internet backbone, is the 
Internet entry router. The last router in this group, which demarcs the 
end of the Internet backbone, is called the Internet exit or egress 
router. These routers are also called Internet backbone routers.

 

Intranet A company-wide network of different types of computers linked 
together.

Intranet 
routers

The group of Intranet routers used to connect your desktop computer 
to the ISP portion of the path. The first router in the group. which 
demarcs the start of the Intranet, is the Intranet entry router. The last 
router in this group, which demarcs the end of the Intranet,    is called 
Intranet exit or egress router. The Intranet routers are the first group 
of routers, followed by the ISP routers, and Internet backbone 
routers.

IP Short for Internet Protocol.    A networking protocol, which resides on 
both hosts and routers. It is responsible for relaying data from the 
source host to the destination host.

IP 
address

An Internet Protocol (IP) address for an Internet machine. It is a 
unique identification for each machine on the Internet. The address 
consists of four groups of numbers that are separated by dots. Each 
group of numbers is an 8-bit octet that can range from 0 to 255. (An 
octet is a byte that consists of 8 bits). The entire IP address is a 32-
bit value.

ISP Short for Internet Service Provider. A company or organization that 
provides Internet services to its customers.



ISP dial-in 
phone 
number

The phone number that you dial from your desktop computer to 
connect to your Internet Service Provider (ISP). 

ISP 
egress 
router

The ISP router that connects to the Internet backbone. The 
Net.Medic Activity pane uses green, yellow, and red to indicate the 
current state of this router. If problems are encountered with this 
router, you can obtain more information on the problem by displaying 
the Net.Medic health log.

ISP entry 
router

The Internet Service Provider’s router that your local router contacts 
to connect to your ISP. Such a router is a component of your Web 
path and is monitored by Net.Medic. If Net.Medic detects any 
problems with this router, it reports the problem in its health log.

ISP pane The Net.Medic pane that is an index of your Internet Service 
Provider’s (ISP) current overall health from your unique perspective. 
It also provides performance information about your ISP based upon 
a periodic sampling.

When you’re connected, the name of your Internet Service Provider 
(ISP) appears in the upper-left corner of this pane. To open this pane 

in the Net.Medic dashboard, click any ISP router hop icon  in the 
Activity pane or pull down the View menu and choose ISP from the 
Details submenu.

ISP 
routers

The group of ISP routers used to connect your desktop computer to 
the Internet backbone. The first router in this group, which demarcs 
the start of the ISP portion of a path, is called the ISP entry router. 
The last router in this group is called the ISP exit or egress router. 
For example, the ISP router that your local router contacts to 
connect to your ISP is called the ISP entry router.

By double-clicking on a yellow or red icon for a router, you can open 
the Net.Medic health log with the matching entry highlighted.

J

Java An Internet programming language developed by Sun Microsystems. 
Java has been integrated with many of the popular Internet browsers, 
such as Netscape Navigator and Internet Explorer. 

Java 
applet

A Java program is a small program that is executed when loading    a 
Web page into a browser window. Java applets are used to add video 
and sound to Web pages. 

K

kilobit

(kbps)

kbps is kilobits per second. A kilobit is one thousand bits, or units of 
information. There are eight bits in a byte. Computer memory is 
usually measured in kilobytes or megabytes while data transmission is 
typically measured in kilobits per second or megabits per second (one 
million bits per second). For example, if you are transferring data over 
the network at a rate of 22.1 kbps, then the data is being transferred 
at a rate of 21,100 bits per second. 

L

LAN Short for local area network. A network that consists of a set of 
devices that are connected for communication purposes. A LAN can 
connect to a larger network (for example, the Internet.)

Link Short for hyperlink. A path that connects one part of a Web document 



to another part of the same document or to a separate document or 
location on the World Wide Web. For example, you click on links 
within the Net.Medic Help System to go to other help topics.

Local 
router

The router your modem goes through to connect to your ISP. 
Net.Medic uses green, yellow, and red to indicate the current health of 
this router within its Activity pane. If problems are encountered with 
this router, you can obtain more information on the problem by 
displaying the Net.Medic health log.

M

Microsoft 
Internet 
Explorer

Microsoft’s Web browser that acts as a graphical interface to the 
World Wide Web. For example, you can use Internet Explorer to 
retrieve Web documents, to download files, to participate in 
newsgroups, and to send and receive E-mail. VitalSigns Net.Medic is 
a companion application of such browsers as Microsoft Internet 
Explorer.

Modem The internal or external device that allows your desktop computer to    
make telephone calls to other computers.

Modem 
Connect 
Time 
pane

The Net.Medic pane that displays your modem connection time by 
current session, day, and month. Total time is shown in hours and 
minutes. 

To display this pane in the Net.Medic dashboard, click  in the 
Net.Medic toolbar.

Modem 
pane

The Net.Medic pane that indicates your modem’s performance and 
overall health.

To display this pane in the Net.Medic dashboard, click the modem 

icon  in the Activity pane.

N

Navigator Netscape’s Web browser that acts as a graphical interface to the 
World Wide Web. For example, you can use Netscape Navigator to 
retrieve Web documents, to download files, to participate in 
newsgroups, and to send and receive E-mail. VitalSigns Net.Medic is 
a companion application to such browsers as Netscape Navigator.

Net.Medic 
Activity 
pane

The Net.Medic pane Indicates overall performance. Reports the 
status of your current Web path (for example, “Transferring data...”). 
Color is used to indicate the current health of the Web path 
components. Gray, yellow, and red respectively indicate good, 
moderate, or poor health of each Web path component.

It tells you how many router hops your current Internet connection 
involves. Each router icon is a router hop. Net.Medic counts the 
number of router hops (Intranet routers, ISP routers, and Internet 
backbone routers) involved in your current Web path. For example, if 
your computer must traverse ten routers to connect to a remote 
server, that Web path involves ten router hops.

Net.Medic 
Client 
pane

Indicates your desktop computer’s performance and overall health.

Displays the name of your computer (for example, “My Computer”) in 



its upper left corner. 

Net.Medic 
health log

A log that records significant problems encountered during your 
online sessions as monitored by the Net.Medic software. The log 
explains what the problem is in plain language.

To display this log, click  in your Net.Medic toolbar or choose 
Health Log from the Net.Medic Window menu.

Net.Medic 
history 
reports

The Net.Medic reports that track and rate the performance of your 
ISP, your modem, and    the Web sites you’ve visited over the past 
month. 

Net.Medic 
icon The Net.Medic icon  appears in the system tray area of your 

Windows task bar when Net.Medic is running. Note that the color of 
the Net.Medic icon changes colors to indicate your overall health of 
your current online session.    Green indicates good health. Yellow 
and red indicate moderate to poor health.

Net.Medic 
inlay

A Net.Medic pane that is inlaid into the upper-right corner of your 
browser window. By having this inlay in your browser, you can easily 
monitor the health of your current online session from your browser.

Net.Medic 
Internet 
pane

Indicates how the Internet portion of your Web path is performing.

To open and close this pane, click on one of the Internet router hop 
icons in the Activity pane.

Net.Medic 
ISP pane

An index of your Internet Service Provider’s (ISP) current overall 
health from your unique perspective.    It also provides performance 
information about your ISP based upon a periodic sampling.

To open and close this pane, click on one of the ISP router hop icons 
in the Activity pane or pull down the View menu and choose ISP from 
the Details submenu.

Net.Medic 
menu bar

Bar near the top of the Net.Medic dashboard that consists of a set of 
pull-down menus. To pull down a menu, click on it in the menu bar.

Net.Medic 
modem 
call log

The Net.Medic log that tracks modem calls. The log provides 
information about your modem’s success rate, the bandwidth it 
achieved for each call, its average connection rate, and the 
percentage of busy signals it encountered. This vital data can help 
you decide whether to upgrade to a faster modem. You can use this 
log to audit your monthly usage and fees as well as the level of 
service provided by your ISP. 

Net.Medic 
Modem 
Connect 

Displays your modem connection time for the current session, day, 
and month. Total time is shown in hours and minutes.



Time pane

This pane is automatically displayed in    the Net.Medic dashboard 
when you open the dashboard.

Net.Medic 
Modem 
pane

Indicates your modem’s performance and overall health.

To display this pane in the Net.Medic dashboard, click  in the 
Activity pane.

Net.Medic 
Retrieval 
pane

Indicates how effectively you are transferring data over the network.

To display this pane in the Net.Medic dashboard, click     in the 
Net.Medic toolbar.

Net.Medic 
Server 
pane

The Net.Medic pane that provides an estimate of the health or 
performance of the Web server.

 

To display this pane in the Net.Medic dashboard, click     in the 
Activity pane.

Net.Medic 
Session 
Connect 
Time pane

Displays your session connection time for the current session, day, 
and month. Total time is shown in hours and minutes. To display this 
pane, right-click on the Modem Connect pane and choose Session 
Connect Time from the pop-up menu.

Net.Medic 
system 
tray icon

When the Net.Medic program is running, the Net.Medic icon  
appears in the system tray area of your taskbar. Note that the 
Net.Medic icon changes colors to indicate the overall health of your 
current online connection. Gray, yellow, and red respectively indicate 
good, moderate or poor health.

Net.Medic 
ticker tape

A    tape that displays streams of messages. The Net.Medic 
dashboard has a ticker tape that reports information such as the 
name of the Web site you’re connected to along with the number of 
times you’ve visited the site.

Net.Medic 
title bar

Bar at the top of the Net.Medic dashboard.

Net.Medic 
Throughp
ut pane

Indicates how fast you are currently transferring data over the 
network. Transfer speed is shown in kilobits per second (kbps). A 
kilobyte is 1024 bytes. For example, if you are receiving a Web page 
across the network at a rate of 54.0 kbps, the Web page is being 
transferred at a rate of 54,000 bits per second (bps).

To display this pane in the Net.Medic dashboard, click  in the 
Net.Medic toolbar.

Net.Medic Row of icons at the top of the Net.Medic dashboard. Click an icon to 



toolbar perform certain tasks such as opening and closing panes in the 
dashboard or displaying Net.Medic logs and reports.

Netscape 
Navigator

Netscape’s Web browser that acts as a graphical interface to the 
World Wide Web. For example, you can use Netscape Navigator to 
retrieve Web documents, to download files, to participate in 
newsgroups, and to send and receive E-mail. VitalSigns Net.Medic is 
a companion application to such browsers as Netscape Navigator.

Node An end point of a network connection or a junction that is common to 
two or more lines in a network. Nodes can be interconnected by links 
and act as control points in the network. Processors, controllers, 
bridges, routers, and workstations are all examples of network 
nodes.

O

P

Packet An electronic envelop that is used to transmit user data over a 
network. This is also referred to as a frame.

Primary 
DNS 
server

The Domain Name System (DNS) server is a computer on the 
Intranet or ISP, which implements the DNS protocol. One of the main 
functions of the DNS server is to translate the hostnames of network 
nodes of a domain it is responsible for into IP addresses. (A domain is 
a part of a network whose nodes are under some common control.) 

The primary DNS server is the first DNS server that a host contacts 
for the translation of the hostname into an IP address. If the primary 
DNS server fails, the secondary DNS server handles the 
responsibility. If the secondary DNS server fails, Net.Medic supplies a 
backup DNS server.

Proxy 
server

A computer that is used to access the Internet around a firewall. 
(Networks have firewalls at different entry points to block access to 
unauthorized users.)

Q

R

Respons
e time

The amount of time to respond to a request. Net.Medic measures the 
response time of your ISP, the Internet, and the Web server in your 
Web path. The Net.Medic Service Provider Report shows the ISP’s 
response time over the past month. The Net.Medic Frequently Visited 
Sites Report shows the response time of the ten sites you’ve visited 
the most often the past month. The Slowest Sites Report reflects the 
response time of the slowest five sites you’ve visited over the past 
month.

Retrieval 
pane

The Net.Medic pane that indicates how effectively you are transferring 
data over the network.

Retrieval 
rate

The average speed of the network during the transfer of a Web page. 
The Net.Medic Retrieval pane digitally reports this average speed in 
kilobits per second (kbps). 

Retrieval 
time

The amount of time it takes to retrieve a Web page from a remote 
server. The Net.Medic Retrieval pane digitally displays this retrieval 



time in hours, minutes, and seconds.

Router An internetworking device that is used to connect different networks, 
or two network segments in a local area network (LAN).

S

Seconda
ry DNS 
server

The Domain Name System (DNS) server is a computer on the 
Intranet or ISP, which implements the DNS protocol. One of the main 
functions of the DNS server is to translate the hostnames of network 
nodes of a domain it is responsible for into IP addresses. (A domain is 
a part of a network whose nodes are under some common control.) 

The primary DNS server is the first DNS server that a host contacts 
for the translation of the hostname into an IP address. If the primary 
DNS server fails, the secondary DNS server handles the 
responsibility. If the secondary DNS server fails, Net.Medic supplies a 
backup DNS server.

Server The computer that handles the primary data delivery tasks for its 
clients. To initially view a Web page, the server that stores the page 
must deliver it to your browser. After the page is retrieved, you can 
use your browser to view it on your computer (the client portion of the 
client/server pair). Web servers are called Web sites or remote Web 
servers.

Server 
pane

The Net.Medic pane that provides an estimate of the health or 
performance of the Web server.

.

To display this pane in the Net.Medic dashboard, click     in the 
Activity pane.

Session 
Connect 
Time 
pane

The Net.Medic pane that displays your session connection time by 
current session, day, and month. Total time is shown in hours and 

minutes. To display this pane, click  in the Net.Medic toolbar, right-
click on the Connect Time pane and choose Session Time from the 
pop-up menu.

SMTP Short for Simple Mail Transfer Protocol. The E-mail protocol most 
commonly used by the Internet. It is implemented by the mail server 
SMTP channel. You can use the Net.Medic Preferences window to 
specify the E-mail protocol Net.Medic should use when sending E-
mails. To display the Preferences window choose Preferences from 
the Net.Medic View menu.

Snappin
g panes

The process of displaying a Net.Medic pane within your browser is 
called “snapping a pane” on your browser. To snap a pane, right-click 
on the dashboard pane and choose Snap on Browser. The Net.Medic 
pane opens as an inlay in your browser.

Subnet A subnet is a portion of an IP network that shares the same subnet 
address. Subnets are arbitrarily created by a system administrator to 
provide a multilevel, hierarchical routing structure. Such hierarchical 
structures shield the subnet from the addressing complexity of 
networks that are attached to the subnet.

Subnet 
mask

A 32-bit address mask used by the Internet Protocol (IP) to calculate a 
particular subnet.

System 
tray

The lower-right corner on your desktop. The Net.Medic icon    
automatically appears in this tray to indicate Net.Medic is currently 
running. Note that the color of the Net.Medic icon changes colors to 
indicate your current overall health. Gray indicates good health. 
Yellow and red indicate moderate to poor health.



T

TCP Short for Transmission Control Protocol.    Networking protocol that 
resides on host computers and assures reliable data delivery.

TCP/IP Transmission Control Protocol/Internet Protocol. The main network 
protocol for the Internet and Intranet (company) networks.

Through
put

The total traffic between network stations (your desktop PC and a 
remote Web server) per unit of time. Net.Medic tracks the throughput 
of the server involved in the Web path. It reports how fast the Web 
server transfers the Web page to your desktop computer. The server’s 
transfer rate is measured in kilobytes.

Through
put pane

The Net.Medic pane that Indicates how fast you are currently 
transferring data over the network. The transfer rate is measured in 
kilobits (kbps). A kilobit is one thousand bits, or units of information. 
There are eight bits in a byte. Computer memory is usually measured 
in kilobytes or megabytes while data transmission is typically 
measured in kilobits per second or megabits per seconds (a million 
bits per second).

For example, if you are receiving a Web page the network at a rate of 
54.0 kbps, the Web page is being transferred at a rate of 54,000 bits 
per second (bps).

 

To display this pane in the Net.Medic dashboard, click  in the 
Net.Medic toolbar.

Ticker 
tape

A    tape that displays streams of messages. Net.Medic has a ticker 
tape on its dashboard that reports such information as the name of 
the Web site you’re connected to along with the number of times 
you’ve visited the site.

Title bar Bar at the top of the Net.Medic dashboard that you use to close the 
Net.Medic dashboard (main window).

Toolbar The row of buttons at the top of the Net.Medic dashboard that you use 
to perform such tasks as opening the Net.Medic health log.

U

URL Uniform Resource Locators. The address that identifies a page on the 
Web. An URL consists of the following four parts: the service (for 
example, http or ftp), the host computer, the port number, and the full 
path name of the Web page (for example, http://www.vitalsigns.com). 

You can also click  in the dashboard to view the VitalSigns home 
page in your browser window.

V

Virtual 
memory

The Windows operating system uses a portion of your hard drive to 
simulate Random Access Memory (RAM). Through the use of virtual 
memory,    your computer acts as if it has more RAM than it actually 
does. This allows your computer to run more programs than it could 
otherwise.



VitalSign
s

Company that manufactures the Net.Medic product.

W

Web Short for World Wide Web. 

Web 
browser

A program that provides a user interface to the Web. Netscape 
Navigator and Microsoft Internet Explorer are two examples of 
graphical Web browsers.

Webmas
ter

The individual at a Web site who administers all the Web resources at 
that site.

Web 
page

A document you can read with a Web browser. Such pages can vary 
in complexity from a simple text page to pages containing hypermedia 
(video and sound) 

Web 
path

The connection between your computer and the remote server. For 
example, a Web path would be the connection between a PC in San 
Jose) and a remote Web server in Tokyo. Net.Medic monitors the 
health of your Web paths.

Web 
server

A computer equipped to provide Web services to client computers that 
access it. Web pages are stored on such servers. Web servers are 
also called Web sites.

Web site Another name for a Web server.

World 
Wide 
Web

A collection of hypertext- and hypermedia-linked documents that are 
accessible through the Internet. You access Web documents through 
a Web browser.

X

Y 

Z 



Activity pane

Use the Net.Medic Activity pane to animate your online connections and to determine your overall performance. 
Colored dots are used to represent the health of the various components in your Web path. This pane also reports 
the status of your current online activity (for example, “Transferring data”), the animation of Web pages being 

retrieved, and the number of hops in your path. Each dot  represents a router hop. For example, if your computer 
traversed ten routers to connect to a remote server, that Web path involves ten router hops.



Balloon help

Balloon help is available for certain objects in the Net.Medic dashboard. Move your pointer over an object. If balloon 
help is available, a magnifying glass appears and Net.Medic displays a brief description of the object. For example, 
move the pointer over one of the groups of router hop icons. As the following figures show, Net.Medic displays a 
brief description of the router hop group. 



Backup DNS server

The Domain Name System (DNS) server is a computer that acts as the server for a domain. (A domain is a part of a 
network in which the data processing resources are under common control. Each domain in a network is managed 
by a domain name server.) One of the main functions of the Domain Name Server is to convert the host names of 
network nodes to IP addresses. 

If the primary DNS server fails, the secondary DNS server handles the responsibility. If the secondary DNS server 
fails, Net.Medic supplies a backup DNS server, which is a fail-safe server at the core of the Internet. Although use of 
this backup server ensures connection to the Internet, it may not be the most direct route. Therefore, you should 
routinely use your ISP DNS servers to ensure you’re using the most direct route.



Bandwidth

The maximum transmission speed of a Web path or connection that is usually measured in kilobits per second 
(kbps) or megabits per second (Mbps). More bandwidth indicates that more data can be transmitted per second. 
Capacity is sometimes used to refer to bandwidth.



Bank of health lights in the Client dashboard pane

The overall health of the client (your computer) is signified by the bank of health lights in the Client dashboard pane. 
Green, yellow, and red respectively indicate good, moderate, or poor health.

Note

The color of this bank of health lights corresponds to the color of the  client icon (your desktop computer) in the 
Activity pane.



Browser

A program used to explore the World Wide Web (Web). Netscape Navigator and Microsoft Internet Explorer are 
examples of browsers. Net.Medic is a browser companion.



Browser companion

Net.Medic works with most 32-bit Windows 95 communication programs. Examples of such programs include 
Netscape Navigator, Microsoft Internet Explorer, and Netscape Communicator. Because Net.Medic works so closely 
with your browser, you can run Net.Medic as an inlay in the browser. This allows you to conserve desktop space 
and to work in a single window as you “surf the Web.”



Cache

The portion of your computer’s RAM used to locally store a copy of the data you retrieve from the network.    By 
caching the data (Web pages), your computer avoids having to make duplicate retrievals from a remote server 
during a current online session. By preloading such pages, it speeds up how quickly you can reload the Web page.



Cache hits

To save time, certain information that you retrieve from the network is automatically saved on your computer for 
later retrieval. When your computer retrieves the stored information from its cache (disk) the retrieval is called a 
cache hit. Net.Medic displays the percent of retrievals during a current Internet session that are retrieved from your 
computer's cache versus the network. This number is displayed in the Cache Hits meter. High numbers in this meter 
indicate good cache management.



CIO

Short for Chief Information Officer.



Client

A smaller computer that connects to other larger, more powerful computers functioning as servers. Your browser is 
an example of a client/server system. The client program running on your desktop takes advantage of the more 
powerful server at a remote site. Net.Medic tracks the performance of your desktop computer (for example, Client A 
that is a PC in San Jose). Desktop computers are also referred to as clients.



Client pane

Indicates the performance and overall health of the client (your desktop computer).

Bank of health lights. An indication of the overall health of your computer. The color indicates good, moderate, or 
poor health. For example, yellow indicates a moderate to serious problem with your computer. To obtain more 
information about PC-related problems, check the Net.Medic health log by double-clicking on this pane’s yellow or 

red health light, or on the yellow or red PC icon  in the Activity pane.

CPU Load gauge. Reports what percent of your computer’s central processing unit (CPU) is currently utilized. The 
CPU load is sometimes referred to as the system load. The more occupied it is, the slower your browser may work. 
Spiking (occasional high percentages) in this gauge is normal. However, a continually high reading on the gauge 
indicates a sustained heavy CPU load, which could signify an overtaxed computer. Windows 95 will often run at 
100% if you have multiple applications open.

Cache Hits meter. Reports the percent of Web pages this session retrieved from local disk cache (cache hits) 
rather than retrieving them from the remote Web site. The local cache, or Web page storage, keeps pages from 
Web sites you have previously visited, and stores them on your local hard drive. Once these pages are stored on 
your hard drive, they can be quickly retrieved from your computer the next time you visit that Web site. It is faster to 
“download” from your local drive than from the remote Web site. High numbers in this meter indicate good cache 
management and thus good browsing performance.



Colored dots

Net.Medic uses colored dots to indicate the current health of the router hops involved in your current Web path. 
Gray indicates a healthy state. Yellow and red respectively indicate moderate to poor health.

n To display more information about an unhealthy hop (router), click once on its icon in the Activity pane. The 
corresponding pane opens in the Net.Medic dashboard. For example, in the preceding figure the group of 
Internet backbone routers are experiencing problems. Click once on any of the router icons to open the Internet 
dashboard.

n To drill down into the cause of the problem, double-click on one of these yellow router icons. The health log will 
open with the matching entry automatically highlighted. By double-clicking on the health log entry, Net.Medic 
displays a diagnosis and prescription for the problem whenever possible.



Components of a Web path

The components of a Web path include:

n Your computer (the client)

n Your modem

n Your Internet Service Provider (ISP)

n Network (Internet backbone) portion of the connection

n Remote Web server 



Connect Time pane

Use the Net.Medic Session Time/Connect Time pane for the following purposes: (1) to track your modem 
connection time if you’re connected via a modem, or (2) to track your browser activity time. Total time is shown in 
hours and minutes. Note that the session time is reported for both modem and LAN connections; whereas, the 
modem connect time is only reported with modem connections. You can switch between these two views (Modem 
Connect Time and Session Connect Time) by right-clicking on this Net.Medic pane and choosing Session Time or 
Modem Connect Time from the pop-up menu.

Session digital display. Time on current session.

Today digital display. Time on all sessions today.

This Month digital display. Time on all sessions this month.

Note

n The session connect time stops incrementing when the browser is idle for more than 3 minutes.

n Note that ISPs vary in their billing policies and can also periodically change them. For example, various ISPs 
use different methods to round up the billable hours while others bill in minimum time increments. Net.Medic 
does not account for such variables. Consequently, although the Net.Medic Connect Time dashboard pane 
reflects your online time over the past month, the reported time may not reflect your final ISP bill because of 
these variables.



CPU load

The Central Processing Unit (CPU) is the hardware that processes instructions for the computer. Different types of 
CPUs have various levels of processing power. The CPU's processing power that is currently being used in your 
computer is called the CPU load. Net.Medic reports your CPU load percentage in its dashboard. A continually high 
percentage, for example, could indicate your current CPU is being overtaxed. A possible solution would be to 
upgrade your computer to a more powerful CPU.



Current load

The current load is a percentile that reflects the server’s current load relative to its past load (its load when you have 
visited the Web server in the past).



Current traffic congestion levels

The current traffic congestion level is a percentile that reflects the traffic congestion on the Intranet, ISP, or Internet 
relative to the past traffic congestion on the Intranet, ISP, or Internet (its traffic congestion in your past experiences).



Net.Medic dashboard 



Diagnosis window

Net.Medic displays its diagnosis and prescription for a problem in its Diagnosis window. To obtain a diagnosis and 
prescription for a problem, double-click on the health log entry, or click once on the entry and then click Diagnosis. 

The Diagnosis window opens. If Net.Medic can cure the problem, it tells you to click AutoCure. In the following 
example, Net.Medic fixes the problem by increasing the baud rate of your serial port. If the cure had been to notify 
your ISP, you could have Net.Medic generate an E-mail describing the problem to your ISP by clicking Notify. After 
formatting the text for the E-mail, Net.Medic asks if you want to send it. Unless you tell Net.Medic to send the E-mail 
message, it will not be sent. Note that the E-mail notification feature is only available with the retail version of 
Net.Medic.

Note 

If you keep the Diagnosis window open, you can continue to display a diagnosis and prescription for various entries 
in the health log by clicking once on another log entry. The contents of the Diagnosis window are updated to reflect 
the diagnosis and prescription for the currently selected entry.



Dial-in string

Phone number used to dial into your Internet Service Provider (ISP) from your desktop computer. It is also called a 
dial-in phone number.



Domain

A part of a network in which the data processing resources are under common control. Each domain in a network is 
managed by a domain name server.



Domain Name Service (DNS)

When you use an Internet program and enter a domain name rather than an Internet Protocol (IP) address, the 
Internet program automatically uses the Domain Name Service (DNS).    DNS translates the supplied domain name 
into the IP address. The duration of this DNS translation impacts the time needed to begin a connection to a remote 
server. Other factors can also extend this pre-connection process.



Domain Name Server

The Domain Name System (DNS) server is a computer that acts as the server for a domain. (A domain is a part of a 
network in which the data processing resources are under common control. Each domain in a network is managed 
by a domain name server.) One of the main functions of the DNS server is to convert the host names of network 
nodes to IP addresses. If the primary DNS server fails, the secondary DNS server handles the responsibility. If the 
secondary DNS server fails, Net.Medic supplies a backup DNS server.



Domain Name System

A system used by machines on a network to convert names of network nodes into their corresponding Internet 
numbers (addresses). Typically, machines obtain this translated information from a DNS server, or they look it up in 
tables maintained on their systems. If your computer has been configured with the wrong DNS address, it is unable 
to convert the Internet names to IP addresses. This, in turn, prevents you from being able to use your browser to 
locate the server. 



The connection between your computer and the remote Web server. For example, an end-to-end connection would 
be the connection between Client A (a PC in San Jose) and Server B (a remote server in Tokyo). Net.Medic 
monitors the health of your end-to-end connections. The term Web path is used to refer to such connections 
throughout this help system.



Egress (exit) router

The last router in a group of Intranet, ISP, or Internet backbone router hops along your Web path. Such routers are 
components of your Web path and are monitored by Net.Medic. To display balloon help for a router, move the 
pointer over its icon in the Activity pane.

If Net.Medic detects any problems with these routers, it reports the problem in its health log. To display information 
about a router hop, double-click on its yellow or red icon in the Activity pane. To open the corresponding dashboard 
pane, click once on any of the router hop icons in the Activity pane or pull down the View menu and choose the 
appropriate option from the Details submenu. For example, to open the Internet pane choose Internet from the 
Details submenu.



Entry router

The first router in a group of Intranet, ISP, or Internet backbone routers (hops) along your Web path. Such    routers 
are components of your Web path and are monitored by Net.Medic. If Net.Medic detects any problems with these 
routers (hops), it reports the problem in its health log. To display balloon help for a group of router hops, move your 

pointer over any of its router hop icons  in the Activity pane.

To display more information about a router hop, double-click on its yellow or red icon in the Activity pane. To open the 
corresponding dashboard pane, click once on any of its router hop icons in the Activity pane or pull down the View 
menu and choose the appropriate option from the Details submenu. For example, to open the ISP pane choose ISP 
from the Details submenu.



Firewall

Large networks typically have firewalls at different entry points to block access to unauthorized users. A proxy 
server is a computer that is used to access the Internet around a firewall.



Gateway

Networking hardware that allows messages to be transferred between two different types of networks.    For 
example, you need a gateway to communicate between a Macintosh AppleTalk network and a UNIX-based network. 



The Health Summary Report rates the overall health of your online sessions for the past month. The report provides 
a distribution of problems along with the top five causes of the problems. The report can help you pinpoint problems 
that persistently cause a bottleneck in your online connections.

To display this report

In the Net.Medic menu bar, pull down the Window menu, choose 
History Reports then drag right and choose Health Summary 
Report.

In the Net.Medic toolbar, click , pull down the Reports menu in 
the displayed History Reports window and choose Health 
Summary Report.



Hop

The term used to describe the passage of a data packet (frame) between two network nodes such as routers. 
Net.Medic tracks the number of router hops your current Internet connection involves. Each router hop in the Web 
path (each Intranet router, ISP router, or an Internet backbone router) is shown as a router hop icon (a gray, yellow, 
or red dot) in the Activity pane. For example, if your computer must traverse ten routers to connect to a remote 
server, that connection requires ten router hops. 

To check which portion of the path a router hop is part of, move your pointer over its icon. Net.Medic’s balloon help 
displays a brief description of the router hop group.



Host

Typically, individuals access the Internet by using a modem to connect to a host. Hosts are large computers that 
have their own Internet address. For example, to access the Internet from your home computer, you can use a 
modem to dial a phone number that connects you to one of your Internet Service Provider’s host computers. Hosts 
are also referred to as host computers.



Hostname

Name assigned to each machine on the Internet. A hostname is similar to an Internet Protocol (IP) address because 
it is a unique identifier. Each hostname consists of a machine name, a subnet name, a domain name, and a top-
level domain name (for example, well.sj.ca.us). Typically, hostnames are given in full format (for instance, 
mypc.mydomain.com). This full format is referred to as a Fully Qualified Domain Name (FQDN). Hostnames, 
however, can be specified relative to a subnet or domain.



Hot spots

Even when you are not transferring Web pages, Net.Medic is continually monitoring your Internet path for you. 
Net.Medic uses colors to allow you to quickly identify potential points in your path that might be a bottleneck. For 
instance, the following Activity pane indicates there is a health problem with your modem. 

By simply double-clicking on a yellow or red icon in a Net.Medic pane or inlay, you can obtain additional information. 
These potential problem points, which you may choose to investigate, are also called hot spots.



HTTP server

A server that stores hypertext documents and sends them to such HyperText Transfer Protocol (HTTP) clients as an 
Internet browser.    A Web server is an example of an HTTP server. Routers are examples of a gateway.



HTTP proxy

A single computer is capable of running multiple servers. Each server connection is identified by a port number. A 
HyperText Transfer Protocol (HTTP) proxy server, like an HTTP server, occupies a port on the computer. 



Hunt group

Trunk hunting is a method used to switch incoming calls to the next consecutive or available number in a hunt 
group. If the first number called is busy or unavailable, the call is automatically switched to the next number in the 
hunt group.



HyperText Transfer Protocol (HTTP)

Method used to exchange information between HTTP servers and clients. Your browser is an example of an HTTP 
client program. A Web server is an example of an HTTP server.



Identify feature

Net.Medic’s Identify feature allows you to quickly obtain identity information about your Intranet, ISP, or remote 
server. This information includes such details as the network address, domain name, name and address of the 
contact. To obtain this information, Net.Medic contacts a well-known server that maintains a database of all the 
remote servers and network elements. 

To identify any of these objects, right-click on the Intranet, ISP, or Server dashboard pane and choose Identify from 
the pop-up menu. You can also display this information by right-clicking on the component’s icon (for example, the 
server icon) in the Activity pane and choosing Identify from the pop-up menu.



Inlay

An image from a companion application that is inlaid into another application's window. For example, because 
Net.Medic is a browser companion application, your browser window displays a Net.Medic inlay in its upper-right 
corner. By having this inlay in your browser, you can easily monitor the health of your current online session from 
the browser.



Internet

A world-wide network of different types of computers that are linked together. No particular organization has 
jurisdiction over it.



Internet ailments

Internet ailments include bottlenecks and other common Internet problems, such as being unexpectedly 
disconnected from your Internet Service Provider (ISP).



Internet backbone

The connections between the primary computers in the Internet. An Internet cloud is typically used to depict this 
portion of the network.



Internet backbone routers

The group of Internet backbone routers used to connect your desktop computer (for example, your PC) to the 
remote Web server. The first router in the group, which demarcs the start of the Internet backbone, is the Internet 
entry router. The last router in this group, which demarcs the end of the Internet backbone,    is called the Internet 
exit or egress router. By double-clicking on a yellow or red router hop icon in the Activity pane, you can open the 
Net.Medic health log with the matching entry highlighted.

By clicking once on a router hop icon, you can open the corresponding dashboard pane. For example, the Internet 
pane opens if you click once on any of the Internet router hop icons in the Activity pane. You can also open the 
Intranet, ISP, or Internet panes by pulling down the View menu and respectively choosing Intranet, ISP, or Internet 
from the Details submenu.



Internet egress router

The last router in the Internet router group, which demarcs the end of the Internet backbone, is called the Internet 
exit or egress router. Internet routers are also called Internet backbone routers.



Internet entry router

The first router in the Internet router group. which demarcs the start of the Internet backbone, is the Internet entry 
router, Internet routers are also called Internet backbone routers.



Internet pane

Use the Net.Medic Internet pane to check the performance of the Internet portion of your Web path.

Delay chart. Provides an estimate of the network delay attributable to the Internet backbone. The chart provides a 
histogram of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow 
indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the 
delay caused by the Internet backbone. The delay attributed to the Internet backbone is computed by taking the 
difference of round trip times between reaching the remote Web server and the last ISP router.

Traffic gauge. Provides a relative estimate of the Internet traffic level along your path. Lower percentile numbers in 
this gauge mean lower congestion and vice-versa.

Peak Speed meter. Reports an estimated peak transfer speed as a percent of the speed limit of your online 
connection. The speed limit refers to the number of bits per second (bps) that can be transferred by the thinnest 
pipe (connection) between your computer and the Web server. A low percentage in this meter indicates poor 
utilization of the bandwidth available end to end. Consequently, high values in this meter are desirable and indicate 
the Internet backbone is passing traffic without introducing delays.



Internet router hop icons

The group of Internet backbone routers that are used to connect your desktop computer to the remote Web server. 

Each Internet backbone router that your computer must traverse to connect to the remote Web server is a router 

hop. Each router hop is represented as a  in the Activity pane. To display a brief description of a router hop group, 
move your pointer over one of its icons in the Activity pane.



Internet Service Provider (ISP)

A company or organization that provides Internet services to its customers. 



Intranet

A company-wide network of different types of computers linked together.



Intranet pane

Use the Net.Medic Intranet pane to determine the following: (1) the health of your Intranet from your unique 
perspective, and (2) your Intranet’s performance based upon a periodic sampling. The name of your Intranet 
appears in the upper-left corner of this pane. Note that most modem users are not using an Intranet and therefore 

will not see this pane in their Net.Medic dashboard. 

Delay chart. Provides an estimate of network delay attributed to the Intranet. Blue indicates a reasonable delay. 
Yellow indicates slowness associated with this portion of the network. The taller the line on the Delay chart, the longer 
the delay caused by your Intranet. The delay attributed to the Intranet is computed by taking the difference of round 
trip times between reaching the last (egress) Intranet router and the first (ingress) Intranet router.
Traffic gauge. Provides a relative estimate of the Intranet traffic level in your Web path. Note that this is along your 
path through the network This estimate is computed by taking the delay introduced by the Intranet and comparing 
that against the historical distribution of Intranet delays. The current value is placed in that distribution by computing 
a percentile. In the preceding example, 10% indicates that the current response was in the 10th percentile, which 
means that the current Intranet delay was more than 10% of previously seen delays and was less than 89% of other 
previous delays. Therefore, lower percentile numbers mean lower congestion and vice-versa. The traffic index for 
your performance over the Intranet is baselined over time and will become more accurate over time.

Bank of health lights. Indicates the current overall health of your Intranet services (for example, IP connectivity 
and Domain Name System (DNS). Green, yellow, and red respectively indicate good, moderate, or poor health. 



Intranet pane bank of health lights

The overall health of the Intranet is signified by the bank of health lights in the Intranet pane. Green, yellow, and red 
respectively indicate good, moderate, or poor health.



Intranet router hop icon

The group of routers in your corporate Intranet that are used to connect your desktop computer to your Internet 
Service Provider (ISP). Each Intranet router that your computer must traverse to connect to your ISP is a router hop. 

Each router hop is represented as a  in the Activity pane. Move your pointer over a router hop group to display a 
brief description of it. To identify the Intranet, right-click on one of its router hop icons and choose Identify from the 
pop-up menu.



Intranet routers

The group of Intranet routers used to connect your desktop computer to the ISP portion of the path. The first router 
in the group, which demarcs the start of the Intranet, is the Intranet entry router. The last router in this group, which 
demarcs the end of the Intranet, is the Intranet exit or egress router. The Intranet routers are the first group of 
routers, followed by the ISP routers, and Internet backbone routers.

To identify the Intranet, right-click on one of the Intranet router hop icons and choose Identify from the pop-up menu. 
By double-clicking on a yellow or red router hop icon, you can open the Net.Medic health log with the matching 
entry highlighted. By clicking once on a router hop icon, you can open the corresponding dashboard pane. For 
example, the Intranet pane opens if you click once any of the Intranet router hop icons in the Activity pane. You can 
also open the Intranet, ISP, or Internet panes by pulling down the View menu and respectively choosing Intranet, 
ISP, or Internet from the Details submenu.



IP

Short for Internet Protocol.    A networking protocol, which resides on both hosts and routers. It is responsible for 
relaying data from the source host to the destination host.



IP address

An Internet Protocol (IP) address for an Internet machine. It is a unique identification for each machine on the 
Internet. The address consists of four groups of numbers that are separated by dots. Each group of numbers is an 
8-bit octet that can range from 0 to 255. (An octet is a byte that consists of 8 bits). The entire IP address is a 32-bit 
value.



ISP egress router

The last router in the group of Internet Service Provider (ISP) routers that connects to the first Internet backbone 
router in an end-to-end connection. 

An egress router is used to leave any three of the regions (the Intranet, ISP, or Internet backbone portion) of an end-
to-end connection.



ISP entry router

The Internet Service Provider’s router used to connect your desktop computer to your Internet Service Provider 
(ISP). 

This is the router your local routers contacts to connect to your ISP. Such a router is a component of your Web path 
and is monitored by Net.Medic. If Net.Medic detects any problems with this router, it reports the problem in its health 
log.



ISP pane

Provides an index of the current overall health of your ISP from your connection point. Also reports your ISP’s 
performance based upon a periodic sampling. 

Delay chart. Provides an estimate of network delay that is attributable to your ISP. The chart provides a histogram 
of delay with the most recent information on the far right. Blue indicates a reasonable delay. Yellow indicates 
slowness associated with this portion of the network. The taller the line on the Delay chart, the longer the delay 
caused by your ISP.

Traffic gauge. Provides a relative estimate of the ISP traffic level in your Web path. This estimate is computed by 
taking the delay introduced by the ISP and comparing that against the historical distribution of ISP delays. The 
current value is placed in that distribution by computing a percentile. In the preceding example, 89% indicates that 
the current response was in the 89th percentile, which means that the current ISP delay was more than 89% of 
previously seen delays and was less than 10% of other previous delays. Therefore, higher percentile numbers 
mean higher congestion and vice-versa. The traffic index for your ISP’s performance is baselined over time and will 
become more accurate over time.

Bank of health lights. Indicates the current overall health of your ISP. Green, yellow, and red respectively indicate 
good, moderate, or poor health.



ISP pane bank of health lights

The overall health of your Internet Service Provider (ISP) is signified by the bank of health lights in the ISP pane. 
Green, yellow, and red respectively indicate good, moderate, or poor health.



ISP router hop icon

The group of routers that are used to connect your desktop computer to the Internet backbone. 

Each ISP router that your computer must traverse to connect to the Internet backbone is a router hop. Each router 

hop is represented as a  in the Activity pane. Move your pointer over a router hop group to display a brief 
description of it. To identify the ISP, right-click on one of the ISP router hop icons and choose Identify from the pop-
up menu.



ISP routers

The group of ISP routers used to connect your desktop computer to the Internet backbone.    The first router in this 
group, which demarcs the start of the ISP portion of a path, is the ISP entry router. The last router in this group is 
the ISP exit or egress router. By double-clicking on a yellow or red router hop icon, you can open the Net.Medic 
health log with the matching entry highlighted. To identify the ISP, right-click on one of the ISP router hop icons and 
choose Identify from the pop-up menu.

By double-clicking on a yellow or red router hop icon, you can open the Net.Medic health log with the matching 
entry highlighted. By clicking once on a router hop icon, you can open the corresponding dashboard pane. For 
example, the ISP pane opens if you click once on one of the ISP router hop icons in the Activity pane. You can also 
open the Intranet, ISP, or Internet panes by pulling down the View menu and respectively choosing Intranet, ISP, or 
Internet from the Details submenu.



Java applet

Java is an Internet programming language developed by Sun Microsystems. Java has been integrated with many of 
the popular Internet browsers, such as Netscape Navigator and Internet Explorer. A Java applet is a small program 
that is executed when loading a Web page into your browser window. Java applets are used to add video and 
sound to Web pages.



kbps

kbps is short for kilobits per second. A kilobit is one thousand bits and is a unit of measurement to indicate the 
speed at which data is being transferred. For example, if you are retrieving data from the network at a rate of 22.1 
kbps, then the data is being retrieved at a rate of 22,100 bits per second.



LAN

Short for local area network. A network that consists of a set of devices that are connected for communication 
purposes. A LAN can connect to a larger network (for example, the Internet.)



Link (Hyperlink)

A path that connects one part of a Web document to another part of the same document or to a separate document 
or location on the World Wide Web (Web).



Local router

The router your modem goes through to connect to your Internet Service Provider (ISP). Net.Medic uses gray, 
yellow, and red to indicate the current health of this router within its Activity pane. Gray indicates a healthy state. 
Yellow and red indicate moderate or poor health. If problems are encountered with this router, you can obtain more 
information about the problem by displaying the Net.Medic health log.



Modem

The internal or external device that allows your desktop computer to make telephone calls to other computers, as 
shown in the following figure.



Modem pane

Use the Net.Medic Modem pane to determine your modem’s performance and overall health.

Bank of health lights. Indicates the overall health of your modem. Green, yellow, and red indicate good, moderate, 
or poor health. 

Compression scale. Provides an estimate of the amount of compression your modem is currently using. The 
compression scale setting is updated every second and is only active during transfers. The blue arrow will slide 
back and forth to indicate the level of compression. If the blue arrow turns white when it is active, this signifies 
compression is in effect. If your modem is using compression, you can download Web pages faster. You can have 
Net.Medic enable compression via its AutoCure feature.

Speed meter. Reports the connection speed of your modem. The meter indicates what percent of the rated modem 
speed was actually achieved during the “handshake” between your modem and the ISP’s modem. A low percentage 
in this meter indicates your modem is not connected at optimal speed. For example, if you had a 28.8 kbps modem 
and the speed is reported at 26.4 kbps, the Speed meter registers 92% because 8% of your modem’s potential 
capacity is not being utilized.



Modem pane bank of health lights

The overall health of your modem is signified by the bank of health lights in the Modem pane. Green, yellow, and 
red respectively indicate good, moderate, or poor health.

Note

To fully utilize compression, a DTE rate that is four times higher than the modem’s rated baud rate is needed.



Net.Medic health log

The Net.Medic log that describes the problems encountered with your online connections. 

To display the log, use any of the following methods:

n Click  in your Net.Medic toolbar.

n Double-click on a yellow or red Net.Medic icon.

n Choose Health Log from the Net.Medic Window menu.

Note

To display a diagnosis and prescription for a problem listed in the log, double-click on the log entry or click on the 
entry once and then click Diagnosis.



Net.Medic history reports

The Net.Medic reports that track and rate the performance of Web sites you’ve visited over the past month. They 
enable you to compare your current and past performance. This information, in turn, allows you to make an 
informed decision about which sites to visit. The Internet Service Provider (ISP) performance rating notifies you 
about ISP bottlenecks. If the ISP is a bottleneck, then the information helps in deciding    whether to change service 
providers. If your ISP isn’t a bottleneck, you avoid needlessly calling your ISP for assistance or unnecessarily 
changing to a new ISP.



Net.Medic inlay

A Net.Medic pane that is inlaid into the upper-right corner of your browser window. By having this inlay in a browser, 
you can easily monitor the health of your current online session from your browser.



Menu Option Description

File Close Closes the Net.Medic dashboard on your desktop without shutting down the Net.Medic program. Because the 
Net.Medic program is still running, its icon remains in the system tray area of your taskbar.

View Home Opens only the Activity pane, the Throughput pane, and the Retrieval pane in the Net.Medic dashboard.

Preferences Opens the Net.Medic Preferences window, which you can use to change the Net.Medic E-mail, ticker tape, display 
colors, and performance preferences.

Open All Opens all the panes in the Net.Medic dashboard.

Close All Closes all the panes in the Net.Medic dashboard.

Details Opens the Details submenu from which you can open a particular pane in the Net.Medic dashboard:

n Choose My PC to open the Client pane.

n Choose Modem to open the Modem pane.

n Choose Intranet to open the Intranet pane.

n Choose ISP to open the ISP pane.

n Choose Internet to open the Internet pane.

n Choose Server to open the Server pane.

Window Call Log Opens the Net.Medic call log.

Health Log Opens the Net.Medic health log.

History    Reports Opens the submenu that lists the history reports you can display and print. 

Session Summary Opens the Net.Medic Session Summary window, which gives you a summary of your current online session.

Help Help Opens this Net.Medic help system on your desktop.

VitalSigns Home Page Opens the VitalSigns home page in your browser.

Version Update 
Information

Opens the VitalSigns Web page that you can use to obtain information about Net.Medic version updates.

Register Net.Medic Opens the VitalSigns Web page, which allows you to register your Net.Medic product.

Release Notes Opens the VitalSigns Web page, which contains release note information about the Net.Medic product.

Technical Support Opens the VitalSigns Web page, which contains information about obtaining technical support for the Net.Medic 
product.

About Net.Medic Displays the version number of the Net.Medic software.



$ K + Modem pane

Use the Net.Medic Modem pane to determine your modem’s performance and overall health.

Bank of health lights. Indicates the overall health of your modem. Green, yellow, and red indicate good, moderate, 
or poor health. To obtain more information about problems related to your modem, check the Net.Medic health log 
by double-clicking on this pane’s yellow or red health light, or on the yellow or red modem icon in the Activity pane.

Compression scale. Provides an estimate of the amount of compression your modem is currently using. The 
compression scale setting is updated every second and is only active during transfers. The blue arrow will slide 
back and forth to indicate the level of compression. If the blue arrow turns white when it is active, this signifies 
compression is in effect. If your modem is using compression, you can download Web pages faster. You can have 
Net.Medic enable compression via its AutoCure feature.

Speed meter. Reports the connection speed of your modem. The meter indicates what percent of the rated modem 
speed was actually achieved during the “handshake” between your modem and the ISP’s modem. A low percentage 
in this meter indicates your modem is not connected at optimal speed. For example, if you had a 28.8 kbps modem 
and the speed is reported at 26.4 kbps, the Speed meter registers 92% because 8% of your modem’s potential 
capacity is not being utilized.



Net.Medic call log

The Net.Medic log that tracks your modem calls over the past month. The log provides information about your 
modem’s success rate, the bandwidth it achieved for each call, its average connection rate, and the percentage of 

busy signals it encountered. To display this log, click  in the Net.Medic toolbar or choose Call Log from the 
Net.Medic Window menu.

Note

This vital data can help you decide whether you should upgrade to a faster modem. In addition, you can use this log 
to audit your monthly usage and fees as well as the level of service provided by your ISP. You can also use the log to 
audit your monthly usage and fees as well as the level of service provided by your ISP. However, ISPs vary in their 
billing policies and can also periodically change their policies. For example, various ISPs use different    methods    to 
roundup the billable hours while others bill in minimum time increments. Net.Medic does not account for such 
variables. Consequently, although this log reflects your actual online modem time over the past month, the reported 
time may not reflect your final ISP bill because of these variables in billing policies.



Net.Medic icon

When the Net.Medic program is running, the Net.Medic icon  appears in the system tray of your taskbar. Note 
that the Net.Medic icon changes colors to indicate the overall health of your current online connection. Gray, yellow, 
and red respectively indicate good, moderate or poor health.



Net.Medic system tray icon

When the Net.Medic program is running, the Net.Medic icon  appears in the system tray area of your taskbar. 
Note that the Net.Medic icon changes colors to indicate the overall health of your current online connection. Gray, 
yellow, and red respectively indicate good, moderate or poor health.



Net.Medic ticker tape

The Net.Medic dashboard has a ticker tape that reports such information as the name of the Web site you’re 
connected to along with the number of times you’ve visited the site. You can snap this ticker tape onto your browser 
by right-clicking on the ticker tape in the Net.Medic dashboard and choosing Snap On Browser. With Netscape 
Navigator, you can snap the ticker tape and a Net.Medic dashboard pane onto the browser concurrently. With 
Internet Explorer, you can only snap the ticker tape or a Net.Medic dashboard pane onto the browser.



Net.Medic title bar

Bar at the top of the Net.Medic dashboard window used to close the Net.Medic dashboard. 



Net.Medic toolbar

Row of buttons at the top of the Net.Medic dashboard used to perform such tasks as opening the Net.Medic health 
log.



Network gauge

Net.Medic separates the amount of delay in retrieving the page into two portions. The delay caused by the network 
and the delay caused by the server. This network delay is the amount of time it would take to make the request from 
the client to the server and the amount of time it takes the results to be brought back from the server to the client. 
Some of this delay is the propagation delay in the links. The rest of it is the delay in packet queues of intermediate 
devices such as routers. In the following example, the network contributed to 43% of the delay and the rest belongs 
to the server.



Non-peak times

Generally, the best time to log on is early morning or late evening. The busiest Internet time is the afternoon.



Packet

An electronic envelop used to transmit user data over a network. This is also referred to as a frame.



Primary DNS server

The Domain Name System (DNS) server is a computer on the Intranet or ISP, which implements the DNS protocol. 
One of the main functions of the DNS server is to translate the hostnames of network nodes of a domain it is 
responsible for into IP addresses. (A domain is a part of a network whose nodes are under some common control.) 

The primary DNS server is the first DNS server that a host contacts for the translation of the hostname into an IP 
address. If the primary DNS server fails, the secondary DNS server handles the responsibility. If the secondary DNS 
server fails, Net.Medic supplies a backup DNS server.



Proxy server

A computer used to access the Internet around a firewall.



Response time

The amount of time to respond to a request. Net.Medic measures the response time of your ISP, the Internet, and 
the Web server in your Web path. It reports how long each of these Web path components took to transfer a Web 
page. The Net.Medic Service Provider Report shows the ISP’s response time over the past month. The Net.Medic 
Frequently Visited Sites Report shows the response time of the ten sites you’ve visited the most over the past 
month. The Slowest Sites Report shows the response time of the slowest five sites you’ve visited over the past 
month.



Retrieval pane

Use the Net.Medic Retrieval pane for the following purposes: (1) to determine how effectively you are transferring 
data over the network, (2) to establish how much time it takes to retrieve a Web page, and (3) to pinpoint the source 
of the delays.

Time digital display. Reports the total time (delay) taken to retrieve the current Web page. (The retrieval of a Web 
page is an HTTP transfer.) The transfer time is shown in minutes, seconds and tenth of seconds.

Network gauge. Reports an estimated percent of retrieval time caused by a delay in the network that is between 
the Web site and the client (your desktop computer). 

Site gauge. Reports an estimated percent of retrieval time caused by a delay on the server (Web site). The 
Network gauge and the Site gauge measurements combined always total 100%. The Network gauge gives a real-
time indication of the percentage of transfer time attributable to the network. The Site gauge indicates the 
percentage of transfer time attributable to the Web server (the site). For example, if the Network gauge reads 43% 
and the Site gauge reads 57%, this indicates the site is causing most of the delay.

Avg. Rate digital display. Reports the average rate to retrieve the current Web page from the Web site. This rate is 
shown in kbps.



Router

An internetworking device that is used to connect different networks, or two network segments in a local area 
network (LAN).



Secondary DNS server

The Domain Name System (DNS) server is a computer on the Intranet or ISP, which implements the DNS protocol. 
One of the main functions of the DNS server is to translate the hostnames of network nodes of a domain it is 
responsible for into IP addresses. (A domain is a part of a network whose nodes are under some common control.) 

The primary DNS server is the first DNS server that a host contacts for the translation of the hostname into an IP 
address. If the primary DNS server fails, the secondary DNS server handles the responsibility. If the secondary DNS 
server fails, Net.Medic supplies a backup DNS server.



Server

A computer that handles the primary data delivery tasks for its clients. For example, when you initially view a Web 
page, the server that is storing the page must deliver it to your browser. After the page is retrieved from the server, 
you can view it with your browser. (Web servers are also called Web sites.) Your computer is the client portion of the 
client/server pair.



Server pane

Use the Net.Medic Server pane (also referred to as the Web site pane) to obtain an estimate of the health or 
performance of the remote Web server. The name of the remote Web server (for example, “southport.jpl.nasa”) 
appears in the upper-left corner of this pane.

Delay chart. Reports the estimated server and application (HTTP) delay caused by the various Web sites you have 
most recently visited. The delay measurement is based on the amount of time the server takes to complete its 
response to a request. Blue indicates a reasonable delay. Yellow indicates slowness associated with the remote 
Web server and the application layer response. The taller the line on this chart, the longer the delay caused by the 
server or Web site.

Load gauge. Reports the relative load on the server or Web site. This estimate is computed by taking the server 
delay and comparing that against the historical distribution of server delays. Lower percentile numbers mean lower 
load and better responsiveness. The more you visit a site, the more accurate its load gauge percentage reading 
becomes.

Throughput meter. Reports the efficiency of the current server or Web site and its attempt to use the available 
network bandwidth. It’s an estimated percent of the speed limit achieved by the current Web site server averaged 
over the complete page transfer time. A high throughput percentage indicates good utilization of the bandwidth 
available to the current server or Web site. However, if the speed limit is high (such as “LAN” speed), even the 
fastest servers may not achieve a high percentage.



SMTP

Short for Simple Mail Transfer Protocol. The E-mail protocol most commonly used by the Internet. It is implemented 
by the mail server SMTP channel. You can use the Net.Medic Preferences window to specify the E-mail protocol 
Net.Medic should use when sending E-mails. To display the Preferences window choose Preferences from the 
Net.Medic View menu.



Snapping

The process of displaying a Net.Medic pane in your browser is called “snapping” a pane onto your browser. The 
process of closing a Net.Medic inlay in your browser is called “detaching” a pane from your browser. You can snap 
and detach the Net.Medic ticker tape onto and off your browser.



Snapping a pane

The process of displaying a Net.Medic pane within your browser is called “snapping a pane” onto your browser. To 
snap a pane, right-click on the Net.Medic dashboard pane and choose Snap On Browser. The Net.Medic pane 
opens as an inlay in your browser. 

To detach (close) the Net.Medic inlay, right-click on the inlay and choose Snap on Dashboard. You can also snap 
and detach the Net.Medic ticker tape onto and off your browser by right-clicking on the ticker tape and choosing 
Snap On Browser or Snap on Dashboard. Net.Medic remembers the last pane you snapped onto the browser and 
automatically resnaps it the next time you restart your browser.



Subject of an E-mail message

When Net.Medic creates an E-mail message, it automatically specifies its subject. 



Subnet mask

A subnet is a portion of an IP network that shares the same subnet address. Subnets are arbitrarily created by a 
system administrator to provide a multilevel, hierarchical routing structure. Such hierarchical structures shield the 
subnet from the addressing complexity of networks that are attached to the subnet. A subnet mask is a 32-bit 
address mask used by the Internet Protocol (IP) to calculate a particular subnet.



Session Summary toolbar

To obtain more information about the source of a problem, click the corresponding tab in the Session Summary 
toolbar.



Session Summary window

The Session Summary window provides a summary of your current online session. To obtain more information 
about the source of a problem, click the corresponding tab in this toolbar. For example, click the Desktop tab for 
more information about your desktop computer.



TCP

Short for Transmission Control Protocol.    A networking protocol that resides on host computers and assures reliable 
data delivery.



Telephony

Pertaining to the transmission of voice or data between separate points.



Teleprotector

An external device that you can use to protect your data transmissions from line interruptions and interference.



Throughput

The total traffic between network stations (your desktop computer and a remote Web server) per unit of time. 
Net.Medic tracks the throughput of the server involved in the Web path. It reports how fast the Web server transfers 
the Web page to your desktop computer. The server’s transfer rate is measured in kilobytes.



Throughput pane

Use the Net.Medic Throughput pane to determine how fast you are currently transferring data over the network. 
Transfer speed is shown in kbps. For example, if you are receiving a Web across the network at a rate of 26.3 kbps, 
the Web page is being transferred at a rate of 26,300 bits per second (bps). The transfer speed rate is reported in: 
(1) the recv and send graph that indicates any activity seen on the network/dialup interface of the client, (2) the 
transfer gauge to the right of the recv and send graph, and (3) as a digital display (for example, 26.2 kbps). If white 
tips appear on the transfer gauge, this reflects a data transfer that is using compression and is exceeding the 
modem connection speed.

Speed limit digital display. The speed limit is the estimated maximum speed or bandwidth (capacity) available 
end-to-end during the current transfer. Net.Medic attempts to estimate non-modem bandwidth (for example, a T-1 
line) and automatically calculates your speed limit. You may, however, want to change the current speed limit if the 
receive and transmit rates (the blue vertical bars in the recv and send graph) are high and difficult to read. In this 
case, raising the speed limit will increase the histogram maximum, thereby making the bars shorter in the graph and 
easier to interpret. To manually set the speed limit, right-click on this digital display, choose Speed Limit from the 
pop-up menu, then drag right and choose one of the manual settings.

Recv and send graphs and digital displays. The recv graph and digital display report the receive rate during each 
interval. The send graph and digital display report the transmit rate during each interval. Transfer rates for the 
previous several seconds scroll from right to left with the passage of every second. The send/recv graphs indicate 
any activity seen on the network/dialup interface of the client. If the blue lines have white tips at the top, your 
connection is using compression to speed up the download of Web pages.



Uniform Resource Locator (URL)

The address that identifies a resource on the Web. A URL consists of the following four parts: the service (for 
example, http or ftp), the host computer, the port number, and the full path name of the Web page. 



Virtual memory

The Windows operating system uses a portion of your hard drive to simulate Random Access Memory (RAM). 
Through the use of virtual memory, your computer acts as if it has more RAM than it physically does. This allows 
your computer to run more programs than it otherwise could.



Webmaster

The individual at a Web site who administers all the Web resources (for example, the Web pages) at that site. A 
Web site is also called a Web server, as shown in the following figure.



Web page

A document you can read with a Web browser. Such pages can vary in complexity from a simple text page to pages 
that contain video and sound. Web pages are stored on Web servers.



Web path

The connection between your computer and the remote server. For example, a Web path is the end-to-end 
connection between a client (a desktop PC in San Jose) and remote Web server. Net.Medic monitors the health of 
your Web paths.



Web server

A computer that is equipped to provide Web services to the client computers, which access it. Web pages are 
stored on such servers. For example, Server A, Server B, and Server C are examples of Web servers. Web servers 
are also referred to as Web sites or remote servers.




